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Form No. 008-42104-00

WARRANTY
MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each 
instrument manufactured by it to be free from defects in material and workmanship impairing its usefulness 
under normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any 
instrument or defective parts, when returned prepaid to us, and which our examination discloses to have been 
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for 
warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized 
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The 
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive 
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed 
against wear and / or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of 
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and 
authorization to return the instrument or product. All repairs or replacements are made subject to factory 
inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications 
are made by persons other than its own authorized service personnel unless such work is authorized in writing by 
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their 
respective brand names or trade names. We, therefore, make no express or implied warranty as to such 
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary 
practice, the repair or replacement of such of his products that may prove defective in workmanship or 
materials. Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This 
states our entire liability in respect to such products, except as an authorized person of MICROMERITICS 
may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the 
discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check 
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and 
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. 
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be 
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against 
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or 
manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of 
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or 
implied, including, but not limited to the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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SediGraph III Plus Introduction
1.  USING THE ANALYZER

Introduction
This manual provides details on program menu options and operating instructions. This chapter con-
tains information on the system hardware and software components.

To help operate the analyzer system more efficiently, refer to:

• Chapter 1, USING THE ANALYZER - prior to operating the analyzer and software
• Chapter 2, OPERATIONAL PROCEDURES - for step-by-step instructions for common operations

Organization of the Operator’s Manual
This operator’s manual is organized as follows:

Chapter Description 

Chapter 1 USING THE ANALYZER

Provides a general description and features of the analyzer, 
organization of the manual, and software and instrument 
interface.

Chapter 2 OPERATIONAL PROCEDURES 

Provides step-by-step procedures for the operations available 
using the application.

Chapter 3 FILE MENU
Provides a description of the File menu options and field and 
button definitions. 

Chapter 4 UNIT MENU
Provides a description of the Unit menu options and field and 
button definitions.

Chapter 5 REPORTS MENU
Provides a description of the Reports menu options and field and 
button definitions.

Chapter 6 OPTIONS MENU
Provides a description of the Options menu options and field and 
button definitions.
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Organization of the Operator’s Manual SediGraph III Plus
Chapter 7 TROUBLESHOOTING AND MAINTENANCE 

Provides a description of the options contained on the Reports 
menu.

Chapter 8 ORDERING INFORMATION
Provides ordering information for the application and analyzer 
system components.

Appendix A ERROR MESSAGES
Lists the error messages displayed by the analysis program; 
includes a cause and action for each.

Appendix B SAMPLE DISPERSION 

Provides methods for dispersing samples.

Appendix C CHEMICAL AIDS FOR PARTICLE DISPERSION 

Provides a list of dispersants and their active ingredients.

Appendix D STOKES’ LAW
Provides calculations for Stokes’ Law.

Appendix E SEDIMENTATION THEORY 

Provides theoretical information on the sedimentation method.

Appendix F SEDIGRAPH RESULTS RELATIVE TO OTHER 
METHODS

Provides the relativity of the analysis results to other methods.

Appendix G LIQUID DENSITY AND VISCOSITY DATA

Provides density and viscosity data for common dispersants.

Appendix H SOURCES OF DISPERSING AIDS
Provides a list of suppliers for common dispersants.

Appendix I SEDISPERSE® PARTICLE DISPERSION LIQUIDS

Provides information on Sedisperse dispersing liquids.

Appendix J DATA REDUCTION 

Contains the calculations used for producing reports.

Chapter Description (continued)
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SediGraph III Plus Conventions
Conventions

This manual uses the following icons to identify notes of importance, warnings and cautions. 

Appendix K SEDIGRAPH X-RAY SAFETY INFORMATION 

Describes the safety features provided with the analyzer.

Appendix L MASTERTECH INSTALLATION

Describes how to install a MasterTech for use with the analyzer.

Index INDEX

Provides quick access to subject matter.

Notes contain important information pertinent to the subject matter.

Warnings contain information to help prevent actions that may cause personal injury.

Cautions contain information to help prevent actions that may damage the analyzer or 
components.

Chapter Description (continued)
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Equipment Description SediGraph III Plus
Equipment Description

SediGraph III Plus
The analyzer consists of up to two particle size analyzers and a multi-function computer. The particle 
size analyzer is mounted on adjustable feet and contains a level indicator so that accuracy of the analy-
sis process is maintained. It is designed for completely automatic operation; however, a sliding 
transparent door on the front panel provides convenient observation of, and access to, the temperature-
controlled analysis compartment. 

The analyzer contains an internal fixed-position X-ray source, detector assembly, and a vertical cell 
movement assembly. It incorporates a complete system for circulation of sedimentation liquid and par-
ticle sample mixture between the cell, the external mixing chamber, an external rinse liquid container, 
and an external waste container. It also contains a detachable magnetic stirring assembly.
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SediGraph III Plus Equipment Description
MasterTech 052
The MasterTech 052, an automatic sampling device that operates in conjunction with the SediGraph, is 
also available. The MasterTech allows up to 18 predispersed samples to be "queued up’ and run con-
secutively and unattended. It allows samples to be redispersed either by stirring only or by stirring and 
disruption with an ultrasonic probe. The MasterTech transfers each sample to the SediGraph, then after 
analysis is complete, rinses the mixing chamber, the connecting tubing, and the stirrer.

The MasterTech 052 consists of three main components: the arm assembly, the body, and the beaker 
tray. The arm assembly controls the movement of the stirring rotor, the ultrasonic probe, and the trans-
fer tube. The body houses the electronics, the transfer pump, the front panel controls, and supports the 
beaker tray, which holds up to 18 sample beakers.

During operation, the beaker tray is loaded with beakers containing 60 to 80 mL of predispersed sam-
ple. When the SediGraph is ready for a sample, the tray rotates until the correct sample is underneath 
the head of the arm assembly. The head then lowers until it rests on top of the beaker. Stirring action 
begins and continues for a user-specified length of time. The ultrasonic probe can be activated to aid in 
redispersion.

When redispersion is complete, the pump transfers most of the sample to the SediGraph, where it is 
loaded into the mixing chamber. Analysis now proceeds as if the mixing chamber was filled manually 
with predispersed sample. When analysis is complete, the contents of the mixing chamber are disposed 
to the waste container, and a small amount of rinsing fluid is back-flushed to the MasterTech to rinse 
the tubing. The arm rises so that the rinse liquid removes the sample residue from the stirrer blades and 
transfer tube. Once rinsing is complete, the arm rises to the Up position. The MasterTech is now ready 
to proceed to the next sample.
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Instrument Components and Connectors SediGraph III Plus
Instrument Components and Connectors
The system is fully automatic. The computer is used to enter operational information and view system 
status. 

SediGraph III Plus - Front Panel

Component Description 

X-ray status • X-Ray standby indicator - illuminates when the analyzer is 
ON and the X-ray keyswitch is turned to the standby 
position, when the door to the analysis compartment is open, 
or any interlock is disengaged. 

• X-Ray ON indicator - illuminates when X-rays are being 
generated. The X-ray keyswitch must be turned to the  
X-RAY ON position. 

X-ray keyswitch Sets the X-ray to either the On or Standby position.

Pump control Off/Auto switch Selects the operational mode of the mixing and cell pumps.

The Off position turns off power to the pumps. The Auto 
position places the pumps in automatic mode.

X-Ray
standby
indicator

X-Ray
ON
indicator

X-Ray
keyswitch

Pump
control
switch

Mixing chamber
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SediGraph III Plus Instrument Components and Connectors
SediGraph III Plus - Side Panel

Mixing chamber Contains the sample during an analysis and maintains sample 
dispersion throughout the analysis with a built-in stirrer.

Component Description 

ON/OFF power switch Turns electrical power to the analyzer on and off. 

Electrical outlet For connecting power to the analyzer.

Aux RS232 port For Micromeritics use only.

MasterTech RS232 port For connecting the MasterTech to the analyzer.

Ethernet port For connecting the analyzer to the computer.

Component Description (continued)

Ethernet port for 
connection to computer

RS232 port for connection 
to MasterTech

Power switch Electrical outlet

For Micromeritics’ use 
only
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MasterTech 052 - Front Panel

Component Description 

Power display Displays the power being generated by the ultrasonic probe.

Ultrasonic probe AUTO/ON 
switch

LEDs on the switch indicate the mode of operation.

The AUTO position places the probe under automatic control.

The ON position turns on the probe. Remove the probe from its 
holder and place it in the liquid before turning on the probe.

Never turn the probe on unless the tip is submerged in liquid.

After using the probe, press the switch again to place the probe 
in automatic mode. Then replace it in its holder.

Intensity control Turn the control clockwise to increase the intensity of the probe. 
Turn it counterclockwise to decrease the intensity.

Arm AUTO/LOAD switch The LEDs on the switch indicate the mode of operation.

Do not press the ARM AUTO/LOAD switch while an automatic operation is in progress.

• AUTO - places the arm under automatic control.

• LOAD - raises the arm to remove or load the tray.

This switch will not work unless the computer is installed and 
the analyzer software is operating.

Ensure the LOAD switch has been released when finished 
removing or loading the beaker tray. The MasterTech will not 
operate if the arm is in the Load position.

Power 
display

Intensity 
control

Pump Auto/Off 
switch

Ultrasonic Probe 
Auto/ON switch

Arm Auto/Load 
switch
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MasterTech - Rear Panel

Pump AUTO/OFF switch The LEDs on the switch indicate the mode of operation.

The AUTO position places the pump under automatic control.

The OFF position turns off power to the pump.

Component Description 

Power ON/OFF switch Turns the MasterTech on and off.

The down (O) position turns off the MasterTech.

The up ( | ) position turns on the MasterTech.

+5 and +24 VDC indicators Illuminates when appropriate power is present in the 
MasterTech.

RS232 connector Used to connect the MasterTech to the analyzer.

Component Description (continued)

RS232 connectorPower switch

+5 and +24 VDC indicators
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Turning the Analyzer On and Off

Turning the Analyzer On
1. Place the computer, monitor and printer ON/OFF switches in the ON position.

2. Place the Pump Control switch (located on the front panel) in the AUTO position.

3. Place the analyzer ON/OFF switch (located on the side panel) in the ON position. 

4. Insert the X-ray key into the X-ray keyswitch then turn the switch to the X-RAY ON position.

5. Wait 30 minutes for the analyzer to warm up before performing an analysis. 

Turning the Analyzer Off

It is recommended that the analyzer be turned on at all times. If it does become necessary to turn it off, 
perform these steps:

1. Go to File > Close or File > Exit.

If an analysis is in progress, the following message is displayed:

Select No and the program remains open and the analysis continues to run.

2. Shut down the computer using standard Windows procedure.

3. Place the monitor and printer ON/OFF switches in the OFF position.

4. Place the analyzer ON/OFF switch in the OFF position.

It is recommended that the analyzer remain on unless it is going to be idle for a period 
of more than 24 hours. Leaving the analyzer on helps prolong the life of its major 
components.

Always exit the analysis program before turning off the computer. Failure to do so 
could result in loss of data.

 Instrument is busy. Continue program exit? 

Select Yes and the analysis program closes. The analysis 
continues and data continue to be collected. Queued 
reports under the printer will print. If a power failure occurs 
and an uninterruptible power supply (UPS) is not attached 
to the analyzer, the data collected after exiting the analysis 
program are lost
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Software
The analysis program operates in the Windows environment and requires familiarity with standard 
Windows operations, for example, using the mouse, menus and windows. While this manual provides 
brief instructions for such standard operations, if necessary, refer to Windows documentation or its 
online help system to clarify any Windows functions. 

Shortcut Menus
Shortcut menus are available for:

• the instrument schematic when Manual Control is enabled. Refer to Enable Manual Control, page 
4-24.

• onscreen graphs and tabular reports. Refer to Report Shortcut Menus, page 5-22.

Shortcut Keys
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (when 
applicable) are listed to the right of the menu item. 

Another shortcut method of accessing a menu or function is to use the Alt key plus the underlined let-
ter in the menu command. For example, to access the File menu, press Alt+F.

If the underscored letters do not display menus and windows, press the Alt key on the 
keyboard.

Shortcut Key(s) Function 

F1 Accesses the online operator’s manual.
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F2 Opens a file selection window that displays sample information files.

F3 Opens a file selection window that displays analysis conditions files.

F4 Opens a file selection window that displays liquid properties files.

F5 Opens a file selection window that report options files.

F6 Tiles open windows.

F7 Cascades open windows.

F8 Opens a file selection window that displays reports to run.

F9 Closes all open reports.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save 
changes displays.

Shortcut Key(s) Function (continued)
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Files

File Status and Description
In the File Selector window, the Mic Description column and the Mic Status column display file 
description and file status, respectively.

File Name Conventions
For sample information files, a default file name (the next available sequence number) and a default 
file extension display. For Analysis conditions, Report options, and Liquid properties files, only a 
default file extension display.

The following table lists the default file extensions assigned to program files:

File Status Description 

Analyzing Sample information files that are currently being used for analysis.

Complete Sample information files used in an analysis that has been completed.

Entered Sample information files containing manually entered data.

No Analysis Sample information files which have not been used to perform an analysis.

File Type Default File Name Extension

Analysis conditions .ANC

Export to disk (ASCII) .EXP

Liquid Properties .LIQ

List to disk .LST

Report options .RPO

Report to disk .RPT

Report (saved from the report window) .REP

Sample information .SMP

For conversion from non-Windows 
SediGraph 5100

.DAT
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Menu Structure
All program functions are located on menus accessed from the menu bar. Each menu contains com-
mands and, in some cases, a submenu. A submenu is indicated when the command is followed by an 
arrow.

Main Menu Bar
All program functions are accessed from the main menu bar. The following table contains brief menu 
descriptions and links to additional information:

Menu Item Description 

File Use to access files. Refer to FILE MENU, page 3-1.

Unit [n] Use to perform analyses, calibrations and other instrument operations. 
Refer to UNIT MENU, page 4-1.

Reports Use to run reports and view the results. Refer to  
REPORTS MENU, page 5-1.

Options Use to edit sample defaults, specify the printer for reports, and select data 
presentation formats. Refer to OPTIONS MENU, page 6-1.

Windows Use to arrange open windows and display a list of open windows. Refer to 
Windows Menu, page 1-15.

Help Displays help information. Refer to Help Menu, page 1-15.

Arrow indicates a 
submenu is available
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Windows Menu
The Windows menu lists open files and provides the ability to rearrange the way open windows dis-
play. A check mark appears to the left of the active window.

Help Menu

Window Menu 
Option Description 

Cascade Stacks open windows in a fanned format so that each window title bar is 
visible. F7 can also be used as a keyboard shortcut.

Tile Resizes open windows and arranges windows horizontally so that multiple 
windows can be viewed at once. F6 can also be used as a keyboard 
shortcut.

Arrange Icons Arranges the symbols for all minimized windows.

Help Menu Option Description 

Operator’s Manual Provides access to the online operator’s manual.

About SediGraph III 
Plus

Provides the analysis program version number.
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Setup Program
The Setup program is located on the installation CD. It is used to:

• Upgrade or re-install the software
• Add an analyzer
• Move an analyzer from one computer to another computer
• Remove an analyzer from the computer
• Change the analyzer setup
• Reinstall calibration files
• Uninstall the analysis program

Specifications
The SediGraph III Plus has been designed and tested to meet the following specifications:

Characteristic Specification 

Analyzer

Particle Diameter Range 300 to 0.1 μm Equivalent Spherical Diameter

Resolution The sedimenting sample is scanned by a narrow x-ray beam - 
less than 0.2% of the total distance scanned - permitting high 
resolution.

Wetted Materials Stainless steel, Teflon® impregnated anodized aluminum, nickel 
plated aluminum, nylon, polypropylene, polystyrene, Tygon® 
tubing, tungsten carbide, Ertalyte®, Viton®, Kalrez®, glass, and 
epoxy.

Sample Size 50 mL of dispersed sample; precise concentration is not required

Suspending Liquids Any liquid compatible with sample cell materials and not highly 
absorptive of X-rays (typical liquids are water, glycols, mineral 
oils, Sedisperse®, and alcohols)

Voltage 85 to 264 VAC

Frequency 47 to 63 Hz

Power 450 VA

Temperature Ambient +10 to 40 °C, operating; 
-10 to 55 °C, storing or shipping
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Humidity Up to 90% relative (non-condensing); 20 to 80% for computer 
and components

Physical Height: 52 cm (20.5 in.)
Width: 50.5 cm (20 in.)
Depth: 58 cm (23 in.)
Weight: 43 kg (95 lb)

Computer

Minimum requirements Windows 2000 or higher operating system with an Ethernet port

MasterTech

Sample Capacity  18 per tray; continuing indefinitely if tray is replenished

Sample Size  18 per tray; continuing indefinitely if tray is replenished

Suspending Liquid  Any liquid compatible with wetted materials (typical liquids are 
water, glycols, mineral oils, alcohols, SediSperse®, (and mineral 
spirits)

Wetted Materials  Stainless steel, Viton®, Tygon®, silicone rubber, polypropylene

Voltage  100, 120, 220 or 240 VAC +10%

Fuse  2A (100/120 VAC); 1A Type T, Slow-Blow (220/240 VAC)

Power  250 VA

Frequency  50/60 Hz.

Temperature  10 to 40oC, operating: -10 to 55oC, storing or shipping

Humidity  20 to 80% relative (non-condensing)

Physical  Height:  71 cm (28 in.)

Width:  46 cm (18 in.)

Depth:  53 cm (21 in.)

Weight: 18 kg (40 lbs)

Characteristic Specification (continued)
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SediGraph III Plus Introduction
2.  OPERATIONAL PROCEDURES

Introduction
This chapter contains information on:

• specifying sample defaults
• creating sample files in advanced, basic, and restricted formats
• defining parameter files
• preparing for analysis
• performing a baseline measurement
• performing an analysis
• performing a rinse operation
• generating overlays
• exporting, listing and converting file contents to the screen, printer, or file

Editing the Sample Default File
Sample files include the information required by the analyzer to perform analyses and collect data. A 
sample default file is a template for sample files that contains the parameters to be used for an analysis. 
The analysis software contains a sample default file. When creating a new sample information file, all 
of the parameters are filled with the values in the sample default file and can be edited if necessary.

Editing the Sample Default File
1. Go to Options > Option presentation > Advanced. Ensure a checkmark appears to the left of 

Advanced.

2. Go to Options > Sample defaults.
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3. In the Sequence Number text box, specify an optional default alphanumeric file sequence string. 
This field must contain a minimum of 3 numbers. As files are created, this number is 
incrementally sequenced as a part of the file name and will also display in the Sample text box 
when a sample file is created.

4. In the Sample text box, enter a format for the default sample identification. Include the $ 
character to automatically include the contents of the Sequence Number field and Sample file 
name field as part of the sample identification. 

5. Enter default Operator and Submitter identification information in the respective text boxes. 
This information will display in the Sample Information tab of new sample information 
files.

6. The optional user-defined fields in the User Parameters group box may be used to enter and 
track information from another instrument or source, along with other statistical process control 
(SPC) data.

7. Use the Comments text box to enter notes about the default sample.

8. Select the Material Properties tab. Select the options to be used as defaults, then click Save. 
Refer to Analysis Conditions, page 2-8.

9. Select the Analysis Options tab. Select the analysis options to be used as defaults, then click 
Save. Refer to Analysis Conditions, page 2-8.

10. Select the Report Options tab. Select the report options to be used as defaults, then click Save. 
Refer to Defining a Report Options File, page 2-14.

11. Click Save, then Close.

The labels for the Sample, Operator, and Submitter fields can be modified by overwriting 
the default labels. These fields can also be omitted from a sample file by selecting the 
Omit checkbox.

The labels for the User Parameter fields can be modified by overwriting the default 
labels. These fields can also be omitted from a sample file by selecting the Omit 
checkbox.

The << Prev and Next >>buttons can be used to navigate between tabs.
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Defining Sample Information Files
A sample information file must be created for each analysis. This file can be created prior to or at the 
time of analysis. The sample information file identifies the sample, guides the analysis, and specifies 
report options.

A sample information file may be created in Advanced, Basic, or Restricted format. 

Format Description 

Advanced Displays all parts of sample information and parameter files. Navigate to 
parameter windows by selecting the tabs across the top of the window. 

 Basic Displays the entire sample information file in a single window with no tabs 
across the top. This option is used once the parameter files have been created. 
The previously entered or default parameter files are then accessible using 
dropdown lists.

 Restricted Displays the sample information file in a single window similar to the Basic 
format with certain functions disabled. A password is set when the restricted 
format is selected. That same password must be entered to change the format. 
This format is typically used in laboratories where analysis conditions must 
remain constant, for example, in the pharmaceutical industry. The Advanced 
format option is not available from the Restricted presentation format. 
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Creating Sample Files in Advanced Format
The values specified in the parameter portions of the sample default file (Analysis Conditions and 
Report Options) are saved as the defaults for new sample files. To navigate from one set of parameters 
to another, select the parameter tab at the top of the window or use the << Prev and Next>> buttons.

1. Go to Options > Option presentation > Advanced. Ensure a checkmark appears to the left of 
Advanced.

2. Go to  File > Open > Sample Information.

3. Accept the next sequenced file number or enter a new name in the File name field. Click OK and 
respond YES to the prompt to create a new file.
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4. Enter a sample description in the Sample text box.

5. Enter Operator and Submitter identification information in the respective text boxes. Some text 
box fields may have been renamed or may not display if modified in Options > Sample Defaults.

6. If SPC (Statistical Process Control) information is to be reported, enter appropriate information in 
the User Parameters group box. These are user-definable parameters that can be entered and 
tracked along with other statistical process control data. Some text box fields may have been 
renamed or may not display if modified in Options > Sample Defaults.

7. Enter any pertinent information about the sample information file in the Comments text box. 
Comments are displayed in the report header.

8. Click the Add Log Entry button to enter notes for the instrument log report. Create entries that 
cannot be recorded automatically through the application software. For example, record that the 
port filter was changed.

9. After completing the Sample Information window, click the parameter tabs to edit other sample 
information file parameters. See Defining Parameter Files, page 2-8.

The << Prev and Next >>buttons can be used to navigate between tabs.
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Creating Sample Files in Basic or Restricted Format
The Basic and Restricted formats use predefined parameter files to create a sample information file. If 
using Restricted format, a password is required to enter and exit Restricted format mode.

• When using the Basic format, switch to the Advanced format to edit parameter file values.
• When using the Restricted format, parameter files cannot be edited.  

1. Go to Options > Option presentation > Basic (or Restricted). Ensure a checkmark appears to the 
left of Basic.

2. Go to File > Open > Sample Information.

3. Accept the next sequenced file number or enter a new name in the File name field. Click OK and 
respond YES to the prompt to create a new file.
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4. Select an Analysis Conditions set from the dropdown list.

5. Select the Rinse after analysis option.

6. Select a Report Options file from the dropdown list.

7. In the Report Options list box, select any reports to be generated. A checkmark to the left of the 
report option indicates the report has been selected.

8. In the Full scale mass percent field, enter the percentage of the sample to be analyzed. Unless 
planning to analyze a portion of the sample by some other method, this should be left at 100%.

9. To merge alternatively collected data with the data to be collected with the active file, select 
Merge with external data. Refer to Sample Information Files - Basic Format, page 3-8.

a.) Click External Data and select whether the external data is particle size or sieve size. 

b.) In the table, enter the data (particle size or sieve) collected from the alternative method.

c.) Choose the type of distribution provided by the external analysis method.

d.) Click OK.

10.   Click Save, then Close.

It is highly recommended that the Rinse after analysis option remain selected. De-
selecting this option may speed up analyses, but inaccurate data may be produced.

To merge data collected by another method with the data collected with this analysis, 
skip this step.
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Defining Parameter Files
The following file types can exist as part of the sample information file as well as individual parameter 
files:

• Analysis Conditions .ANC file extension
• Liquid Properties .LIQ file extension
• Report Options .RPT file extension 

Default parameter files can be used for multiple analyses without having to re-enter the values each 
time an analysis is performed.

Predefined parameter files are included with the program and can be edited as needed or new parame-
ter files can be created. The Replace button can be used to overwrite values from an existing file. 
Changes can be made as needed to the new file while the original file remains unchanged.

Analysis Conditions
Analysis conditions specify the data used to guide an analysis and consists of three sets of data:

• Material Properties - defines sample material, liquid properties, and type of analysis. Refer to 
Material Properties, page 2-9.

• Liquid Properties - defines certain physical characteristics of sedimentation liquids. Refer to 
Defining a Liquid Properties File, page 2-12.

• Analysis Options - defines MasterTech operation and analysis conditions. Refer to Analysis 
Options, page 2-11.
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Material Properties
File > Open > Analysis conditions [file] (or use the F3 keyboard shortcut)

Material Properties define the sample material, the liquid properties, and the type of analysis to be 
performed.

1. Go to File > Open > Analysis conditions.

2. Enter a file name in the File name text box and click OK when prompted to create a new file.

3. Go to the Material Properties tab.

4. Enter a description in the Description field. 

5. Select a sample material in the Sample Material list box. To add a sample material not displayed:

a.) Enter the sample material to be added in the Description field below the Sample Material 
list box.

b.) Enter the material’s density in the Density field.

c.) Click Add. The sample material is added to the Sample Material list.

6. Select a dispersing liquid in the Analysis Liquid list box. To add a dispersing liquid not 
displayed:

a.) Enter the dispersing liquid to be added in the Description field.
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b.) Click the Properties button. Select the Fixed values option and enter the viscosity and 
density for the liquid. Click OK. Refer to Defining a Liquid Properties File, page 2-12.

c.) Click Add. The dispersing liquid is added to the list.

7. Select an analysis type in the Analysis Type dropdown list.

8. Enter the starting and ending diameters in the Starting Diameter and Ending Diameter text 
boxes. Generally, the starting diameter should be larger than the largest particle expected to be in 
the sample. The ending diameter must be less than the smallest size particle of interest.

9. The Maximum diameter field should be greater than the starting diameter specified in step 8. 
The Reynolds number should be less than 0.3.

If... Then... 

The maximum diameter and 
Reynolds number values are not 
attained

A dispersing liquid with a higher viscosity must be used.

The maximum diameter is much 
greater than the starting diameter 
and the Reynolds number is 
much less than 0.3

A lower viscosity liquid (if available) may be used.
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Analysis Options
File > Open > Analysis conditions [file] (or use the F3 keyboard shortcut)

Analysis Options define MasterTech operation and analysis conditions.

1. Go to File > Open > Analysis conditions. If continuing from the instructions in the Materials 
Properties section, skip to Step 3.

2. Enter a file name in the File name text box or select an existing file. Click OK if prompted to 
create a new file.

3. Click the Analysis Options tab.

4. If a MasterTech attached to the analyzer, in the MasterTech Treatment group box, enter the 
stirrer time, stirrer speed and probe time.

5. Select Stop at selected mass percent if the analysis should be stopped at a specified mass percent 
finer. Enter the point where the analysis should stop.

6. In the Number of tests box, enter up to 8 tests (analyses) to be performed.

7. Select Leave pump on during analysis to have the mixing pump operate during analysis. Coarse 
materials tend to settle in the tubing during analysis. Allowing the mixing pump to operate during 
analysis will make rinsing and resuspension more thorough. 

8. Select Wait for temperature stabilization to have the temperature in the analysis compartment 
and mixing chamber stabilize before the analysis begins. Since liquid properties are defined from 
the analysis compartment temperature, analyses are more accurate if the mixing chamber and 
analysis compartment have the same temperature range.

9. Enter the mixing chamber speed in the Mixing chamber stirrer speed text box.
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10. In the Full Scale Scan group box:

a.) Enter the cell pump operating speed during the scanning process in the Pump Speed text 
box.

b.) Select a bubble detection of Coarse, Medium, or Fine in the Bubble detection dropdown 
list.

11. In the Rinse group box:

a.) Select if the analysis cell should be rinsed after each analysis:

–  Autorinse - the analysis cell is rinsed automatically.
–  Rinses - specify the number of rinses 

b.) Enter the cell pump speed during the rinsing process.

12. Click Save, then Close.

Defining a Liquid Properties File
File > Open > Liquid properties [file] (or use the F4 keyboard shortcut)

Liquid properties files provide certain physical characteristics of sedimentation liquids used for analy-
sis. The physical characteristics are the density and viscosity of the liquid at different temperatures.

Several liquid properties files, located in the PARAMS subdirectory, are included with the analysis 
program. 

1. Go to File > Open > Liquid properties.

Refer to Appendix G LIQUID DENSITY AND VISCOSITY DATA for a list of some 
common dispersants and their density and viscosity values.
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2. Enter a file name in the File name text box and click OK when prompted to create a new file.

3. Enter a description in the Description field.

4. Select one of the following:

• Fixed values (ignore temperature) - enter values in the Viscosity and Density fields. These 
values will be maintained regardless of the cell temperature.

• Interpolate using cell temperature - enter three sets of values for the temperature, viscosity 
and density. These values are used to interpolate the density and viscosity at the current cell 
temperature as long as the instrument operating temperature remains within these ranges.

The table requires that entered values be properly ordered. For example, Temperature should 
be in ascending order. Enter values from left-to-right and from top-to-bottom.

5. Select the X-ray intensity:

• Normal - increases intensity when using high X-ray absorption liquids, such as water.
• Low - decreases intensity when using low X-ray absorption liquids, such as hydrocarbons.  

6. Click Save, then Close.
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Defining a Report Options File
File > Open > Report options [file] (or use the F5 keyboard shortcut)

Report options files specify the types of reports which can be generated from an analysis or from man-
ually-entered data. They also contain details of the reports such as axis scale, axis range, and column 
headings. These report options files may be used to generate reports automatically at any time during 
or after the analysis. 

Report options files may be created and stored, then used with any sample information file. A report 
options file may contain tabular reports only, graphs only, or both. It may also contain user defined 
report tables.

Report options files also may be defined to include overlay options. The analyzer can overlay up to 
seven graphs of different samples onto an eighth graph of the same type. The system can also overlay 
one graph type onto a different graph type from the same sample analysis. For example, a cumulative 
mass graph may be overlaid with a mass frequency graph. 

Several report options files are included in the analysis program and are located in the PARAMS sub-
directory. 

1. Go to File > Open >Report Options.

2. Enter a file name in the File name text box and click OK when prompted to create a new file.

3. Enter a description in the Report options field.

4. To display a title on the report header, select the Show report title checkbox and enter the report 
title in the text box. Refer to Report Header, page 5-16.
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5. To display a graphic on the report header, select the Show report title checkbox and enter the 
report title in the text box. Click the Browse button to locate a .BMP or .EMF file. Specify the 
graphic size in the Height and Width text fields. Refer to Report Header, page 5-16.

6. Select the data distribution type to be used for reports.

7. To compare analysis results for the current sample to those obtained for a reference sample, click 
Reference and select a file. Results are reflected in the Difference from Reference Graph report. 
Click OK after selecting a file.

8. To determine if the results for the current sample are within coarse and fine specifications, click 
Specification and select a sample file for each boundary. Results are reflected in the Out of 
Specification Graph report. Click OK after selecting a file.
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9. To overlay graphs, click Overlays and choose the sample file(s) to overlay with the current 
sample. Click OK after selecting files.

10. From the Test dropdown list, select the analysis report to be generated (Average, First, Last).

11. In the Reports to Generate list box, select which reports are to be generated. Selected reports 
will have a checkmark to the left of the report name.

• Double-click the report to place a checkbox to the left of the report.

• To specify report options, highlight the report in the Reports to Generate list box and click 
Edit. Make changes as necessary. Click OK.

12. Click Save, then Close.

For information on Overlays, refer to Generating Overlays, page 2-46.
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Preparing for Analysis
Before collecting baseline data or perform an analysis, the cell and mixing chamber must be drained 
and the sample (or baseline liquid) loaded.

A baseline measurement must be performed before running analyses. It is not necessary to measure a 
baseline for each analysis; however it is recommended that a baseline measurement be performed once 
per shift and when changing dispersing agents.

Performing a Drain and Load Operation
Unit [n] > Drain and load

Before collecting baseline data or performing an analysis, the cell and mixing chamber must be 
drained and the sample (or baseline liquid) loaded. 

• Prior to a baseline collection or an analysis, go to Unit > Drain and load.

• At the beginning of a baseline collection, select the Prepare SediGraph to load baseline liquid 
check box on the Baseline Measurement window. Refer to Performing a Baseline Measurement, 
page 2-19.

• At the beginning of an analysis, select the Prepare SediGraph to load sample check box on the 
Drain and Load window. Refer to Performing an Analysis, page 2-21.

1. Go to Unit [n] > Drain and load.

2. Select to either have the liquid remain in the mixing chamber or leave the mixing chamber empty. 
Click Continue. 

Ensure that the outlet tube is in the waste reservoir and that the rinse tube is in the 
rinse liquid reservoir.
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3. A progress message appears prior to the following window. Ensure the mixing chamber bezel is 
inserted in the mixing chamber, then load the sample (or baseline liquid) into the mixing chamber. 
The mixing speed can be changed using the Increase or Decrease button.

4. Click Continue.

Confirm the X-ray intensity reduction over the baseline before it completes: 

• Good - indicates reduction is between 30 and 75% meaning that the concentration level is 
appropriate.

• Low - indicates the reduction is less than 30% meaning that the concentration is too low and 
sample should be added.

• High - indicates the reduction is more than 75% meaning that the concentration is too high and 
more dispersant or less sample should be used.

5. When the X-ray reduction level is set, click Continue and the cell will move to the normal park 
position and the load operation will be complete.
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Performing a Baseline Measurement
Unit [n] > Baseline

A baseline measurement is required for data collection. Although it is not necessary to measure a base-
line for each analysis, Micromeritics recommends that a baseline measurement be performed once per 
shift and when changing dispersing agents. Up to seven baselines can be measured; however, only the 
last one may be saved.

1. Go to Unit [n] > Baseline. 

2. If the baseline liquid has not been loaded into the mixing chamber:

a.) Select Prepare to load baseline liquid. 

b.) Select to have the liquid remain in the mixing chamber or to leave the mixing chamber 
empty.

3. To have a baseline report generated:

a.) Select Report After Analysis.

b.) Select the report destination.

Ensure that the outlet tube is in the waste contains that no sample is present in the 
system.

If planning to use a liquid different from the one used for rinsing, select Leave mixing 
chamber empty.
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c.) If Printer was selected, enter the number of copies to print. 

4. Select the X-ray intensity setting.

• Normal - increases intensity when using high X-ray absorption liquids, such as water.
• Low - decreases intensity when using low X-ray absorption liquids, such as hydrocarbons. 

5. Click Next >> to display a window containing the previous baseline. This window also displays 
the new (current) baseline as it is measured.

6. The window displays an upper status. Click on the Baseline to use dropdown to select Latest (for 
the current baseline) or Previous (to use the previously saved baseline). 

File cannot be specified as the destination for baseline reports. Only tabular reports 
can be output to a file.

If Prepare to load baseline liquid was selected, a drain and load operation is performed 
first.

If this baseline is not satisfactory, perform another baseline by clicking Next >>. If 
another baseline is measured, the current one will become inaccessible. 
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Performing an Analysis
An analysis can be performed in one of five ways:

• Sample Analysis - performs a single sample analysis.

• Quick Start Analysis - performs analyses on multiple samples using the same analysis conditions. 
Sample files are generated automatically.

• Repeat Analysis - performs multiple analyses on the same sample.

• MasterTech Automatic - analyzes a series of samples of the same type with the same analysis 
conditions. Functional only if a MasterTech is installed.

• MasterTech Schedule - analyzes a series of samples which are different in size and shape and, 
consequently, require different analysis conditions. Functional only if a MasterTech is installed.

Sample Analysis
Unit [n] > Sample analysis

To perform an analysis on only one sample:

1. Go to Unit [n] > Sample Analysis.

2. Click Browse to select a sample to analyze.

3. Verify the analysis conditions and report options.
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4. In the Full scale mass percent field, enter the percentage of the sample to be analyzed. It is 
recommended that the percentage be left at 100% unless only a portion of the sample will be 
analyzed using an alternate method.

5. To merge alternatively collected data with the data to be collected with this file, select Merge 
with external data.

a.) Click External Data button.

b.) Select if the external data is particle size or sieve size.

c.) Enter the particle size or seize size of the data collected from the alternative method into the 
table.

d.) Select the type of distribution provided by the external analysis method.

e.) Click OK.

6. Click Next>>.

7. In the Drain and load options group box, select one of the following

• Prepare SediGraph to load sample - select if the sample has not been loaded into the mixing 
chamber. If selected, a drain and load operation is performed.

• Leave liquid in mixing chamber / Leave mixing chamber empty - select if the liquid should 
remain in the mixing chamber or leave the mixing chamber empty.

To merge data collected by another method with the data collected with this analysis, 
skip Step 5.
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If... Then  

A sample is loaded into the 
mixing chamber

a.)  Ensure that Prepare SediGraph to load sample is 
deselected.

b.) Select report output options in the Report options group 
box.

c.) Click Start.
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If a sample is not loaded a.)  Select Prepare SediGraph to load sample.

b.) Select to have liquid remain in the mixing chamber or to 
have the chamber left empty.

c.) Select report output options in the Report options group 
box.

d.) Click Start. A drain operation is performed and the 
following window displays.

e.) Load the sample. To change the mixing chamber speed, use 
the Increase or Decrease button.

f.) Click Start. 

If... Then (continued) (continued)
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8. Confirm the X-ray intensity reduction over the baseline before it completes: 

• Good - indicates reduction is between 30 and 75% meaning that the concentration level is 
appropriate.

• Low - indicates the reduction is less than 30% meaning that the concentration is too low and 
sample should be added.

• High - indicates the reduction is more than 75% meaning that the concentration is too high and 
more dispersant or less sample should be used.

9. When satisfied with the concentration level, click Next >>. 

10. The Load operation in progress window followed by a dual-paned window. The left pane 
contains the current baseline and full-scale scan. The right pane contains analysis data in progress.

If rinse after analysis is not specified, select the Rinse after analysis option any time 
while the analysis is in progress.
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Quick Start Analysis
Unit [n] > Quick Start

To perform analyses on multiple samples using the same analysis conditions. 

1. Go to Unit [n] > Quick Start.

2. If the analyzer has not been drained, select Prepare SediGraph to load sample to drain the 
mixing chamber. Then select to have the liquid remain in the mixing chamber after the drain and 
load operation or to leave the mixing chamber empty.

3. Click Report After Analysis to generate a report after analysis is complete. Select the destination 
and specify the number of copies to print.

4. To specify a different identification string, enter a new name in the Sample field. To have the 
sample file number included as part of the identification, the $ symbol must remain in the field.

5. Click Next>>. If Prepare SediGraph to load sample was selected, a drain is performed before 
being prompted to load the first sample.. 

To analyze a sample requiring different analysis conditions, click Browse and select the 
different sample file. Once this sample is completed, all conditions revert back to the 
ones established for the Quick Start series. 
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6. Load the sample. To change the mixing chamber speed, use the Increase or Decrease button.

7. Click Next>>. Analysis of the first sample begins. The current baseline and data display as they 
are collected

8. When analysis is complete, a prompt to load the next sample displays. Repeat steps 6 and 7 until 
all analyses are complete. 

Panes may be resized using standard Windows resizing functions. 
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Repeat Schedule
Unit [n] > Repeat Schedule

To perform multiple analyses on the same sample:

1. Go to Unit [n[ > Repeat Schedule.

2. Click Insert.

a.) Click Browse to select a sample file to use for analysis.

b.) Enter the number of tests (analyses) to perform.

c.) Select the Type of Analysis in the dropdown list.

d.) Click OK.

e.) Repeat this step for all analyses to be performed using this sample.

3. To edit a parameter file, highlight the file and click Edit.
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4. Click Report Settings to generate a report after analysis. Select the destination and specify the 
number of copies to print.

5. Click Start to begin the analyses. 

MasterTech Automatic
Unit [n] > MasterTech Automatic

Use to analyze a series of samples of the same type, using the same analysis conditions. Sample files 
containing the default analysis conditions are created automatically and used for all analyses. 

1. Go to Unit [n] > MasterTech Automatic.

2. In the Start with beaker field, enter the position number of the beaker containing the first sample 
to be analyzed.

3. In the Sample resuspension group box, enter the stirrer time, stirrer speed and probe time to use 
for sample resuspension. Samples tend to settle in the beaker while waiting for analysis, 
especially if samples are prepared ahead of time. This option allows samples to be redispersed 

When the analysis begins, the Start button changes to Stop. The Stop button cancels the 
remaining analyses. The analysis that is currently in progress will be completed.

This option is functional only if a MasterTech is connected to the analyzer. 
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before analysis. Coarse materials and less stable dispersions may need a higher speed and more 
stirring and probe time than finer samples.

4. Select Report After Analysis to generate a report after analysis. Select the destination and 
specify the number of copies to print.

5. In the Sample field, enter a default string for this series of samples.

6. Click Start.

The beaker number containing the sample can be included in the sample identification 
by entering # within the specified name. For example, Garnet in beaker #.

When the analysis begins, the Start button changes to Stop. The Stop button cancels the 
remaining analyses. The analysis that is currently in progress will be completed.

To view the analyses in progress, select Analysis Results from the View dropdown list.
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MasterTech Schedule
Unit [n] > MasterTech Schedule

Use to analyze a series of samples that are different in size and shape and require different analysis 
conditions. Baseline measurements can be scheduled between samples. 

1. Go to Unit [n] > MasterTech Schedule.

2. Click Insert.

a.) Enter the position number of the beaker containing the current sample.
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b.) Select Baseline measurement or Sample analysis.

• If Sample analysis is selected, click Browse to select a sample file to use with the sample 
in this beaker position. The values contained in the fields for Stirrer time, Stirrer speed, 
and Probe time are copied from the selected sample file.

• If Baseline measurement is selected, select the X-Ray intensity.

–  Normal - increases intensity when using high X-ray absorption liquids, such as 
water.

–  Low - decreases intensity when using low X-ray absorption liquids, such as 
hydrocarbons.

c.) Click OK. The beaker information displays in the list box.

d.) Repeat this step for each beaker containing sample.

If dispersing liquids will be changed at any time during this series, perform a baseline mea-
surement using the beaker position preceding the one containing the sample with the new 
liquid. For example, if dispersing liquids are changed with the sample contained in beaker 
position 4, insert a Baseline measurement for beaker position 3. 

3. Click Report Settings to generate a report after analysis. Select the destination and specify the 
number of copies to print. Click OK.

4. Click Start to begin the analysis.

When the analysis begins, the Start button changes to Stop. The Stop button cancels the 
remaining analyses. The analysis that is currently in progress will be completed.

To view the analyses in progress, select Analysis Results from the View dropdown list.
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Performing a Rinse Operation
Unit [n] > Rinse > [SediGraph, MasterTech, Both]

A rinse operation should be performed to rinse any debris or contaminants from the analysis cell. It is 
best to perform a rinse operation after each analysis. On the Analysis Options window, select that a 
rinse is to be performed after an analysis. Refer to Analysis Conditions, page 2-8. 

• SediGraph - rinses the analysis cell, mixing chamber, and tubing
• MasterTech - rinses the MasterTech tubing into a specified beaker
• Both - rinses the analysis cell, mixing chamber, and all tubing 

Rinse SediGraph
Unit [n]> Rinse >SediGraph

The following steps rinse the analysis cell, mixing chamber and tubing.

1. Pour approximately 10 liters of water containing a small amount of surfactant into the rinse 
container. For example, use 0.05% sodium metaphosphate (W/W) in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the waste 
container. Turn the caps clockwise to secure.

The rinse container should be rinsed thoroughly or replaced after each use.

Ensure that tube weights are attached to the rinse and waste tubes, that the overflow 
tube and waste tubes are in the waste container, and that the rinse tube is in the rinse 
liquid container.

Rinse 
container

Tube weight

Rinse tube
Overflow tube

Waste tube

Waste 
container
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3. Go to Unit [n] > Rinse > SediGraph.

4. Select one of the following:

• Autorinse - to have the analyzer automatically determine how many rinse cycles to perform. 

• Rinses - to specify the number of rinses. If Rinses is selected, enter the number of rinse cycles 
to perform.

5. Enter the operating speed of the cell pump. A speed of 2 usually is sufficient unless the material is 
difficult to rinse; then it may be necessary to use a higher speed.

6. Click Continue. Progress messages display until rinsing is complete.

Autorinse, in an effort to reestablish baseline conditions, performs three cycles of three 
rinses per cycle (default setting) before displaying an error message that baseline 
conditions cannot be reestablished.
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Rinse MasterTech
Unit [n]> Rinse >MasterTech

Use to rinse the MasterTech tubing into a specified beaker.

1. Pour approximately 10 liters of water containing a small amount of surfactant into the rinse 
container. For example, use 0.05% sodium metaphosphate (W/W) in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the waste 
container. Turn the caps clockwise to secure.

3. Go to Unit [n] > Rinse > MasterTech.

4. Enter the position number of the beaker to catch the rinse liquid. Ensure the beaker is empty.

5. Click Continue. Progress messages display until rinsing is complete.

Ensure that tube weights are attached to the rinse and waste tubes, that the overflow 
tube and waste tubes are in the waste container, and that the rinse tube is in the rinse 
liquid container.

Rinse 
container

Tube weight

Rinse tube
Overflow tube

Waste tube

Waste 
container
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Rinse Both
Unit [n]> Rinse >Both

To rinse the analysis cell, the mixing chamber, and the tubing for the analyzer and the MasterTech.

1. Pour approximately 10 liters of water containing a small amount of surfactant into the rinse 
container. For example, use 0.05% sodium metaphosphate (W/W) in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the waste 
container. Turn the caps clockwise to secure.

3. Go to  Unit [n] > Rinse > Both.

4. In the SediGraph group box, select one of the following:

• Autorinse - to have the analyzer automatically determine how many rinse cycles to perform. 

• Rinses - to specify the number of rinses. If Rinses is selected, enter the number of rinse cycles 
perform.

5. In the MasterTech group box, enter the beaker position number to catch the rinse liquid. Ensure 
the beaker is empty.

6. Click Continue. Progress messages display until rinsing is complete.

Ensure that tube weights are attached to the rinse and waste tubes.
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Generating Reports
Reports > Start Report (or use the F8 keyboard shortcut)

1. Select a sample file. The selected report name appears in the File name text box. To select 
multiple files, hold down the Ctrl  key on the keyboard while selecting the files, or hold down the 
Shift key to select a range of files.

2. Select a destination in the Settings group box. Refer to Print Options in Common Fields and 
Buttons - File Menu Options, page 3-1. Click OK.

3. If only one file was selected in Step 1, the Reports to Generate window displays. Verify the 
reports to generate and select additional reports if necessary. Click OK. If multiple files were 
selected, this window does not display.
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4. To view the reports, click the tab across the top of the window.

Status Display
All operational windows contain two common status displays; one in the upper portion of the window 
and one in the lower portion. Some status displays may contain more items than others, depending on 
the type of operation in process. The center portion of the window contains the activity of the current 
operation.

Go to Unit [n] > Show Status to display the status of the current operation.

Upper Display Items
The following is a typical upper status display.

Lower Display
The following is a typical lower status display.
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Printing Files
File > Print > [file type]

Prints the entire contents of a file. Select from:

• Sample information

• Analysis conditions

• Liquid properties

• Report options

Field or Button Description 

File name Displays the name of the selected file.

Files If the file(s) to be printed resides on a drive other than where the 
software is installed, select another drive in the Directories list 
box.

Select one or more files from the Files list box. To select 
multiple files, hold down the Ctrl  key on the keyboard while 
selecting the files, or hold down the Shift key to select a range 
of files.

Status Used as a filter to display only the files with the selected status.

Dates button Used as a filter to display only the files within the selected date 
range.
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Exporting Files
File > Export > [file type]

Data in a sample information file can be exported as:

• Smoothed ASCII - exports data in a form used in reports

• Raw ASCII - exports as time, height, and mass fraction

• Unsmoothed ASCII - exports data as collected by the instrument. Refer to DATA REDUCTION, 
page J-1 for information on the smoothing technique.

1. Go to File > Export.

2. Select a file from the list. To select multiple files, hold down the Ctrl  key on the keyboard while 
selecting the files, or hold down the Shift key to select a range of files. Click OK.

Settings group box • Copies - specify the number of copies to print or display

• Destination - specify screen, printer, or plotter as the print 
destination. Go to Options > System Configuration to 
configure the printer or plotter name.

• File Name - enabled only if File is selected in the 
Destination field.

Field or Button Description (continued)
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3. From the Destination dropdown list, select a list output destination. If File is selected, enter a 
name in the File name field.

4. Click OK. A list for the selected files is sent to the specified destination.
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Listing Files
File > List > [file type] > [file]

Provides the option to create a list of sample file information, for example, file name, date, time the file 
was created or last edited, file identification, and file status. 

1. Go to File > List > [file type].

2. Select a file from the list. To select multiple files, hold down the Ctrl  key on the keyboard while 
selecting the files, or hold down the Shift key to select a range of files.

3. From the Destination dropdown list, select a list output destination. If File is selected, enter a 
name in the File name field.

4. Click OK. A list for the selected files is sent to the specified destination.
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Converting Non-Windows Sample Files
File > Convert [file]

Converts sample information files created with the non-Windows version of the SediGraph analysis 
program to a file that is compatible with Windows.

After conversion, the converted file and associated parameter files can be used with any analysis as 
long as the analysis has not been completed. Material properties cannot be updated.

1. Go to File > Convert.

2. Using the Directories list box, navigate to the location where the non-Windows data files are 
stored.

3. From the Files list box, choose the files to convert. To select multiple files, hold down the Ctrl 
 key on the keyboard while selecting the files, or hold down the Shift key to select a range of files.

4. In the System directory field, enter the source directory of the non-windows parameter files.

Two types of parameter files are associated with a non-Windows sample file: Liquid Properties 
and User-Defined Report Tables. These files are required for a complete conversion. If a directory 

To filter the files by date, click Dates and specify a date range.

As sample files are converted, the referenced liquid properties and user-defined 
report tables are also converted. The Parameters field gives the destination for the 
converted parameter files.
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is not entered, the conversion proceeds but all files may not be found. A warning message is 
displayed in the Status window if parameter files are not found.

If converting files on the same computer where the files were created, the files are located 
automatically. If converting files created on a different computer, place a copy of the file(s) from 
the other computer onto the computer running the conversion. A warning message is displayed in 
the Status window if all parameter files are not found

5. Click OK. The status of the conversion displays. If the conversion was unsuccessful, possible 
reasons are given.

To stop the conversion, click Close. To close the status window, go to the system 
menu in the upper left corner and click Close or use the keyboard command of 
Ctrl+F4.
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Exit
File > Exit

Exits the program.

• If changes have been made to a file and not yet saved, a prompt displays providing the option to save 
the file.

• If a file is open with unsaved changes, a prompt displays providing the option to exit the program.

–  YESsaves the changes before exiting the program
–  NO exits the file without saving the changes
–  CANCELcancels any changes 

• If a report is being printed, the following message is displayed:

CAUTION: A report is currently printing. If you exit the program the report will be canceled. 
Do you want to cancel the report and exit the program?

–  YES cancels the report and exists the analysis program
–  NO leaves the analysis program active and allows the reports to finish

If the MasterTech is being used, the current analysis continues until it is finished; 
subsequent analyses are postponed and resumed when the analysis program is 
restarted.

Although data are stored in the analyzer exiting the program, data are not saved to disk 
in the computer until the program is reopened. If a power failure occurs and the 
analyzer does not have an Uninterruptible Power Supply (UPS), any data not saved are 
lost.
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Generating Overlays
Use the overlay function to compare multiple graphs. Overlays may be generated in three ways:

• from the same sample file to overlay multiple graphs. 
• from multiple sample files to overlay the same type of graph(s). 
• from the same sample file to overlay the same type of graph for all analyses (tests) used in this 

sample file. 

It is much easier to generate overlays if predefined report options files were created for specific over-
lay functions. For example, Out of Specification graphs if compared often, define a report options file 
containing the options and assign an identification such as Out of Spec Overlays. Then use Replace 
to load the predefined file into the sample file. Report options for the original sample file remain intact.

Overlay Multiple Graphs from the Same Sample File
1. Go to File > Open > Sample information.

2. Select the file and then click OK. If an Advanced button displays at the bottom of the popup 
window, click Advanced to change to Advanced view.
2-46 512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Generating Overlays
3. Select the Report Options tab.

4. Use one of the following methods:

If... Then... 

Using a predefined Report 
Options file

Click Replace and select the report options file to use.
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5. Go to Reports > Start report. 

6. Select a destination in the Settings group box. Refer to Print Options in Common Fields and 
Buttons - File Menu Options, page 3-1.

7. Click OK. Report options can be changed on the Reports to Generate list box.

8. Click OK. Selected overlays are generated and sent to the specified destination.

Defining report options a.) In the Test dropdown list, select the test to use.

b.) In the Reports to Generate list box, select the graph(s) to 
overlay with other graph(s). To select a graph, double-click 
the graph name. A checkmark to the left indicates the graph 
has been selected.

c.) Highlight a graph selected in Step 4.b) and click Edit.

d.) From the Overlay dropdown list, choose the type of graph 
to overlay; then click OK.

e.) Repeat Steps 4.c.) and 4.d.) for each selected graph.

If... Then... (continued)

The options do not have to be saved before generating overlay reports. If they are 
saved, the original report options will be overwritten.
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Overlay the Same Graph Type for Multiple Sample Files
1. Go to  File > Open > Sample information.

2. Select the file and then click OK. If an Advanced button displays at the bottom of the popup 
window, click Advanced to change to Advanced view.

3. Select the Report Options tab.
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4. Use one of the following methods:

If... Then... 

Using a predefined Report 
Options file

Click Replace and select the report options file to use.

Defining report options a.) In the Test dropdown list, select the test to use. The 
graph(s) selected for this report will be overlaid with the 
corresponding graph(s) of the test designated in the Report 
Options file(s) of the sample file(s) selected in step 7.

b.) In the Reports to Generate list box, select the graph(s) to 
overlay. To select a graph, double-click the graph name. A 
checkmark to the left indicates the graph has been selected.

c.) Highlight a graph selected in Step 4.b.) and click Edit.

d.) From the Overlay dropdown list, select Samples. Click 
OK.

e.) Repeat Steps 4.c.) and 4.d.) for each selected graph.
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5. Click Overlays.

6. Click Browse to select the sample information files.

7. Select up to eight files and click OK.

8. Go to Reports > Start report. 

9. Select a destination. Refer to Print Options in Common Fields and Buttons - File Menu 
Options, page 3-1.

10. Click OK. 

The options do not have to be saved before generating overlay reports. If they are 
saved, the original report options will be overwritten.
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Overlay the Same Type of Graph from the Same Sample File
1. Go to  File > Open > Sample information.

2. Select the file and then click OK. If an Advanced button displays at the bottom of the popup 
window, click Advanced to change to Advanced view.

3. Select the Report Options tab.
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4. Use one of the following methods:

5. Go to Reports > Start report. The sample information file selected in step 2 will be highlighted in 
the Files list.

6. Select a destination. Refer to Print Options in Common Fields and Buttons - File Menu 
Options, page 3-1.

7. Click OK. 

If... Then... 

Using a predefined Report 
Options file

Click Replace and select the report options file to use.

Defining report options a.) In the Reports to Generate list box, select the graph(s) to 
overlay. To select a graph, double-click the graph name. A 
checkmark to the left indicates the graph has been selected.

b.) Highlight a graph selected in Step 4.b.) and click Edit.

c.) From the Overlay dropdown list, select Tests. Click OK.

d.) Repeat Steps 4.b.) and 4.c.) for each selected graph.

The options do not have to be saved before generating overlay reports. If they are 
saved, the original report options will be overwritten.
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3.  FILE MENU

Introduction
This chapter contains information specific to the File menu options used in sample and parameter files. 
This chapter provides details of File menu options, commonly used functions and buttons, and field 
descriptions.

Common Fields and Buttons - File Menu Options
The following fields and buttons are common to many of the File Menu windows. Field and button 
descriptions not listed below are found in their respective sections.

Common field and button descriptions are listed in a Common table at the beginning 
of their respective chapters. Field and button descriptions not listed in the Common 
table are listed in their appropriate heading.

Field or Button Description 

Advanced button Click to change to Basic option presentation format.

Autoscale checkbox When enabled on report parameters screens, allows the x- and y-axes to be 
scaled automatically. Autoscale means that the x- and y- ranges will be set 
so that all the data is shown. If Autoscale is not selected, the entered range 
is used.

Axis Range On report parameters screens, the From / To fields are enabled when 
Autoscale options are not selected. Enter the starting and ending values for 
the x- and / or y-axes.
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Basic button Click to change to Advanced option presentation format.

Browse button or icon Click to search for a file. Select a file from either the Name column or from 
the library and click Open or double click the file name to open (or import) 
the file.

Cancel button Cancels any changes made to the screen.

Close Closes the active window. If changes were made to the file and not yet 
saved, a prompt displays providing the option to save the file.

Close All Closes all active windows. If changes were made and not yet saved, a 
prompt displays for each changed file providing the option to save the 
file.

Convert Converts a sample file created with a non-Windows version of the 
SediGraph analysis program to a file compatible with WIndows.

Delete button When working with report parameters screens, click Delete to remove the 
selected report. Deleted reports will have to be regenerated if deleted in 
error.

Edit button When working with report parameters screens, highlight the item in the 
Selected Reports list box and click Edit to modify report details.

Field or Button Description (continued)
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Exit Exits the program. 

If a file is open with unsaved changes, a prompt displays providing the 
option to save the changes and exit or to exit the program without saving the 
changes.

• Yes - saves the changes, then closes the window
• No - closes the window without saving the changes
• Cancel - cancels the Close command

Export Exports isotherm data in a sample information file as a .REP, .TXT or .XLS 
file. When saved to a file, the data can be imported into other applications.

File name text box Select a file from Files list box. The file name displays in the File name 
text box. Click Open or double-click the file name to open the file. To 
select multiple files, hold down the Ctrl  key on the keyboard while 
selecting the files, or hold down the Shift key to select a range of files.

From / To text boxes When working with report parameters screens, enter the From and To range 
for x- and / or y-axes.

List Provides the option to create a list of sample or report options file 
information, for example, file name, date / time the file was created or last 
edited, file identification and file status.

Name column A list of files in the selected directory or library.

Next >> Click to move to the next screen.

OK button Click to save and close the active window.

Open button Click to open the selected file (or double-click the file name in the Name 
column to open the file).

<< Prev Click to move to the previous screen.

Field or Button Description (continued)
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Print options Sends the report to the selected destination (screen, printer or file).

• Preview - sends the file to the screen. Click Print on the report screen to 
send the file to the printer.

• Print - sends the file to the default printer.

• Copies - select the number of copies to print. This field is only enabled 
when Print is selected.

• File - saves the report as a file. Click the Browse icon to the right of the 
text field to select the directory where the new file will be stored. Enter 
the new file name in the File name text box.

• File Type - use to save the new file with a .TXT, .XLS or .REP file 
extension. This field is only enabled when File is selected.

.REP (Report system) - saves the report in a format that can be opened 
within any MicroActive program.

.TXT (ASCII text) - saves the report as a text file.

.XLS (Spreadsheet file) - saves the report in a format that can be opened 
within a spreadsheet program.

Remove Removes an item from a list.

Replace button Click to select another file where the values will replace the current file’s 
values.

Save Saves the active window under the current file name.

Save All Saves all active windows under the current file names.

Save As • Saves a file in the active window under a different file name.

• Saves a subset (parameter) of the sample file in the active window as a 
standalone parameter file. For example, to create a standalone parameter 
file of the analysis conditions portion of the active sample file, go to File 
> Save As, select the Analysis Conditions folder in the library and enter 
a file name in the File name field. Click Save.

Field or Button Description (continued)
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Open
Select Open to create a file or edit an existing one. The following file types are available:

• Sample Information files - the File name text box contains the next sequential sample information 
file name generated by the program. The sample information file extension is .SMP.

• Parameter files - the File name text box contains an asterisk (*) and a default file extension 
depending on the type of parameter file selected. Default file extensions are:

*.SMP Sample Information
*.ANC Analysis Conditions
*.LIQ Liquid Properties
*.RPO Report Options 

Settings group box • Copies - specify the number of copies to print or display

• Destination - specify screen, printer, or plotter as the print destination. 
Go to Options > System Configuration to configure the printer or plotter 
name.

• File Name - enabled only if File is selected in the Destination field.

Table buttons • Insert - inserts one row above the selected row.
• Delete - deletes the selected row.
• Clear - clears all table entries and displays only one default value.
• Append - inserts one row at the end of the table.

View Instrument Log For use by a Service Technician. Operators should use Unit [n] > Show 
Instrument Log. Refer to Show Instrument Log, page 4-30.

Field or Button Description (continued)
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Sample Information Files - Advanced Format
File > Sample Information > [file name]

Each analysis must be linked with a sample information file before the analysis can proceed. A sample 
information file can consist of parameter files, however, parameter files can also stand alone.

Parameter files allow repeated use of the file, for example, if the same analysis conditions exist for 
multiple analyses, create an Analysis Conditions file containing the recurring conditions. When the 
sample file is created, select the Analysis Conditions file for the analysis conditions. Once it becomes 
part of the new sample file, edit the new file as needed without affecting the original Analysis Condi-
tions file. Sample Information files can be created or opened in Advanced, Basic, or Restricted format. 
Refer to Creating Sample Files in Advanced Format, page 2-4 provides step-by-step instructions for 
creating a Basic sample information file.     

Specify or change the default format by selecting Options > Option Presentation or 
select Basic / Advanced from the drop-down list at the bottom of the window. Refer to 
Editing the Sample Default File, page 2-1 for a description of the Advanced, Basic, and 
Restricted formats.

Field or Button Description 

Sample text box Enter a description of the sample.

Operator / Submitter 
text boxes

Enter identification information in the respective text boxes. Some text 
boxes may have been renamed or may not display if modified in Options > 
Sample defaults.
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Type of Data group 
box

• Automatically collected - select if the type of data will be automatically 
collected by the system while an analysis is running.

• Manually entered - use to manually enter data collected from another 
source.

User Parameters 
group box

These fields are primarily used for the SPC (Statistical Process Control) 
reporting to specify sample characteristics or its manufacturing process but 
may be used for other data by entering specific analysis conditions or 
sample criteria. 

The entered parameters display on the Sample Information window, in 
Reports > SPC Report Options, and the Summary Report.
Choose to hide or display these fields or modify the default alphanumeric 
field labels in Options > Sample defaults.

Comments text box Enter comments about the sample or analysis. Comments display in the 
report header.

Add Log Entry 
button

Use to enter information to appear in the sample log report that cannot be 
recorded automatically through the application. Click the button again to 
enter multiple log entries.

Replace All button Click to select another .SMP file where the values will replace all values for 
the active Sample Information file. The original file will remain unchanged.

Close button

Save button

Refer to Common Fields and Buttons - File Menu Options, page 3-1

Field or Button Description (continued)
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Sample Information Files - Basic Format
When in Basic format, all parts of the sample information file are contained on one window. With the 
Basic format, a sample information file can be quickly created using predefined parameter files. Refer 
to Creating Sample Files in Basic or Restricted Format, page 2-6 provides step-by-step instructions 
for creating a Basic sample information file.

Field or Button Description

Sample Contains the next sequenced file description based on the format 
specified in Sample defaults. 

Analysis Conditions Displays a dropdown list containing analysis conditions files. 
This list is disabled for files which have been used for an 
analysis.

Sample / Liquid Displays the type of sample and dispersing liquid used with the 
analysis conditions file selected in the Analysis Conditions 
dropdown list.

Sample Density Displays the density of the sample specified in the Analysis 
conditions file. These properties may be edited on samples file 
not used in an analysis. If significant adjustments are required, 
switch to advanced format and define a new type of sample 
material.

If the sample file is complete, density properties may be edited by selecting Advanced. Then 
select the Material Properties tab and Update Properties.

Number of tests Enter the number of analyses to perform with this sample file.
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Rinse after analysis Select to rinse the cell, the tubing, and the mixing chamber after 
each analysis. It is highly recommended that this option remain 
selected. If deselected, rinses are not performed after analysis 
and inaccurate results may be obtained.

Report Options Displays a dropdown list containing report options files.

Reports list box Displays the specified reports from the file selected from the 
Report Options dropdown list.

Merge with external data Select to merge data collected using manual methods with the 
data collected for the current analysis.

External Data button Enabled only if selected Merge with external data is selected. 
Allows the entering of data to be merged.

• Insert - enter new data in the table. If this is a particle size 
table, enter the particle size and cumulative percent for the 
particle. If this is a sieve table, a set of sieves is displayed to 
enter the percent passed through each size.

• Delete - removes the selected row from the table.

• Clear - deletes all but one entry of the table (one entry is 
required). 

Field or Button Description
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External Data button 
(continued)

• Size Type - specify the type of size data.

• Distribution Type - specify the type of distribution data.

• Autoscale percent of total sample - When selected, the 
overlapping regions of the collected data and the merged data 
are used to rescale the collected data so that the regions 
match. 

When deselected, the percentages entered for the merged 
data are used and the non-overlapping portion of the 
collected data is scaled to be the percent passing through the 
smallest sieve. 

Full scale mass percent Specify the weight percent of the sample actually analyzed by 
the analyzer versus the percent that is manually analyzed. The 
data are scaled accordingly.

Use this option if part of the sample was analyzed by another 
method you do not want to merge those results with the reports 
for the current analysis.

This field is disabled if Merge with external data is selected.

Close button

Replace button

Save button

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description
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Analysis Conditions Files
File > Open > Analysis conditions > [file name] (or click the Analysis Conditions tab when in 
Advanced format)

Material Properties
The Material Properties tab specifies properties for the sample and analysis liquid. 

Field or Button Description 

Description Enter the description of the analysis conditions file.
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Sample Material group box Displays a list of available sample materials. When a sample 
material is selected, the description and density display.

• Description - the selected sample material. Enter the name 
of sample materials to add to the list.

• Density - the density of the sample material selected from the 
list.

• Add - adds sample materials to the list. 

To add samples materials - in the Description field, enter the 
name of the sample material, then click Add.

To change values of the sample material density - highlight 
the sample material in the list, then enter the density value in 
the Density field.

• Delete - deletes sample materials from the list. 

Field or Button Description (continued)
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Analysis Liquid group box Displays a list of the Liquid Properties files.

• Description - the selected analysis liquid. Enter the name of 
analysis liquids to add to the list.

• X-Ray Intensity - the X-ray intensity selected for the 
analysis liquid. The intensity is selected in Liquid Properties 
window.

• Add - adds analysis liquids to the list and change values for 
an analysis liquid.

To add analysis liquids - in the Description field, enter the 
name of the liquid, then click Add.

To change values of an analysis liquid - highlight the liquid, 
then click Properties. Enter the new values, then click OK. 
Note that Add changes to Change; click Change.

• Delete - deletes the selected liquid from the list.

• Properties button - edit the properties of the analysis liquid. 
Refer to Liquid Properties, page 3-21.

Field or Button Description (continued)
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Analysis Type Specifies if the analysis is Standard, High Speed or High 
Resolution.

• Standard - provides good resolution and average analysis 
time.

• High speed - allows a faster analysis, but a little lower 
resolution. 

• High resolution - provides high resolution at the smallest 
diameters, but takes a longer time.

• Starting diameter - specify the range of sizes to be included 
in the analysis. The starting diameter generally should be 
larger than the largest particle expected to be in the sample.

• Ending diameter - the ending diameter must be less than the 
smallest size particle of interest.

Each time the values in these fields are changed, the analysis 
statistics are updated. A note also is added to the report header 
indicating changes have been made since the first analysis was 
performed.

Field or Button Description (continued)
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Analysis Unit Displays a list of the attached units and their temperatures. The 
displayed temperature is used to compute analysis statistics.

• Reynolds number - calculated for the starting diameter 
using the sample’s density and the liquid’s density and 
viscosity. If this number is greater than 0.3, large particles 
falling through the liquid may create turbulence, affecting 
both their velocity and the velocity of neighboring smaller 
particles. This results in an incorrect particle size 
distribution.

• Maximum diameter - calculated to have a Reynolds number 
equivalent to the one entered as a default (from the Options 
menu). If the sample has more than a couple percent mass of 
particles larger than this diameter, the sample should be 
analyzed in a liquid with a higher viscosity.

• Analysis time - calculated based on the sample density, 
liquid density and viscosity, and ending diameter. The actual 
analysis time may vary slightly if the analysis compartment 
temperature is different when the analysis takes place.

The Reynolds number, Maximum diameter, and Analysis 
time fields display analysis statistics. These values are updated 
whenever a parameter affecting their computation is changed.

Field or Button Description (continued)
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Update Properties button Allows the updating of the material properties of a completed 
analysis. This allows the collected data to be reprocessed based 
upon the new properties.

The material properties for the original analysis remain 
unchanged. A note is added to the report header describing the 
change.

The contents of the Sample Material and Analysis Liquid 
group boxes are described in Material Properties, page 3-11.

• Set Baseline - applies a baseline different than the one active in 
the original analysis.

From the dropdown list, choose the instrument containing the 
baseline to use, then select Use alternate baseline. The 
original baseline is preserved.

Field or Button Description (continued)
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Update Properties button 
(continued)

• Apply Changes button - select to apply all changes to the 
material properties.

Click Yes at the prompt - All test data will be converted to 
the new data reduction options. Do you wish to continue?

The data are converted and this prompt displays - 
Application of new reduction options (file name) is 
complete.

Click OK to close the message box.

Close button

Save button

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description (continued)
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Analysis Options
The Analysis Options tab provides details for setting up the sample analysis conditions file. Analysis 
options can be edited as long as the analysis is not in progress and the sample file does not contain 
manually entered data. Changes made to analysis parameters are noted in the report header upon com-
pletion of the analysis.  

Field or Button Description  

MasterTech Treatment 
group box (applicable 
only if using a 
MasterTech)

Samples tend to settle in the beakers while waiting for sample analysis, 
especially if samples are prepared ahead of time, as in most cases when 
using a MasterTech. Program the MasterTech stirrer and probe to re-
disperse the sample using options in the group box.

• Stirrer time - the number of seconds to have the stirrer operate during 
resuspension.

• Stirrer speed - coarse materials and less-stable dispersions may 
require more high-speed stirring than finer materials. Range: 1 to 10, 
with 1 being the slowest

• Probe time - how long to have the ultrasonic probe operate during 
resuspension. Coarse materials and less-stable dispersions may require 
more high-speed stirring than finer materials.
3-18                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Analysis Conditions Files
Full Scale Scan group 
box

• Pump speed - the speed at which the cell pump should operate during 
the full-scale scan. 

Use a pump speed of 2 or 3 if analyzing fine samples since they pump 
through the tubing easily. If analyzing coarse particles, especially if 
dispersed in higher viscosity liquids, a higher pump speed of 4 to 5 
should be used.

If the analyzer has the smaller 5 mm (3/16 in.) OD tubing, higher 
speeds may be required for finer particles. 

• Bubble detection - types of bubble detection.

The presence of most bubbles in the cell can be detected during the 
full-scale scan that takes place at the start of the analysis. Detecting 
bubbles, however, is somewhat sample-dependent. Samples which 
contain very large particles may appear to have bubbles near the top of 
the cell, when actually the sudden change in X-ray intensity is due to 
incomplete filling of the topmost portion of the analysis cell. For 
samples of this type, select Coarse bubble detection.

If only small particles are present in the sample (less than 1 mm), select 
Fine bubble detection. For samples between these two ranges, select 
Medium bubble detection.

Field or Button Description  (continued)
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Other items group box • Stop at selected mass percent - stops analysis at a specified mass 
percent finer.

If unsure of the smallest size particle present in the sample, it may be 
difficult to determine an ending diameter which will include the 
selected data. With this option, choose to end mass percent at 0%, after 
having set the ending diameter at a small value of approximately 0.1 
μm. Using this method, wait time is lessened at the end of the analysis.

• Ending percent finer  - enabled only if Stop at selected mass percent 
is selected. Enter the point at which the analysis should stop. 

• Number of tests - enter the number of analyses to be performed. 

• Leave pump on during analysis  - coarse materials tend to settle in the 
tubing during analysis. This option allows the pump to operate during 
analysis, enabling easier rinsing and resuspension of the sample.

• Wait for temperature stabilization  - select to have the temperature in 
the analysis compartment and mixing chamber stabilize to within 
+ 0.5 oC of the setpoint before the analysis begins.

• Mixing chamber stirrer speed - adjusts the speed of the magnetic 
stirring bar, which stirs the mixture in the mixing chamber. Select a 
number between 1 and 10. 1 represents the lowest speed and 10 the 
highest.

Rinse group box • Rinse after analysis - select if a rinse cycle should be performed after 
analysis.

• Autorinse - performs up to three cycles of three rinses each (a total of 
nine rinses) in an attempt to reestablish baseline conditions. If 
conditions are not reestablished after nine rinses, an error message is 
displayed. 

• Rinses - the number of rinses to be performed. 

• Pump speed - the speed for the cell pump to operate during rinsing. 
The range is 1 to 5, with 1 being the slowest.

Close button

Save button

Basic button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description  (continued)
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Liquid Properties
Liquid Properties is used to edit the properties of an analysis liquid and to specify properties for a new 
liquid properties file.

The liquid properties is edited by selecting the Materials Properties window and clicking 
the Properties button in the Analysis Liquid group box.

Field or Button Description 

Description If editing an existing file, this field contains the name of the 
selected file. If defining a new file, enter a name in this field.

Current Cell Conditions group 
box

Displays the cell conditions of the analysis unit. These 
conditions are based on the temperature of the cell and are used 
in computing the analysis statistics displayed on the Material 
Properties window.

Choose either fixed values or interpolated values based on the 
cell temperature.

• Fixed values - enter a value in the Viscosity and Density 
fields. These values will be maintained regardless of the cell 
temperature.
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Current Cell Conditions group 
box (continued)

• Interpolate using cell temperature - enter three sets of 
values in the Temp., Density, and Viscosity fields. These 
values will be used to interpolate the density and viscosity at 
the current cell temperature.

The table requires that the entered values be properly 
ordered. Temperature in ascending order for example. Enter 
values from left-to-right and from top-to-bottom.

X-Ray intensity • Normal - optimized for most applications when using high 
X-ray absorption liquids, such as water.

• Low - decreases intensity when using low X-ray absorption 
liquids, such as hydrocarbons. 

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description (continued)
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Report Options Files
File > Open > [.RPO file] (or click the Report Options tab when in Advanced format)

Use to specify report options for collected (from an analysis) or manually entered data. Report Options 
files also help in customizing report details such as axis scale, axis range, column headings, and com-
ponents of thickness curve equations. Refer to REPORTS MENU, page 5-1.

Customized report options files can be created then loaded into a sample file allowing quick and easy 
generation of reports.

Field or Buttons Description 

Report options When editing an existing file, this field displays the 
identification of the report options file.

Show report title Select to include a title in reports. Enter the title name in the text 
box. Refer to Report Header, page 5-16.

Show graphic Select to include a graphic. Enter the pathname of the graphic or 
click Browse and select a file. Refer to Report Header, page 5-
16.

Height / Width - Enter the height and width of the graphic, in 
inches.

Distribution Type Select the type of distribution data to report.
512-42805-01 (Rev C) - Apr 2022 3-23 



Report Options Files SediGraph III Plus
Reference button Specify a reference sample file to compare analysis results of the 
current sample.

Specification button Select the sample files to be used for the coarse and fine 
specification boundaries to determine if the results of the current 
sample are within the specified boundaries.

Overlays button Select the sample files to overlay onto selected plots.

Test dropdown list Select the analysis for the report

Field or Buttons Description (continued)
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Reports to Generate Contains a list of available reports. 

Edit button (for tables) Click to edit the options of the table reports in the Reports to 
Generate list box. Highlight the report then click Edit. Views 
will vary depending on the report selected.

• Column [n] - specify the type of data to display in that 
column. 

• Order of Sizes - choose the order for data.

• Truncate table at distribution limits - use to shorten the 
table to the limits of the distribution.

• Data Points Table - enter the values for the reported data.

Field or Buttons Description (continued)
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Edit button (for graphs) Use to edit a graph in the Reports to Generate box. Highlight 
the graph and click Edit.

• Plot Type - select either curve or histogram for the plotted 
graphs.

• Autoscale Options - automatically scales the X- and / or Y-
axes automatically. Both axes begin at zero, and the system 
uses the highest values collected during analysis as the 
ending points. The Axis Range fields are disabled if 
autoscale data is selected.

• X-Axis - select how to display the X-axis values. 

• Overlay - displays the types of overlays

–  Samples - select to to overlay the same type of curve 
from a different data reduction. Then click Overlays on 
the Report Options window.

–  Tests - use to overlay the same type of curve from all 
tests performed with this file.

• Axis Range - specify beginning and ending values for the X- 
and Y-axis ranges. Data collected outside these ranges are not 
included in the plot.

Field or Buttons Description (continued)
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Collected / Entered Data
This window displays only when using the Advanced presentation format. Depending on the type of 
data selected on the Sample Information window, this window displays as either Collected Data or 
Entered Data.

Collected Data

Browse button

Cancel button

Close button

OK button

Save button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

The values entered in the To fields must be greater than the values entered in the From 
fields.

Field or Button Description 

Table Displays the data collected for the current test.

Field or Buttons Description (continued)
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Test dropdown list Displays the current test for this sample file. To view data for 
another test, click on the down arrow to select the test.

Delete test button Deletes the selected test.

Merge with external data 
checkbox

Select to merge data collected by manual methods with the 
collected data.

External Data button Enabled when Merge with external data is selected. Displays 
the External Data window for the entry of data to be merged.

• Insert button - insert new data in the table. If this is a 
particle size table, enter the particle size and cumulative 
percent for the particle. If this is a sieve table, a set of sieves 
is displayed to enter the percent passed through each size.

• Delete button - removes the selected row from the table.

• Clear button - deletes all but one entry of the table (one 
entry is required). 

• Size Type - specify the type of size data.

–  Particle size - particle diameter and cumulative percent 
for the sample. 

–  Sieve size - the percent passed through each sieve.

Field or Button Description (continued)

This table displays if Sieve Size 
is selected for the size type.
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External Data button 
(continued)

• Distribution Type - specify the type of distribution data.

• Autoscale percent of total sample - when selected, the 
overlapping regions of the collected data and the merged data 
are used to rescale the collected data so that the regions 
match. 

When deselected, the percentages entered for the merged 
data are used and the non-overlapping portion of the 
collected data is scaled to be the percent passing through the 
smallest sieve. 

Full scale mass percent text box Specify the weight percent of the sample actually analyzed by 
the analyzer versus the percent that is manually analyzed. The 
data are scaled accordingly.

Select if part of the sample was analyzed by another method but 
you do not want to merge those results with the reports for the 
current analysis.

This field is disabled if Merge with external data is selected.

Distribution Type Option disabled. Select the Distribution Type from the Report 
Options window.

Cancel button

Close button

OK button

Save button

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description (continued)
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Entered Data

Data cannot be entered if the analysis program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.

Field or Button Description 

Insert button Enter new data in the table. If this is a particle size table, enter 
the particle size and cumulative percent for the particle. If this is 
a sieve table, a set of sieves is displayed for the entry of percent 
passed through each size.

Size Type Size Type - specify the type of size data.

• Particle size - particle diameter and cumulative percent for 
the sample. 

• Sieve size - the percent passed through each sieve.

Distribution Type Specify the type of distribution data.

Cancel button

Close button

OK button

Save button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.
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4.  UNIT MENU

Introduction
This chapter contains information specific to the Unit menu options. These options are used to run 
analyses on one or more units attached to a controlling computer. This chapter provides details of Unit 
menu options, and descriptions of commonly used functions and buttons.

The title bar of the main window displays as Unit [n] for each attached unit. Each unit has a status win-
dow displayed in different colors.

The Unit menu does not appear on the menu bar if the analysis program is being used 
for offline data manipulation.

Common field and button descriptions are listed in a Common table at the beginning 
of their respective chapters. Field and button descriptions not listed in the Common 
table are listed in their appropriate heading.
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Common Fields and Buttons - Unit Menu Options
The following fields and buttons are common to many of the Unit menu options. References are made 
to these fields and buttons throughout this manual.

Field or Button Description 

Browse button Click to search for a file. Select a file and click OK or double click the file 
name.

Cancel button Discards any changes made to the screen or cancels the current process. On 
the Analysis window, at the prompt, choose the port(s) to cancel.

Clear button Removes all of the entries at once.

Close button Click to close the active window. 

Delete button Deletes unwanted files.

Edit button On the analysis window, click to edit the sample information file. Refer to 
Sample Information Files - Advanced Format, page 3-6.

Next >> Click to move to the next screen.

OK button Click to save and close the active window.

<< Prev Click to move to the previous screen.

Replace button Copies values from an existing file into the active file. On the pop-up 
window, choose the file containing the values to be copied. Click OK, the 
values are copied into the new file. 

Report Options • Report After Analysis - designate report options to be generated after 
each analysis.

• Number of Reports - specify the number of reports to print if Printer 
or Printer / Plotter is selected for the destination.

• Destination- select the print output destination.

• File name - enabled only if File is the destination. Enter a file name.

If File is selected, the tabular reports of the requested file are con-
verted to a text file which can be viewed with a text editor or other text 
file manipulation tools. 

Start button Click to start an operation.
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Sample Analysis
Unit [n] > Sample Analysis

Use to perform individual sample analyses. 

Table buttons • Insert - inserts one row above the selected row.
• Delete - deletes the selected row.
• Clear - clears all table entries and displays only one default value.
• Append - inserts one row at the end of the table.

View dropdown list • Operation - use to display the current mode of operation.

• Analysis Log - use to display recent analyses, calibrations, errors or 
messages. Refer to Show Instrument Log, page 4-30.

• Analysis Results - displays the results of the current analysis.

• Instrument Schematic - use to display a schematic of the analyzer 
system. Refer to Show Instrument Schematic, page 4-28.

Field or Button Description 

Sample Displays the sample identification.

Field or Button Description (continued)
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Analysis Conditions Displays the analysis conditions file in the selected sample 
information file. Click the dropdown arrow to select another 
analysis condition file. This list is disabled for files used for an 
analysis.

Sample / Liquid Displays the type of sample and dispersing liquid used with the 
analysis conditions file.

Sample Density Displays the density of the sample specified in the analysis 
conditions file. Properties may be edited if the sample file is not 
complete (used in an analysis). If significant adjustments are 
required, switch to advanced mode and define a new type of 
sample material. 

Number of tests Enter the number of analyses  to perform using this sample file.

Rinse after analysis Rinses the cell, tubing, and mixing chamber after each analysis. It 
is highly recommended that this option remain selected. If this 
option is deselected and rinses are not performed after analysis, 
inaccurate results may be obtained.

Report Options Displays the report options file in the selected sample information 
file. 

Reports list box Displays the selected reports from the file selected in the Report 
Options dropdown list.

Merge with external data Select to merge data collected using manual methods with the 
data collected for the current analysis.

External Data button Refer to External Button in the Field or Button table in 
Collected / Entered Data, page 3-27.

Full scale mass percent Refer to External Button in the Field or Button table in 
Collected / Entered Data, page 3-27.

Next >> Saves all selections and displays options for Drain and Load and 
Report options.

Drain and load options • Prepare SediGraph to load sample - select if the sample 
has not been loaded into the mixing chamber. If selected, a 
drain and load operation is performed.

• Leave liquid in mixing chamber / Leave mixing chamber 
empty - select if the liquid should remain in the mixing 
chamber or leave the mixing chamber empty.

Report Displays the report(s) selected in the report options file.

Field or Button Description (continued)
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Browse button
Cancel button
Close button
Next >> button
OK button
<< Prev button
Replace button
Report Options
Start button
Table buttons
View dropdown list

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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Quick Start
Unit [n] > QuickStart

Use this mode of operation to analyze a series of samples of the same type which contain the same 
analysis conditions. Sample files are created automatically.

Field or Button Description 

Prepare SediGraph to load 
sample

Select if the sample is not loaded. If selected, an initial drain and 
load operation is performed.

Analysis Liquid Level Specify to leave analysis liquid in the mixing chamber or leave 
the mixing chamber empty between samples.

Sample Use to automatically generate sample files with a different string 
other than the one specified in sample defaults. Include the $ 
symbol to have the sample number included as part of the name.

A prompt displays indicating to load the sample when Next >> is clicked.

If Prepare SediGraph to load sample is selected, a drain operation is performed before the 
following window is displayed.
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Filename Defaults to the next sequenced sample number for the next 
analysis.

Sample Enter a name for the sample.

Mixing chamber speed Specify the mixing chamber stirrer speed using the Increase and 
Decrease  buttons.

Click Next >> to display the analysis in progress. A baseline graph and full-scale scan are displayed 
in the left side of the window, while sample data (as they are collected) are displayed in the right side 
of the window. 

When the analysis is finished, the start next analysis view is displayed.

Field or Button Description (continued)
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Repeat Schedule
Unit [n] > Repeat Schedule

Use to perform multiple analyses on the same sample. View the analyses in progress by selecting Anal-
ysis Results in the View dropdown list. 

Browse button
Cancel button
Close button
Next >> button
OK button
<< Prev button
Report Settings
View dropdown list

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Fields or Buttons Description 

 Repeat Schedule window Displays the sample files selected for analysis.

Field or Button Description (continued)
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Insert button Use to select the sample files for the analyses. 

• Number of Tests - enter the number of analyses  to perform 
using the selected sample information file.

• Type of Analysis - select either Standard, High Speed or 
High Resolution.

Edit button Click to edit the selected file. 

Browse button

Cancel button

Clear button

Delete button

OK button

Report Settings button

Start button

View dropdown list

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Fields or Buttons Description (continued)
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MasterTech Automatic

Unit [n] > MasterTech Automatic

Use to analyze a series of samples of the same type which contain the same analysis conditions. Sam-
ple files are created automatically.

This option is functional only if a MasterTech is connected to the analyzer. 

Field or Button Description 

Start with beaker Enter the position number of the beaker containing the first 
sample to be analyzed. This field is disabled if an analysis is in 
progress.

Sample resuspension group box Enter resuspension parameters. All fields in this group box are 
disabled if an analysis is in progress.

Samples tend to settle in the beaker while waiting for analysis, 
especially if samples are prepared ahead of time, as in most 
cases when using a MasterTech. Use the options in this group 
box to program the MasterTech stirrer and probe to re-disperse 
the sample before analysis.

• Stirrer time - enter the number of seconds to have the stirrer 
operate during resuspension.
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Sample resuspension group box 
(continued)

• Stirrer speed - choose stirrer speed. Coarse materials and 
less-stable dispersions may require more high-speed stirring 
time than finer materials.

• Probe time - enter how long to have the ultrasonic probe 
operate during resuspension. Coarse materials and less-stable 
dispersions may require more probe time than finer 
materials.

Sample Enter the name and default string to have applied to the sample 
files of the current series of analyses. The beaker number 
containing the sample in the sample identification can be used 
by entering # within the name. For example, Sample in beaker #.

Cancel button

Close button

Report Options

Start button

View dropdown list

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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MasterTech Schedule

Unit [n] > MasterTech Schedule

Use to: 

• Analyze a series of samples which may be different in size and shape and require different analysis 
conditions

• Perform a series of baseline measurements

• Analyze samples and measure a baseline alternately

This option is functional only if a MasterTech connected to the analyzer. 
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Field or Button Description 

Insert button Click to insert sample files to be used for analyses.

If a sample file is selected, the new file will be inserted before 
the selected file; otherwise it will be inserted at the end of the 
list.

• Beaker Number - enter the beaker number containing the 
selected sample (or baseline liquid).

• Baseline / Sample analysis - specify either a baseline 
measurement or sample analysis for the specified beaker. If 
Baseline measurement is selected, select the X-Ray 
intensity.

–  Normal - increases intensity when using high X-ray 
absorption liquids, such as water.

–  Low - decreases intensity when using low X-ray 
absorption liquids, such as hydrocarbons.

Use this option if  planning to change dispersing agents with one of the samples. A baseline 
measurement can then be scheduled using the beaker preceding the one containing the 
different dispersant. For example, if planning to change dispersing liquids in beaker position 
#4, schedule a baseline measurement in beaker position #3.
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Insert button (continued) • Sample analysis - click Browse, then choose the sample file  
to use with the sample in this beaker position.

–  Stirrer time - the number of seconds to have the stirrer 
operate during resuspension.

–  Stirrer speed - choose stirrer speed. Coarse materials 
and less-stable dispersions may require more probe 
time than finer materials.

–  Probe time - the length of time to have the ultrasonic 
probe operate during resuspension. Coarse materials 
and less-stable dispersions may require more high-
speed stirring time than finer materials.

• Sample ID - displays the sample identification string of the 
selected sample file.

Edit button Edit a sample file or dispersion conditions. Refer to the Insert 
button description given above. .

Cancel button

Clear button

Close button

Delete button

Report Options

Report Settings button

Start button

View dropdown list

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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Baseline
Unit [n] > Baseline

Before performing an analysis, a baseline measurement for data collection must be taken. It is not nec-
essary to measure a baseline for each analysis. Micromeritics recommends that a baseline 
measurement be performed at the change of each shift or if changing dispersing agents. Up to seven 
measurements may be performed; however, only the last one obtained may be used. 

Field or Button Description 

Prepare to load baseline liquid Select if the baseline liquid is not loaded.

• Leave liquid in mixing chamber / Leave mixing chamber 
empty - select if the liquid should remain in the mixing 
chamber or leave the mixing chamber empty.

X-Ray intensity • Normal - increases intensity when using high X-ray 
absorption liquids, such as water.

• Low - decreases intensity when using low X-ray absorption 
liquids, such as hydrocarbons.

If Prepare to load background liquid is selected, a drain and load operation is performed before 
the baseline measurement begins. Load the baseline liquid when prompted. Click Next>> to 
begin the baseline measurement.
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Baseline to use Select whether to use the latest or the previous baseline. 

• Latest - uses the last baseline performed.

• Previous - uses the baseline which was active before the last 
series of baselines were performed.

Cancel button
Close button
Next >> button
<< Prev button
Report After Analysis group box

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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Drain and Load
Unit [n] > Drain and load

Before collecting baseline data or performing an analysis, the analyzer must be drained of any previous 
sample (or baseline liquid). Then reload a sample (or baseline liquid). Use one of the following 
methods:

• Prior to a baseline collection or an analysis, select Unit [n] > Drain and Load (explained below).

• At the beginning of a baseline collection, select the Prepare to load baseline liquid check box on 
the Baseline Measurement window.

• At the beginning of an analysis, select the Prepare SediGraph to load sample check box on the 
Select Drain and Load window..

Field or Button Description 

Leave liquid in mixing chamber 

Leave mixing chamber empty

Select to indicate to leave liquid in the mixing chamber or if 
leave the mixing chamber empty.

Continue button Click to continue the drain operation.
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 Mixing chamber speed Specify the speed of the mixing chamber stirrer using the 
Increase and Decrease buttons.

Continue button Select to continue the operation. Refer to the table in Sample 
Analysis, page 4-3 for more details.

Cancel button Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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Rinse

Unit [n] > Rinse

A rinse operation should be performed to rinse the analysis cell, mixing chamber, and tubing of any 
contaminants or sample materials from the previous analysis.

When Rinse is selected, three choices are available:

• SediGraph - rinses the analysis cell, mixing chamber, and the analyzer tubing.

• MasterTech - rinses the MasterTech tubing.

• Both (SediGraph and MasterTech) - rinses the analysis cell, mixing chamber, the analyzer tubing, 
and the MasterTech tubing.

SediGraph Rinse
Unit [n] > Rinse > SediGraph

A rinse operation cannot be performed when an analysis is in progress.

Field or Button Description 

Rinse Cycles • Autorinse - performs up to three cycles of three rinses each 
(a total of nine rinses) in an attempt to reestablish baseline 
conditions. If conditions are not reestablished after nine 
rinses, an error message is displayed. Refer to Autorinse, 
page 6-4.

• Rinses - specifies up to five rinses to be performed. 
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Cell Pump Speed The speed for the cell pump is to operate during rinsing. The 
range is 1 to 5, with 1 being the slowest.

Continue button Begins the rinse operation. A message displays indicating a rinse 
operation is in progress. When rinsing is complete, the window 
closes.

Cancel button Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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MasterTech Rinse
Unit [n] > Rinse > MasterTech

This option is available only if a MasterTech connected to the analyzer and analyses 
are not in progress.

Field or Button Description 

Rinse beaker number Enter the position number of the beaker  to rinse into. Ensure the 
beaker is empty.

Continue button Begins the rinse operation. A message is displayed indicating a 
rinse operation is in progress. When rinsing is complete, the 
window closes.

Cancel button Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Both
Unit [n] > Rinse > Both.

Field or Button Description 

SediGraph group box • Autorinse - the analyzer to automatically determines how 
many rinse cycles to perform.

• Rinses - the number of rinses to perform.

Cell Pump Speed Enter the speed the cell pump should operate during rinsing. The 
range is 1 to 5, with 1 being the slowest.

MasterTech group box Enter the position number of the beaker to rinse into. Ensure that 
the beaker is empty.

Continue button Begins the rinse operation. A message is displayed indicating a 
rinse operation is in progress. When rinsing is complete, the 
window closes.

Cancel button Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Initialize MasterTech
Unit [n] > Initialize MasterTech

Select this option if:

• Manual operations should be performed with the MasterTech
• The MasterTech beaker tray has been disturbed

When the MasterTech is initialized, the tray is aligned so that beaker #1 is in the starting position..

Field or Button Description 

Continue button Begins the initialization operation. A message is displayed 
indicating a operation is in progress. When initialization is 
complete, the window closes.

Cancel button Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Enable Manual Control
Unit [n] > Enable Manual Control

Select this option to manually control the system. If the instrument schematic is not displayed, select 
Unit [n] > Show Instrument Schematic.

When manual control is enabled, the symbols for valves and pumps change color on the control screen 
to indicate manual operation. 

• Valves: Closed = Yellow Open = Green
• Pumps: Off = Yellow On = Green         Disabled by front panel switch = Red 

Each component has a pop-up menu displaying the operations available for that paticular component. 
These menus may be accessed by right-clicking the component.

Manual Control is disabled if an automatic operation is in progress.

Displayed only 
if a
MasterTech is
Installed
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Component Description 

Set Temperature • Set Temperature - set the target temperature.

• Set point - enter a temperature set point. Range 25.0 to 
50.0oC.

The set point must be at least 10oC above ambient temperature for accurate control.

Mix Pump Turns the mixing pump on or off.

Waste Valve Set the waste valve position.

Rinse Valve Set the rinse valve position.

Mixing Chamber The speed of the mixing chamber magnetic stirrer can be set 
from 1 to 10, with 1 being the lowest speed. 

• Set Speed - displays the Mixing Chamber Speed window.

• Speed - controls the stirrer speed by entering a value from 1 
to 10.

Turns the stirrer on or off.

Air Valve Sets the position of the air valve.
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Cell Pump • Turn Off (or Turn On) - turns the cell pump off or on.

• Flow up (or down) in a cell - changes flow direction. 
Arrows in the pump symbol display the current direction.

• Increase (or Decrease) Speed - changes the cell pump 
speed. The speed of the cell pump can be set from 1 to 5, 
with 1 being the slowest speed.

Cell Controls the movement of the analysis cell. An arrow in the cell 
symbol indicates the direction of cell movement.

• Move Cell Position - enter the cell position. 

–  Absolute - move the cell position to an absolute 
(relative to the last beamsplit location) number of steps. 
For example, an absolute move of 100 steps moves the 
cell 100 steps above beamsplit.

–  Relative - move the cell position to a relative (relative 
to current positon) number of steps. For example, a 
relative move of 100 steps moves the cell up 100 steps 
from its current position.

–  Cell Position - move the cell to the position entered. 

• Stop Motion - stops cell movement.

• X-ray intensity Normal (or Low) - select the X-ray 
intensity setting.

Component Description (continued)
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Cell (continued) • Find Beamsplit - zeros the cell position at the proper 
beamsplit location.

Start - progress messages display.

Done - closes the window.

MasterTech (shown only if a 
MasterTech is installed)

• Move Arm Up (or Down) - MAsterTech arm movement 
control.

• Ultrasonic On (or Off) - turns the ultrasonic probe on or off.

• Stirrer On (or Off) - turns the stirrer in the beaker on or off.

• Stirrer Speed Fast (or Slow) - stirrer speed control.

• Move to next beaker - moves the MasterTech arm to the 
next beaker position.

• Turn On (or Off) - turns the MasterTech pump on and off.

• Flow Direction Rinse (or Load) - Sets the flow direction of 
the MasterTech pump. An arrow in the pump symbol 
changes to show the current flow direction.

Component Description (continued)
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Show Instrument Schematic
Unit [n] > Show Instrument Schematic

Select this option to display a schematic of the analyzer and the MasterTech (if one is being used). 

The color of the valves and pumps indicate their state.

• Valves: Closed = White Open = Green
• Pumps: Off = White On = Green         Disabled by front panel switch = Red

 

                 
             

MasterTech Arm
    Ultrasonic Probe Beaker

Mixing Chamber 
Stirrer Speed

Cell Pump 
Speed

Analysis Cell - 
arrow indicates direction 
of movement

Arrow indicates 
flow direction

Shown only if a 
MasterTech is 
installed
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Show Status
Unit [n] > Show Status

Select this option to show just the status display of an operation in progress; a status window similar to 
this one is displayed.

Use this option if:

• There is an automatic operation in progress and a sample file neds to be edited.

• There are two units attached to the computer. Select Show Status on each unit menu and have the 
status for both units displayed simultaneously.

The following items may appear in the status display, depending on the instrument and the operation in 
progress.

Display Description 

Mode The type of operation being performed.

SediGraph The status of the analyzer, such as Analysis operation in 
progress, Idle, Waiting for load, etc.

Sample The name of the sample file involved in the operation. This field 
also displays for the MasterTech if one is being used. 

MasterTech The status of the MasterTech. This field is visible only when a 
MasterTech is being used.

Time Remaining The time remaining on the analysis. This field is visible only 
when an analysis is in progress.

Cell Temp. The temperature of the liquid in the analysis cell.
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Show Instrument Log
Unit [n] > Show instrument log

Displays a log of recent analyses, calibrations, errors or messages. This information is logged for a  
7-day period for analyses and a 30-day period for messages and calibrations.

X-Ray Counts The intensity of the X-ray in kilocounts/sec.

Mass Percent The current mass percent in the analysis.

Diameter The current particle size in the analysis.

Analysis Time The approximate time for the analysis.

Display Description 

Analysis, Calibration, and 
Message checkboxes

Select the log contents to display. 

Display Description (continued)
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Report button Display on the screen or print a report of log entries. The Log 
Report Settings dialog is displayed.

• Start Date - select the start date for log entries to be included 
in the report. Specify a start date using any of the following 
methods:

–  Highlight the field (or press F2 to clear the field) and 
enter a date.

–  Double-click the field (or press F4) to display a 
calendar and select a date.

–  Press F2 to clear the field, then F3 to insert the current 
date.

• Copies - specify the number of reports to print if Printer or 
Printer/Plotter is selected for the destination.

• Destination- select the print output destination.

• File name - enabled only if File is the destination. Enter a 
file name.

Cancel button
OK button Refer to Common Fields and Buttons - Unit Menu Options, 

page 4-2.

Display Description (continued)
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Unit Configuration
Unit [n] > Unit Configuration

Displays baseline information and software and hardware configuration of the connected analyzer. 

Field or Button Description 

Software Versions group box Displays the software versions of the MICBIOS and analyzer 
analysis program.

Configuration group box Displays the number of the port being used to control the 
analyzer and the serial number of the selected analyzer.

Baseline group box Displays the date and the average intensity of the last baseline 
performed. 
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Analyses per tubing set group 
box

• Enable analyses counter - enables or disables the analyses 
counter. The analysis program keeps a counter of the number 
of analyses remaining on the instrument before the next 
recommended tubing change. For every sample information 
file for which an analysis is started (does not include service 
tests or baseline measurements) this counter is decremented. 

• Max Recommended analyses per tubing set - enter the 
maximum number of analyses to be performed before the 
application displays this message:

The maximum number of analyses for this tubing has been 
reached. It is time to change the tubing. When the tubing has 
been replaced, reset the counter in the unit configuration 
dialog.

• Analyses remaining on current tubing - displays the 
number of analyses remaining before the maximum 
recommended number is reached.

• Reset button - resets the analyses counter to the 
recommended maximum number.

Calibrations group box Displays calibration data.

Board ID button Displays the Board ID dialog, which describes the circuit boards 
in the analyzer. Use the Board dropdown list to select a board to 
view.

Field or Button Description (continued)
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Calibration
Unit [n] > Calibration

The Calibration option provides a method of storing instrument calibration data. Your Micromeritics 
service representative may use this option to enter calibration data for future reference when servicing 
the analyzer. This option is enabled only when the analysis program is operating in Service Test mode. 
Refer to Service Test Mode, page 6-5.

Set Temperature button Set the target temperature. 

Reset button Resets the analysis counter to the recommended maximum 
number.

Cancel button
OK button Refer to Common Fields and Buttons - Unit Menu Options, 

page 4-2.

Field or Button Description (continued)
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Service Test
Unit [n] > Service Test

Use for service tests performed only with the assistance of a trained Micromeritics service representa-
tive. These tests provide the service representative with troubleshooting tools and readouts.

This option is enabled only when the analysis program is operating in Service Test mode. Refer to 
Service Test Mode, page 6-5.
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5.  REPORTS MENU

Introduction
This chapter contains information specific to the Reports menu options used to customize and run 
reports. This chapter provides details of Reports menu options, commonly used functions and buttons, 
field-by-field descriptions, and sample reports. 

Reports can be generated for data: 

• collected on a sample that has completed analysis
• collected on a sample currently being analyzed
• manually entered

Common Fields and Buttons - Reports Menu Options
The following fields and buttons are common to many of the report files. References are made to these 
fields and buttons throughout this chapter.

Field or Button Description 

Add button Select the file and click Add to move a file from the Files list to the 
Selected Files list or double-click the files to move them. Multiple files can 
be selected by holding down Ctrl key while making selections.

Browse button Click to locate another file.

Cancel button Closes the window and cancels any unsaved changes.

Close button Closes the active window.

Dates button Use to filter the files by a date range. Only the files with the selected date 
range display.
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Delete button Deletes a selected file from the Selected Files list and move it back to the 
Files list.

File name text box Select a file from Files list box. The file name displays in the File name text 
box. Click Open or double-click the file name to open the file. To select 
multiple files, hold down the Ctrl  key on the keyboard while selecting the 
files, or hold down the Shift key to select a range of files.

From / To text boxes Enter the From and To range for autoscaling the x- and / or y-axes.

Name column Displays a list of files in the selected directory.

Number of Reports Enter the number of reports copies to generate.

OK button Click to save and close the active window.

Open button Select a file from the Files list. Click Open to open the file.

Report button Click to generate the report.

Save button Saves the active file.

Settings group box • Copies - select the number of copies to print. 

• Destination - sends the file to the selected destination. 

• Filename - enabled when Screen is selected for the destination. The 
report will be saved under the entered filename.

Show graphic Select to have a graphic display on the report header. Refer to Report 
Header, page 5-16.

Show report title Select to have a title display on the report header. Enter a title in the text 
box. Refer to Report Header, page 5-16.

Status dropdown list Use to filter the files by status. Only the files with the selected status 
display.

Use all files in this 
Dir. checkbox

Select to include all files from the selected directory.

Field or Button Description (continued)
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Start Report
Reports > Start Report (or use the F8 keyboard shortcut)

Use to generate a tabular and graphical reports on a sample analysis. Refer to Common Fields and 
Buttons - Reports Menu Options, page 5-1 for a description of the fields and buttons. 

Close Reports
Closes all open reports. This option is disabled if reports are being generated.
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Baseline Reports
Reports > Baseline

A graphical report can be generated on an instrument’s baseline. This report generates a graph illustrat-
ing the X-ray intensity versus the cell height. The report header contains baseline statistics, such as the 
unit serial number, date the baseline was performed, etc.

Field or Button Description 

Instrument Displays a dropdown list of serial numbers of the attached 
instruments.

Baseline Date and Time Displays the date and time of the last baseline measurement.

Number of Reports

Destination

File name

Refer to Settings group box in Common Fields and Buttons - 
Reports Menu Options, page 5-1.

Cancel button
OK button

Refer to Common Fields and Buttons - Reports Menu 
Options, page 5-1.
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SPC Report Options
Reports > SPC Report Options

Use to generate reports with various SPC (Statistical Process Control) options. All selected variables 
must be computed for each sample file used in an SPC report; therefore, it is more efficient to select 
only the necessary variables.

The selected items appear as options on the Reports > Regression Report screen as selections in the 
dropdown boxes and are used in graph selection in Reports > Control Chart.

Field or Button Description 

Test Analysis choices for SPC calculations.

• Last - reports statistics for the last analysis in the sample 
file(s).

• First - reports statistics for the first analysis in the sample 
file(s).

• Average - reports an average based on all analyses in the 
sample file(s).

Distribution Type group box Select the type of distribution data for computation of the SPC 
variables.

Statistics group box Select the type of statistics for SPC variables calculations.
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Sample button Select the SPC Sample Options to include on the report. Refer 
to Sample Defaults, page 6-3 for information on the User 
Parameter fields.

Analysis button Select the SPC Analysis Options to include on the report.

Percentiles button Specify up to five particle sizes for which the cumulative 
percent finer is to be recorded.

Field or Button Description (continued)
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Sizes button Specify up to five cumulative finer values for which the size is 
to be recorded.

Peaks group box Select up to five peaks to include in the SPC calculations. Enter 
the minimum percentage of the distribution in the text box.

Cancel button
OK button

Refer to Common Fields and Buttons - Reports Menu 
Options, page 5-1.

Field or Button Description (continued)
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Regression Report
Reports > Regression Report

Use to generate an SPC (Statistical Process Control) Regression report to determine the interdepen-
dency between two variables. Up to three dependent variables (y-axis) may be plotted against a single 
independent variable (x-axis). The degree of correlation between the variables is also reported.

Field or Button Description 

X- and Y-Axes / Variable fields Designate the X- and Y-axes variables. Click the downarrow to 
display a list of variables specified in the SPC report options.

Plot the regression of up to three Y-axis variables against the X-
axis variable. 

• X-axis - specifies the independent variable
• Y-axis - specifies the dependent variables

Axis Range Specify the From and To values for the X- and Y-axis ranges. 
Data collected outside these ranges are not included in the plot. 
These fields are disabled if Autoscale is selected.

Autoscale Scales the X- and / or Y-axes automatically. When scaled 
automatically, both axes begin at zero. The analysis program 
uses the highest values collected during analysis as the ending 
points.

Tabular report Generates tabular and graphical data of the included samples. A 
tabular report contains the numeric values contributed by each 
sample.
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Label data Select to label the points on the plot to correspond with the 
values in the sample files.

Samples button Select the options to include on the report. Refer to.Common 
Fields and Buttons - Reports Menu Options, page 5-1. 

Recalculate archived SPC 
results checkbox

Use to have archived SPC values recalculated ensuring any 
changes made to the SPC Report Options are included in the 
new report. Selecting this option lengthens the time required to 
generate the report.

Report Settings group box Refer to Settings group box in Common Fields and Buttons - 
Reports Menu Options, page 5-1.

Save as Default button Saves the current definition of the report as the default.

Browse button

Cancel button

OK button

Show graphic

Show report title

Refer to Common Fields and Buttons - Reports Menu 
Options, page 5-1.

Field or Button Description (continued)
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Control Chart
Reports > Control Chart

Use to generate an SPC (Statistical Process Control) control chart report which plots the changes in a 
statistic.

Field or Button Description 

X-axis Order By group box Select the order in which x-axis statistics are placed. 

• Time - sorts by the time the files were analyzed.
• File name - sorts in alphanumeric order.
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Summary Statistics button Select the statistics to display in the report.

Select the statistics to display:

• Mean 

• Standard Deviation 

• Coefficient of Variation - the Standard Deviation divided 
by the Mean

• Confidence Interval - the confidence interval of the mean 
value shown on the same line below the graph on the report. 
Enter the percent in the Confidence Level field.

• Number of Samples - select to have the number of samples 
analyzed included in the report

Field or Button Description (continued)
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Graph [n] button Click to define the Y-axis of each graph. 

• Statistic - displays the SPC variables selected on the SPC 
Report Options window. The selected variable will be 
plotted against time.

• Autoscale - select to automatically the Y-axis scale. To 
specify a range, deselect this option and enter ranges in the 
From and To fields.

• Center Line - displays placement options for the variable’s 
optional value. Choose Entered to specify placement of the 
line.

• Limit Lines - displays the options available for limiting 
lines. Lines can be placed at some multiple of the standard 
deviation or at specified positions (Entered). If Entered is 
selected, enter the High and Low limits.

Tabular report checkbox Generates tabular and graphical data of the included samples. A 
tabular report contains the numeric values contributed by each 
sample.

Recalculate archived SPC 
results checkbox

Select to have archived SPC values recomputed. This ensures 
that changes made to the SPC Report Options are included in 
the new report. This option lengthens the time required to 
generate the report.

Field or Button Description (continued)
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Samples button Select the options to include on the report. Refer to Common 
Fields and Buttons - Reports Menu Options, page 5-1. 

Browse button

Cancel button

Dates button

Delete button

OK button

Report Setting group box

Show graphic

Show report title

Refer to Common Fields and Buttons - Reports Menu 
Options, page 5-1.

Field or Button Description (continued)
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PSD History
Reports > PSD History

Used to report a sequence of full particle size distribution graphs.

Field or Button Description 

X-axis Order By group box Select the order in which x-axis statistics are placed. 

• Time - sorts by the time the files were analyzed.
• File name - sorts in alphanumeric order.

Samples button Select the options to include on the report. Refer to.Common 
Fields and Buttons - Reports Menu Options, page 5-1. 
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Browse button

Cancel button

Dates button

Delete button

OK button

Report Setting group box

Save as default button

Show graphic

Show report title

Refer to Common Fields and Buttons - Reports Menu 
Options, page 5-1.

Field or Button Description (continued)
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Report Features and Shortcuts

Report Header
All reports contain a header displaying file statistics.

• If configured, the report header can also contain a graphic and a title. Tabular and graphical reports 
contain sample and instrument statistics such as analysis date / time, analysis conditions, etc.

• The headers contain notes of sample file changes occurring after analysis.

• Summary report headers contain the same information as tabular and graphical reports with the 
exception of notes.

Generated 
Report Tabs

Header

Data display 
(either graphical 
or text

Reports list box

Tool bar
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Report Header Title.

1. Open the file and select the Report Options tab.

2. Select the Show report title checkbox.

3. Enter the report title in the text box. 
512-42805-01 (Rev C) - Apr 2022 5-17 



Report Features and Shortcuts SediGraph III Plus
Report Header Graphic

1. Open the file and select the Report Options tab.

2. Select the Show graphic checkbox.

3. Click Browse to locate the graphic.

4. Use the Height and Width to indicate the graphic size in inches.
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Report Tool Bar

The Report window has a tool bar and selectable tabs across the top of the report header. To view a 
specific report, select its tab or select the report in the Reports list box and click Show.

Reports can be customized and manipulated using the tool bar, shortcut menus, the zoom feature, or 
axis cross-hairs. 

Field or Button Description 

Reports list box Contains a list of all generated reports. The same reports display as tabs 
across the top of the report header unless the report has been hidden 
using the Hide button.

Show button Jumps to the selected report in the Reports list box. Other methods to 
show reports are:

• Double-click the report name in the Reports list box
• Select the report tab to show the report 

If the report tab has been hidden using the Hide button, click Show to 
display the report and tab.

Delete button Deletes the selected report. Deleted reports will have to be regenerated if 
deleted in error.

Hide button Hides (or temporarily removes) the selected report from the tabbed view. 
The report name remains in the Reports list box. To redisplay the tab, 
select the report in the Reports list box and click Show.
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Print button Displays the Print window for report output.

• Name dropdown list and Properties button - select the printer and 
click the Properties button to change printer setup.

• Print range group box - use to enter specific pages to print.

• Copies group box - select the number of copies and collate option.

• Current button - selects the active report (or selected tab).

• All button - selects all reports in the Reports list box.

• Shown button - selects only the reports not hidden.

• Clear button - clears all selections.

• OK button - prints the selected report to the printer indicated.

• Cancel button - closes the Print window.

Save button Saves all reports of the active file using the sample file name with a 
.REP file extension.

Save As button Saves all selected reports to the indicated file format:

• .REP (Report system) - saves the report in a format that can be 
opened with any MicroActive program.

• .TXT (ASCII text) - saves the report as a common machine language 
file.

• .XLS (Spreadsheet file) - saves the report in a spreadsheet format.

Field or Button Description (continued)
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Default Style button Click to specify default report parameters for fonts and curve properties.

• Font Type list box - use to edit font type and attributes for the 
selected item. Select an item in the list, click Edit, and select from 
various font options. Click OK when done. 

Field or Button Description (continued)
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Report Shortcut Menus
Shortcut menus are accessed by right-clicking on the report header or the report body displayed on the 
screen.

Report Header Shortcuts
Display header shortcuts by right-clicking in the report header.   

Default Style button 
(continued)

• Curve group box -

–  Thickness text box - enter a thickness number for the curve.

–  Histogram Fill dropdown list - select a histogram fill option 
from the list.

• Graph border line thickness text box - enter a thickness number for 
the graph border.

• Load button - click to load the last saved default settings.

• Save button - click to save the changes as the new default settings.

• Close button - click to close the window and save the changes for the 
current report. 

Option Description 

Edit Use to edit the report title or graphic to display in the report header. Refer 
to Report Header, page 5-16.

Copy header as text Use to copy the report header as text. Text is copied to the clipboard and 
can then be pasted into other documents.

Field or Button Description (continued)
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Tabular Reports Shortcuts

Display tabular report shortcuts by right-clicking in the body of the tabular report. Column shortcuts 
require right-clicking on the column to be modified.  

Option Description 

Resize column Right-click on the column to be resized. Select Resize Column on the 
shortcut menu and enter the new column width in inches.

Rename column Right-click on the column to be renamed. Select Rename Column on the 
shortcut menu and enter the new column name. 

Move column Right-click on the column to be moved. Select Move Column on the 
shortcut menu and select Left or Right for the move.

Align column Right-click on the column to be aligned. Select Align Column on the 
shortcut menu and select Left, Right or Center.

Hide column Right-click on the tabular report and select which column(s) to hide.

Show column Displays a list of all hidden columns. To display the hidden column, select 
it from the list.

Column font Right-click in the report data. Select Column font on the shortcut menu. 
Deselect the Use default font to enable font options. Select new font 
attributes for the column data. To return to the default fonts, select the Use 
default font checkbox.

Header font Right-click in the report data. Select Header font on the shortcut menu. 
Deselect the Use default font to enable font options. Select new font 
attributes for the header data. To return to the default fonts, select the Use 
default font checkbox.

Edit title Use to edit the report title or graphic to display in the report header. Refer 
to Report Header, page 5-16.
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Graph Shortcuts

Display graph report shortcuts by right-clicking in the body of the graph report.

Copy table as text Use to copy the report header as text. Text is copied to the clipboard and 
can then be pasted into other documents.

Option Description 

Autoscale Returns the report to full view after using the zoom feature. 

Redraw Removes the cross-hair and returns the graph back to the initial setting.

Show curve Displays a list of hidden curves. To show a curve, select it from the list.

Hide curve Displays a list of curves. Select the curve to hide.

Edit curve Use to edit selected curve properties.

• Title text box - use to change the title of the selected curve.

Option Description (continued)
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Edit curve (continued) • Style dropdown list - use to select another style for the collected data 
curve.

• Curve group box - options are disabled if Histogram is selected in the 
Style dropdown list. Use to edit the curve interpolation, point style and 
pen style and color for the selected curve.

Color button - click to change the curve color.

Use default thickness checkbox - select to use the default curve 
thickness. Deselect the checkbox and enter a new thickness number in 
the Thickness text box.

• Histogram group box - enabled only if Histogram is selected in the 
Style dropdown list. Use to specify the type of fill, fill color and label 
position for the selected curve. 

Label dropdown list - select where the graph point labels will display 
(left, right, center, etc.) on the SPC report.

Option Description (continued)

Graph Label
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Edit axis Use to edit the selected axis properties.

• Title group box - use to edit the selected axis label.

Title text box - use to modify the label of the selected axis.

Title font button - use to modify the font for the selected axis label. 
Deselect the Use default font to enable font options. Select the font 
attributes and click OK.

• Scale group box - use to change the graph display.

Linear / Logarithmic - select the option to scale the graph as linear or 
logarithmic.

Autoscale minimum / maximum - select the Autoscale checkbox to 
enable the option. To manually specify minimum / maximum, deselect 
the Autoscale checkbox and enter the new amount in the text box.

Invert scale checkbox - use to invert the scale.

Scale font button - use to modify the font for the scale label. Deselect 
the Use default font to enable font options. Select the font attributes 
and click OK.

Gridlines dropdown list - use to change how gridlines are displayed.

Option Description (continued)
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Edit legend Use to change the legend location and font. Click Font to modify legend 
fonts. Deselect the Use default font to enable font options.

Edit title Use to change the graph title and font. Click the Font button to change the 
font type and font style. Deselect the Use default font to enable font 
options. Refer to Default Style in the table in Report Tool Bar, page 5-19.

Copy as metafile Copies the graph to the clipboard. It can then be pasted into other 
applications. 

Copy as text Copies the report data to the clipboard. It can then be pasted into other 
applications as tab-delimited columns of text.

Option Description (continued)
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Other On-Screen Features

Zoom Feature
Use the zoom feature to closer examine graph details. To use this feature:

1. Open the graph.

2. Hold down the left mouse button and drag the cursor across the graphical area to be enlarged. A 
box will display in the area to be enlarged.

3. Release the mouse button. The enlarged area fills the graph area. To return to normal view, right-
click in the graph area and select Autoscale or Redraw on the shortcut menu.

Axis Cross-Hair

The cross-hair feature displays axis coordinates. To use this feature:

1. Click the left mouse button on the graph to view the cross-hair coordinates.

2. To remove the cross-hair, right-click in the graph area and select Autoscale or click out of the 
graph area.

Y-axis positionPoint of Coordination

X-axis position
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Report Examples
This section contains examples of the types of reports available with the analysis program.

Combined Report
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Report by Size Class
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Mass Frequency vs. Diameter Report
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Rosin Rammler Graph
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Summary Report
512-42805-01 (Rev C) - Apr 2022 5-33 



Report Examples SediGraph III Plus
Cumulative Surface Area Coarser vs. Diameter
5-34                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Report Examples
Surface Area Population vs. Diameter
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Cumulative Particle Number Coarser vs. Diameter
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6.  OPTIONS MENU

Introduction
This chapter contains information specific to the Options menu selections used to configure the system 
by setting defaults for sample and parameter files.

This chapter contains information on:

• changing the default presentation format - Restricted, Basic, or Advanced.
• specifying default parameters for sample information files and report option files.
• specifying how units appear on application windows and reports.

Option Presentation
Options > Option Presentation

Use to change the default editing format of sample files - Restricted, Basic, or Advanced. Each format 
type displays sample information and options differently. For descriptions of the presentation types, 
refer to Creating Sample Files in Advanced Format, page 2-4. When using Restricted format, a 
password is required to change to Advanced format.
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Data Presentation
Options > Data Presentation

The options on the Data presentation dropdown menu allow you to specify how tabular and graphical 
data to display on the screen and in printed reports. 

Field or Button Description 

Units Select how data are to display on the screen and in printed 
reports.

Invert size axis Inverts the size axis.

Solid graph gridlines 
Dotted graph gridlines

Select how graph gridlines display.

Show graph gridlines Specify whether or not to have grid lines display on graphs and, 
if so, what type.
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Sieves
Sieves specifies the default sieve sizes to use when sieve data are presented. The sieve sizes follow the 
technical specifications per ASTM Specification E-11.

Double-click an entry to select it. A selected size is preceded by a check mark. 

Sample Defaults
Options > Sample Defaults

Use to specify default parameters for sample information files. Refer to Editing the Sample Default 
File, page 2-1.

Reynolds Number
Use to specify the Reynolds number to be used in estimating the maximum measurable diameter dis-
played on the Material Properties window.
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Autorinse
Use to specify autorinse options. The system default for Autorinse is 3 cycles of 3 rinses per cycle. The 
analyzer will rinse a maximum of 9 times in an attempt to reestablish baseline conditions before dis-
playing an error message. 

System Configuration

Use to specify printer and plotter destinations for report output.

Field or Button Description 

Number of rinses before check Enter the number of rinses per cycle to be performed after each 
analysis before baseline conditions are checked.

Maximum number of checks Enter the maximum number of baseline checks to be performed 
before notification that baseline conditions have not been met.

Field or Button Description 

Printer name / Plotter name The printer and plotter names are shown exactly as they appear 
in the operating system Print Manager.

Select Default to use the default printer and plotter as 
designated in the Print Manager. 

To change the default printer, deselect Default. Then choose 
another printer (or plotter) from the dropdown list of installed 
printers (plotters).
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Parameter Files Directory
Options > Parameter Files Directory 

Use to select the location for the predefined parameter files displayed in the dropdown lists when in 
Basic or Restricted format. This configuration option is not available if using Restricted format. The 
system default directory is the recommended location for saving report options files. The default direc-
tory is Params and includes several parameter files supplied with the analysis software.

Service Test Mode
Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the assis-
tance of a trained Micromeritics service representative. This password is supplied by your service 
representative. After Service Test Mode has been enabled, the tests are accessible from the Unit menu 
(Unit > Service Test).
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7.  TROUBLESHOOTING AND MAINTENANCE

Introduction
The analyzer has been designed to provide efficient and continuous service; however, certain mainte-
nance procedures should be followed to obtain the best results over the longest period of time. This 
chapter includes maintenance and calibration procedures.

Troubleshooting
Most operational problems are caused by:

• deteriorated or blocked tubing
• air leaks
• an unlevel analyzer 

When unexpected analysis results occur, check the above items first. Some common operational prob-
lems not indicated on the screen and their respective causes and solutions are provided in the following 
table:

What Happened Why What To Do 

SediGraph

Cell cannot be 
filled or drained.

Blocked or damaged tubing. Locate and replace blocked or 
damaged tubing. Refer to 
Replacing Flexible Tubing, 
page 7-10.

Blocked cell input or output port. Clean analysis cell. Refer to 
Cleaning the Analysis Cell, 
page 7-8.

Valve or pump not working properly. From Manual Control screen, 
check pump and valve 
operation. If either is not 
working properly, contact 
authorized service personnel.

Tubing improperly installed. Install the tubing as described 
under Replacing Flexible 
Tubing, page 7-10
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Cell cannot be 
raised or lowered

Elevator which moves cell is stuck. Check flexible tubing for 
possible obstruction to 
elevator movement. If 
necessary, reposition tubing. 
Also check for any other 
obstruction to elevator 
movement.

Mixing chamber 
cannot be filled or 
drained.

Blocked or damaged tubing. Locate and replace blocked or 
damaged tubing. Refer to 
Replacing Flexible Tubing, 
page 7-10.

Blocked mixing chamber input or output 
port.

Clean mixing chamber. Refer 
to Cleaning the Mixing 
Chamber and Bezel, page 7-
6.

Valve or pump not working properly. From Manual Control screen, 
check pump and valve 
operation. If either is not 
working properly, contact 
authorized service personnel.

Tubing improperly installed. Install the tubing as described 
under Replacing Flexible 
Tubing, page 7-10.

Mixing chamber 
suspension is 
turning brown

Teflon® coating on stirring bar is worn. Replace stirring bar. Refer to 
ORDERING 
INFORMATION, page 8-1.

What Happened Why What To Do (continued)
7-2                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Troubleshooting
X-RAY ON 
indicator is turned 
on, but the 
computer display 
shows 0 
kilocounts.

Analysis compartment door not completely 
closed.

Close analysis compartment 
door.

Cell is in a position which blocks beam. Move cell to proper operating 
position. Enable Manual 
Control, access the pop-up 
menu on the cell, and select 
Move Cell Position.

Cell is clogged. Remove and clean cell. Refer 
to Cleaning the Analysis 
Cell, page 7-8.

Slits in collimator blocked. Clean the collimator. Refer to 
Cleaning the Collimating 
Slits, page 7-18.

X-ray source or detector has failed. Contact authorized service 
personnel.

X-RAY 
STANDBY 
indicator was 
turned on, but 
when keyswitch is 
placed in X-RAY 
ON position, X-
RAY ON indicator 
does not turn on.

Keyswitch is between positions. Move keyswitch to X-RAY 
STANDBY position and then 
back to X-RAY ON position 
while observing indicator.

X-RAY ON indicator lamp is burned out. Replace lamp. Refer to 
Replacing the X-Ray 
Indicator Lamps, page 7-20.

X-ray filament supply not available or X-ray 
unit damaged.

Contact authorized service 
personnel in accordance with 
service contract.

Rear panel is off, the top cover is off, or the 
fluid module is not fully installed.

Replace all panels.

First refer to Determining the Cause of Bubbles, page 7-23 and perform the 
outlined procedure. Then return to this table for corrective action.

What Happened Why What To Do (continued)
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Bubble 
elimination 
problem

Windows are dirty or misaligned. Clean or replace the windows. 
Refer to Cleaning the 
Analysis Cell, page 7-8.

Inlet port on the cell assembly is loose. Replace the cell assembly 
Refer to Replacing the 
Analysis Cell Assembly, page 
7-22.

A valve has failed. Contact authorized service 
personnel.

MasterTech

Power failure. Power cable not connected or switch not in 
ON position.

Make sure power cable is 
plugged into the power source 
and the power ON/OFF switch 
is in the ON position.

Input power fuse blown. Replace the fuse. Refer to 
Replacing the MasterTech 
Input Power Fuse, page 7-24.

Stirrer will not 
work.

Stirrer is improperly connected. Check the stirrer’s electrical 
connection.

Turntable will not 
move.

Arm is in the LOAD position. Press the AUTO/LOAD 
switch on the front panel to 
lower the arm.

MasterTech pump 
will not run.

Pump switch on the front panel may be in the 
OFF position.

Press the pump AUTO/ OFF 
switch on the front panel.

Ultrasonic probe 
will not work.

Probe improperly connected to the 
MasterTech.

Check the MasterTech 
connector cable.

Ultrasonic 
agitation 
diminished.

The ultrasonic probe tip may need replacing. Refer to Replacing the 
Ultrasonic Probe Tip, page 7-
24.

MasterTech will 
not initiate 
commands from 
the computer.

The cable may be connected improperly 
from the MasterTech to the computer.

Check the cable connections. 

What Happened Why What To Do (continued)
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Preventive Maintenance
The following procedures should be performed every 12 months by a Micromeritics service techni-
cian. Do not attempt to perform these procedures yourself.

• Clean the high voltage area
• Calibrate the X-ray control system
• Calibrate the fluid control system
• Calibrate the temperature control system

Schedule
The following table lists the preventive maintenance procedures that should be performed to keep the 
analyzer operating at peak performance. (These procedures are also performed by your service techni-
cian at the same time as the ones listed above.) Instructions for each procedure follow the table.

Pump leaks or is 
not operating 
efficiently.

Tubing is leaking or clogged. Refer to Replacing Flexible 
Tubing, page 7-10.

Maintenance Required Frequency Refer to Page

Perform a reference material run Every week 7-6

Clean the analyzer Every 30 days* 7-6

Clean the mixing chamber and bezel As needed 7-6

Clean the analysis cell Every 30 days* 7-8

Replace the mixing pump and cell pump tubing Every 30 days* 7-10

Replace the analysis cell tubing As needed 7-14

Clean the air filter Every 30 days* 7-15

Check the operation of the mixing pump Every 30 days* 7-16

Check the operation of the cell pump Every 30 days* 7-17

Check the level of the analyzer Every 30 days* 7-18

Clean the collimating slits As needed 7-18

*Or every 160 analyses, whichever comes first

What Happened Why What To Do (continued)
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Performing a Reference Material Analysis
It is a good practice to perform a reference material analysis every week to ensure that the analyzer is 
operating within specifications. Reference material kits, including instructions for performing the ref-
erence material analysis, are available from Micromeritics. Refer to ORDERING INFORMATION, 
page 8-1.

Cleaning the Analyzer
A clean cloth, dampened with isopropyl alcohol (IPA), a mild detergent or a 3% Hydrogen Peroxide 
solution may be used to clean the outside casing of the analyzer. It is not necessary to remove any con-
trol knobs or screws while cleaning. If a MasterTech is installed, clean it in the same manner.

Cleaning the Mixing Chamber and Bezel
The mixing chamber bezel should be cleaned periodically to prevent contaminants from entering the 
mixing chamber. To clean the bezel:

• Remove the bezel and clean using a mild detergent. Rinse, then dry thoroughly before replacing it 
on the mixing chamber.

The mixing chamber should be removed and cleaned periodically to remove any residue.

1. Drain the mixing chamber.

a.) Go to  Unit [n] > Drain and load.

b.) Select Leave mixing chamber empty. Click Continue.

c.) When prompted to load the sample, click Cancel.

 Isopropyl alcohol (IPA) should not be used to clean the sliding door to the analysis 
compartment.

When cleaning the mixing chamber, avoid getting the electrical connections wet. Do 
not immerse the chamber in liquid. Doing so could damage the system.
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2. Disconnect the flexible tubing from the mixing chamber, exercising caution to prevent damage to 
the tubing. Disconnect the electrical cable.

3. Clean the chamber using IPA or a mild detergent. Rinse thoroughly. All ports should be cleaned 
using an air blower.

4. Reconnect the tubing to the mixing chamber. Refer to Reconnecting the Mixing Chamber 
Tubing, page 7-7.

Reconnecting the Mixing Chamber Tubing
1. Attach the tubing to the mixing chamber. 

2. Ensure the tubing is securely fastened at each port.

3. Reconnect the electrical cable.

      Electrical Cable

Flexible Tubing

      
Flexible 
Tubing

I J D

GH

I

J

H

D
G
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Cleaning the Analysis Cell
The analysis cell should be removed periodically and cleaned to remove any residue.

1. Go to  Unit [n] > Drain and load.

2. Select Leave mixing chamber empty. Click Continue.

3. When prompted to load the sample. Click Cancel.

4. Place the Pump Control switch on the analyzer front panel in the OFF position.

5. Open the transparent sliding door to the analysis compartment. Loosen the cell mounting screw 
and remove the cell from the retaining bracket. 

6. Carefully remove the flexible tubing from the rigid tubing connector which is mounted along the 
right side of the analysis compartment.

7. Carefully remove the flexible tubing from the two ports on the cell.
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8. Disassemble the cell by removing the ten screws in the cell window retaining plates.

9. Use either IPA or a mild detergent to clean the cell windows. Use an air blower to remove any 
debris from the cell body, window retaining plates, and ports.

10. Assemble the cell by placing a cell window and a cell window retaining plate on each side of the 
cell body. The cell window retaining plate must be positioned so that the sloped part matches that 
of the cell body and other plate. 

11. Insert the ten screws removed in step 8 into the window retaining plates, but do not tighten.

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the 
cell windows. Particles may lodge in scratches, which could alter X-ray pulse rates and 
cause invalid analysis results.

When assembling the cell, alternate the tightening of screws. Failure to do so could 
result in air entering the cell, causing bubble elimination problems.

Make sure the sloped
portions of the cell body
and retaining plates are
aligned.
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12. Using a screwdriver, tighten the screws around the cell by tightening one screw and then 
tightening the screw diagonally opposite that screw. Refer to the following illustration for the 
tightening sequence. This sequence helps to ensure uniform closure around the cell.

13. Connect the flexible tubing to the ports on the analysis cell and to the rigid tubing connector. The 
tubing for the front port of the cell connects to the front rigid tubing connector . The tubing for the 
rear port of the cell connects to the rear rigid tubing connector.

14. Insert the cell in the retaining bracket and tighten the cell mounting screw.

15. Place the Pump Control switch in the ON position.

16. Go to  Unit [n] > Rinse > SediGraph.

17. Select Autorinse. Click Continue to rinse the analysis cell.

Replacing Flexible Tubing
The analyzer includes a complete plumbing system for circulation of sedimentation liquid and particle 
suspension between the cell, the mixing chamber, an external rinse container, and an external waste 
container. In order for the system to operate properly, you must replace damaged or deteriorated tub-
ing. You can replace tubing from the mixing pump, the cell pump, and the analysis cell independently.

When replacing tubing, always drain the system first. Refer to Draining the System, page 7-11.

The tube installation tool included in the instrument accessories may be used to help 
install the tubing.

Torque to 9 in-lbs using 
the order shown on the 
illustration
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Draining the System
1. Ensure that the outlet tube is in the waste reservoir and the rinse tube is in the rinse liquid 

reservoir.

2. Go to Unit [n] > Drain and load.

3. Select Leave mixing chamber empty. Click Continue. A progress message displays.

4. Click Cancel.
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Replacing the Mixing Pump Tubing
1. Place the analyzer on the edge of a table or flat surface. 

2. Remove the pump chassis cover. 

3. Drain the system. Refer to Draining the System, page 7-11.

4. Place the Pump Control switch on the analyzer front panel in the OFF position.

5. Rotate the mixing pump lever to the left (the mixing pump is the pump on the right) to place the 
mixing pump housing in the open position.

6. Remove the mixing pump flexible tubing from the rigid tubing connectors on both sides of the 
pump. Discard the used tubing.

7. Using the tube installation tool supplied in the accessories kit, attach one end of the new flexible 
tubing (labeled F) to the rigid tubing connector on the right.

8. Thread the tubing through the pump as shown below.

9. Attach the other end of the tubing to the rigid connector on the left.

10. Rotate the mixing pump lever to the right to place the mixing pump housing in the closed 
position.

11. Replace the pump chassis cover.

12. Place the Pump Control switch on the analyzer front panel in the ON position.

Mixing Pump Lever 
(Open position)

Mixing Pump 
Tubing (F)
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Replacing the Cell Pump Tubing
1. Place the analyzer on the edge of a table or flat surface. 

2. Remove the pump chassis cover. 

3. Drain the system. Refer to Draining the System, page 7-11.

4. Place the Pump Control switch on the analyzer front panel in the OFF position

5. Rotate the cell pump lever  (the cell pump is the pump on the left) to the left to place the cell 
pump housing in the open position.

6. Remove the cell pump flexible tubing from both connectors; discard the used tubing. 

7. Using the tube installation tool supplied in the accessories kit, attach one end of the new flexible 
tubing (labeled E) to the rigid tubing connector on the left side of the pump.

8. Thread the tubing through the pump as shown below.

9. Attach the other end of the tubing to the connector on the right side.

10. Rotate the cell pump lever to the right to place the cell pump housing in the closed position.

11. Replace the pump chassis cover.

12. Place the Pump Control switch on the analyzer front panel in the ON position.

Cell Pump Lever 
(Open position)

Cell Pump 
Tubing (E)

    Tubing (E)
Cell Pump
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Replacing the Analysis Cell Tubing
1. Drain the system. Refer to Draining the System, page 7-11.

2. Place the Pump Control switch on the analyzer front panel in the OFF position

3. Open the transparent sliding door to the analysis compartment. 

4. Remove the flexible tubing from the rigid tubing connector in the analysis compartment.

5. Loosen the cell mounting screw and remove the cell from the retaining bracket as shown below. 

6. Remove the flexible tubing from the two ports on the cell.

7. Connect the new flexible tubing (labeled K) to the ports on the new analysis cell and to the rigid 
tubing connector. The tubing for the front port of the cell connects to the front rigid tubing 
connector and the tubing for the rear port of the cell connects to the rear rigid tubing connector.

Front Connector  
(for front cell port tubing)

Analysis Cell 
Tubing (K)

Rear Connector  
(for rear cell port tubing)

Analysis
Cell Tubing
(K)
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8. Insert the cell in the retaining bracket and tighten the cell mounting screw.

9. Close the analysis compartment door.

10. Place the Pump Control switch in the ON position.

Cleaning the Air Filter
The air filter on the analyzer should be cleaned every 30 days (more often in environments with 
increased levels of dust) and replaced once a year. Refer to ORDERING INFORMATION, page 8-1 
for the part number of the air filter.

1. Slide out the drip tray on the front of the analyzer.

2. Remove the air filter from drip tray by squeezing the filter while pulling it away from the drip 
tray.

3. Rinse the filter thoroughly and shake out the excess water. Place it aside and allow it to dry.

4. Install a new filter or after the filter has dried, replace it.

5. Check to see that the analyzer is level. Refer to Checking the Level of the Analyzer, page 7-18.

   

Drip Tray

Air Filter
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Checking the Operation of the Mixing Pump
The mixing pump should be checked every 30 days (or every 160 runs, whichever comes first) to see if 
it is operating correctly. To check the operation of the mixing pump:

1. If the instrument schematic is not displayed, select Show Instrument Schematic.

2. Go to  Unit [n] > Enable manual control.

3. Right-click on the Mixing Pump symbol, then select Turn on from the pop-up menu.

4.  If the pump fails to start, refer to the table on Resetting the Mixing Pump and Cell Pump, page 
7-23 for corrective action.

5. Right-click on the Mixing Pump symbol, then select Turn off from the pop-up. If the pump fails 
to stop, the fluid control board may need replacing; contact your service representative.

Mixing Pump

MasterTech icons do 
not display if 
MasterTech is not 
installed.
7-16                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Preventive Maintenance
Checking the Operation of the Cell Pump
The cell pump should be checked every 30 days (or every 160 runs, whichever comes first) to see if it 
is operating correctly. To check the operation of the cell pump:

1. If the instrument schematic is not displayed, select Show Instrument Schematic.

2. Go to  Unit [n] > Enable manual control.

3. Right-click on the Cell Pump symbol, then select Turn on from the pop-up.

4. Perform the following steps. If any of these steps fail, refer to the table on Resetting the Mixing 
Pump and Cell Pump, page 7-23 for corrective action.

For each of the following steps, right-click the Cell Pump symbol, then select the item listed:

•  Increase speed
•  Decrease speed 
•  Flow up in cell
•  Flow down in cell
•  Increase speed
• Decrease speed 

5. Right-click on the Cell Pump symbol, then select Turn off. If the pump fails to stop, the fluid 
control board may need replacing; contact your service representative.

Arrows indicate           Cell pump
flow direction              speed    

MasterTech icons do 
not display if 
MasterTech is not 
installed.
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Checking the Level of the Analyzer
An unlevel analyzer may cause inaccurate analyses. Check every 30 days to see if the analyzer is level. 

1. Open the analysis compartment door and locate the level indicator.

2. Look straight down at the indicator. The analyzer is level when the bubble is centered inside the 
black circle on the level indicator.

3. If the analyzer is not level, lift the corner then turn the appropriate foot counterclockwise to raise 
the unit or clockwise to lower the unit.

4. Set the analyzer back down and observe the indicator. The bubble should be centered inside the 
black circle on the level indicator.

Cleaning the Collimating Slits
The collimating slits may become blocked by dust or debris which accumulates in the analysis com-
partment over a period of time, causing inaccurate results.

To clean the collimating slits:

1. Place the analyzer ON/OFF switch in the OFF position.

2. Remove the retaining screws from the top of the analyzer; then remove the top panel.

3. Remove the analysis cell. Refer to Cleaning the Analysis Cell, page 7-8 for removal instructions.

4. Remove the two foam plugs in the top of the analysis module.

5. Use a hex driver with an extension to remove the collimator retaining screws.

Level Indicator
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6. Reach through the door of the analysis compartment to lift the top collimator out of the analysis 
module.

7. Use a lint-free cloth to clean the shiny area near the center of the collimator you have removed 
and the corresponding area of the collimator remaining in the analysis module.

8.  Replace the top collimator and the retaining screws.

9. Tighten the retaining screws for the top collimator.

10. Replace the two foam plugs in the top of the analysis module.

11. Replace the analysis cell and the top panel.

12. Place the analyzer ON/OFF switch in the ON position.

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the 
collimating slits.

Tighten the collimator retaining screws only enough to securely hold the collimator in 
place. Over-tightening the screws can close the collimating slits, reducing the intensity 
of (or completely blocking) the X-rays.

Collimator Retaining
Screws

Foam Plugs
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Routine Maintenance

Replacing the X-Ray Indicator Lamps
The X-RAY STANDBY indicator and the X-RAY ON indicator on the front panel of the analyzer con-
tain an internal lamp. If either of these lamps burn out, perform the following steps to replace it.

1. Remove the cover lens from the analyzer by prying with a flat object as shown below.

2. Using a flat object, pull the lever which raises the lamp socket out of the lamp compartment as 
shown below. This makes the lamp accessible.

 If the X-RAY ON indicator lamp is burned out or installed incorrectly, the instrument 
will be inoperative.

Disconnect the analyzer power cord from the AC power source before attempting to 
replace the lamp. Failure to do so could result in electrical shock or damage to the 
instrument.
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3. Remove the lamp by pulling it away from the socket.

4. Push lamp socket lever toward the analyzer and insert replacement lamp into socket.

5. Replace the indicator cover lens.

6. Connect the analyzer power cord to an AC power source. Place the ON/OFF switch in the ON 
position and place the keyswitch in the appropriate position. Verify that the lamp is working.

Replacing the Cell Windows
X-ray photons from the X-ray source pass through the cell windows to the X-ray detector on the other 
side of the cell. If cell windows become scratched or damaged, settling particles may become 
entrapped. This could alter X-ray pulses, resulting in invalid analyses. The analysis cell windows 
should be replaced when necessary. Refer to Cleaning the Analysis Cell, page 7-8.
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Replacing the Analysis Cell Assembly
If the analysis cell assembly becomes damaged, it may be necessary to replace it. To replace the analy-
sis cell assembly:

1. Go to Unit [n] > Drain and Load.

2. Select Leave mixing chamber empty; then Continue.

3. When prompted to load the sample, select Cancel.

4. Place the Pump Control switch on the analyzer front panel in the OFF position.

5. Open the transparent sliding door to the analysis compartment. 

6. Loosen the cell mounting screw and remove the cell from the retaining bracket as shown below. 

7. Carefully remove the flexible tubing from the two ports on the cell.

8. Connect the flexible tubing to the ports on the new analysis cell 

9. Insert the cell in the retaining bracket and tighten the cell mounting screw.

10. Place the Pump Control switch in the ON position.
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Determining the Cause of Bubbles
If bubble problems continue to exist, perform the following steps to determine their source.

1. Install a clean, cell assembly in the cell holder and ensure it is free of bubbles. Refer to Replacing 
the Analysis Cell Assembly, page 7-22.

2. Go to Unit [n] > Baseline and perform the steps for collecting baseline data. Refer to 
Performing a Baseline Measurement, page 2-19.

If the analyzer is successful in obtaining a baseline, the cell proceeds to a parked position, 
indicating that bubbles are caused by: improper tubing routing, a failed valve, window 
misalignment, or a loose inlet / outlet port on the cell assembly. Refer to the troubleshooting table 
at Troubleshooting, page 7-1.

If the analyzer is unable to obtain a baseline, an error message appears in the lower status 
window. This indicates X-ray detection and / or generation problems may be present. Contact 
your Micromeritics service representative for corrective action. 

Resetting the Mixing Pump and Cell Pump
If an electrical overload occurs with the mixing pump or the cell pump, reset the pumps as follows:

1. Place the Pump Control switch on the front panel in the OFF position.

2. Allow the internal varistor to cool down (approximately two to three minutes). 

3. Check the tubing to verify that it is routed properly.

4. Place the Pump Control switch in the AUTO position.

5. Verify pump operation. Refer to Checking the Operation of the Mixing Pump, page 7-16 and 
Checking the Operation of the Cell Pump, page 7-17.

Contact your Micromeritics service representative if the problem continues.
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Replacing the Ultrasonic Probe Tip
After extended periods of use, the tip of the ultrasonic probe on the MasterTech may become pitted, 
causing diminished agitation. 

1. Remove the damaged tip from the probe using the wrenches provided.

2. Attach the new probe tip to the probe body. Use the wrenches to tighten securely.

Replacing the MasterTech Input Power Fuse

1. Ensure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power connector at 
the rear of the MasterTech.

3. Remove the fuse from the fuse block.

Refer to ORDERING INFORMATION, page 8-1 to determine the correct part to be 
used with your probe assembly.

Never hold the probe by the tip. Doing so may cause damage to the probe.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.
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The input power connector can be used with either a single-fuse arrangement or a double-fuse 
arrangement, as shown in the following illustration.

4. Insert appropriate fuse(s) for the input power source. The following chart gives the appropriate 
fuse rating.

Power Source                 Fuse                                   
100-120 VAC 3AG, 1.25 Amp Slow-Blow
200-240 VAC 5x20 mm, 0.8 Amp Slow-Blow (Type T)

5. Insert fuse block and cover assembly into the input power connector (as shown in the following 
illustration) and snap it into place. 

The fuses used in the MasterTech must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and / or damage to the MasterTech.
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8.  ORDERING INFORMATION

The analysis system components and accessories can be ordered using one of the following methods: 

• Call our Customer Service Department at (770) 662-3636
• Email orders to orders@micromeritics.com
• Contact your local sales representative 

Please use the following information to place an order.

SediGraph Parts and Accessories

Part Number Item and Description 

Analyzer 

512-50000-00 SediGraph III Plus analyzer; includes software, operator’s manual, and 
accessories. This represents either the only analyzer in a single-
analyzer system or the first of multiple analyzers in a system.

Cables 

003-20665-00 Interface cable, shielded

003-60101-06 Power cord, shielded

003-63801-01 Cable, Ethernet straight-thru

Filters 

512-27600-01 Filter, air, 10 ppi (washable), for analyzer

512-27600-02 Filter, air, 25 ppi (washable), for analyzer

512-27600-03 Filter, air, 45 ppi (washable), for analyzer

Operating Supplies

003-39046-00 Lamp for analyzer front panel x-ray status indicators

004-25053-00 Spatula

004-61021-00 Beaker, 100 mL

004-61050-00 Bottle, 10L
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004-61050-01 Modified cap for 10L Bottle

500-25610-00 Magnetic stirring bar

500-58904-00 Sound abating enclosure (for use with ultrasonic probe)

510-32801-01 Cell window, set of 2

510-32804-01 Cell window, Homalite®, set of 2

511-25866-00 High settling velocity cell

511-25870-00 Mixing chamber assembly, standard

511-25870-02 Mixing chamber assembly, stainless, for high pH resistance

512-25807-01 Mixing chamber cover bezel

512-33601-00 Recommended operating supplies kit, includes: 2 plastic 10-Liter 
bottles, 2 magnetic stirring bars, 8 cell windows, 2 analyzer air filters, 5 
sets Tygon and 2 sets Silicone tubing.

512-62600-00 Peristaltic pump head, for cell or mixing chamber pump (no motor)

Reference Material

004-16811-00 Reference material, garnet (~11.0 μm)

004-16814-00 Reference material, glass (~1.5 μm)

004-16835-00 Reference material, fine particle size (~0.77 μm) - Traceable to NIST

004-16837-00 Reference material, garnet (~3.77 μm) - Traceable to NIST

Software and Manuals

512-20805-00 SediGraph III Plus - operator manual and current version software

512-42805-00 SediGraph III Plus - operator manual

Part Number Item and Description (continued)
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Tubing

512-32820-01 Tubing set, Tygon®, universal, pre-cut

512-32820-02 Tubing set, universal, pre-cut

512-32820-03 Tubing set, Viton, universal, pre-cut

512-32820-04 Tubing set, Silicone, universal, pre-cut

512-32821-01 Tubing set, Tygon, for mixing chamber pump and cell pump

512-32821-02 Tubing set, universal, for mixing chamber pump and cell pump

512-32821-03 Tubing set, Viton, for mixing chamber pump and cell pump

512-32821-04 Tubing set, Silicone, for mixing chamber pump and cell pump

Ultrasonic Parts

003-58601-00 Ultrasonic bath, 115 Volts

003-58602-00 Ultrasonic bath, 230 Volts

500-58902-00 Ultrasonic probe, 250 Watts, 115 Volts (not available in countries 
requiring CE certification)

500-58903-00 Ultrasonic probe, 250 Watts, 230 Volts (not available in countries 
requiring CE certification)

Part Number Item and Description (continued)
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Ordering Information SediGraph III Plus
MasterTech Parts and Accessories

Part Number Item and Description 

 004-61021-01 Beaker, tall form, 100mL, glass

 051-14811-00 Evaporation cover

 051-14814-00 Turntable assembly

 051-32901-00 Tubing set, Tygon®, pre-cut

 051-58600-06 Ultrasonic probe tip, for use with units that have ultrasonic probe 
cables with connectors at both ends of the cable. One connects to the 
top of the probe and the other to the MasterTech. 

 051-58605-02 Ultrasonic probe tip, for use with units with serial number 151 and 
greater, which have only one connector that connects to the 
MasterTech.

052-00000-00 MasterTech 052, for automatic sample preparation. Redisperses 
samples and transfers them to the SediGraph for analysis. Includes 
built-in mechanical stirrer and ultrasonic probe. 

 052-32802-00 Tubing, MasterTech to SediGraph

052-54600-00 Key, Tubing loading
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SediGraph III Plus Appendix A
A.  ERROR MESSAGES

This chapter contains a numerical listing of the error messages associated with the analysis program. If 
the Action response for the message instructs you to contact your Micromeritics service representative, 
record the error message and make backup copies (if appropriate) of any files involved in the 
operation. 

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message)

2430- Error accessing file (file name), error code = (number).

Cause: Start Report failed to execute the report susbsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application (this 
will not affect any of your sample files). Contact your Micromeritics service 
representative if this message continues.

Cause: An internal processing and / or hardware error has occurred. 

Action: Contact your Micromeritics service representative if this message continues.

Cause A: Diskette may be damaged.

Action A: Clean the diskette drive. If this does not eliminate the problem, attempt the 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Contact your Information Technology department or perform hard disk 
diagnostics.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your Micromeritics service representative.

Cause D: The name specified contains one or more invalid characters.

Action D: Enter a valid file name; do not use characters such as * or ?.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) - Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

Cause: The hard disk does not have enough space left to perform the operation.

Action: Copy files not used regularly from the hard disk to diskette, delete them 
from the hard disk, and then try the operation again.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative if this message 
continues.

Cause: Several files have been added to this directory by some function other than 
the analysis program.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a minute. 

Click No to leave the directory information as is. This option may be 
feasible if a large number of files have been copied into the directory and 
the name of the file is known.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative if this message 
continues.

Cause: An invalid path name and / or extension was entered.

Action: Type a valid path name (including the proper extension) and press Enter.

Cause: A file specification was entered that does not exist.

Action: Enter an existing file specification or select a file name from the list box.
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2438- Disk drive (letter): is inaccessible.

2439- Cannot register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

2448- (directory type) File directory (path name) is invalid. Resetting to the installation 
directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

Cause: A disk drive that is not presently accessible was selected

Action: Ensure that the drive is not write-protected.

Cause: An unrecoverable error occurred when accessing a data file.

Action: Contact your Micromeritics service representative.

Cause: A working directory specified in the .INI file is invalid. The directory may 
have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time a file is opened, 
use the Directories: list to move to the correct directory.

Cause: An invalid file name was entered.

Action: Enter a valid file name. A file name can contain up to eight 
alphanumeric characters.

Cause: An automatic analysis (an analysis in which sample files are created using the 
defaults) was initiated while editing the defaults.

Action: Finish the edit session of the defaults and close the window. Then restart the 
automatic analysis.
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2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handlers available. Application cannot continue.

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file 
(this file exists in each folder containing sample or parameter files).

Action: Use Windows Explorer to access the folder containing the MICATTR.DIR 
file and disable the Read-Only option.

Cause: A File > Print operation was requested on multiple files with the destination 
specified as a disk file. All of these files cannot be processed in a single 
operation.

Action: Only the number of files indicated in the message will be processed. When 
these are complete, return to the File > Print menu selection and generate the 
reports for the remainder.

Cause: A File > Export operation was requested on multiple files with the 
destination specified as a disk file. All of these files cannot be processed in a 
single operation.

Action: Only the number of files indicated in the message will be processed. When 
these are complete, return to the File > Export menu selection and generate 
the reports for the remainder.

Cause: The analysis program has attempted to reserve space for the disk files which it 
will require. This attempt has failed.

Action: Modify the “files=” entry in the CONFIG.SYS file to have a value of 80 or 
greater. Re-boot the computer and attempt to restart the application. Contact 
your Micromeritics service representative if this message continues.
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2457- Results cannot be displayed. More than (n) windows are currently displaying or 
printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460- Fatal Communications error on (Unit n - SN: nnnn)

 
 

Cause: A report was sent to the screen or to the printer. This request exceeds the 
maximum number of reports which may be active at one time.

Action: Close some of the report-to-screen displays currently visible. If reports are 
active to the printer, wait until they have completed, then repeat the report 
request.

Cause: An attempt was made to exit the analysis program while the instrument is 
performing a critical operation. This operation must be completed before 
exiting.

Action: Wait a short time and try to exit again.

Cause: An attempt was made to exit the analysis program while an analysis is in 
progress. While this is possible, the data collected while the analysis program 
is inactive will not be permanently recorded until the analysis program is re-
started. A power failure to the instrument could cause some data to be lost.

Action: Click Yes to continue with the exit, however there is a potential for loss of  
data if a power failure occurs. Click No to wait for the analysis to finish.

Cause: There was a fatal error in the serial communications between the analysis 
program and the analyzer. All displays for that analyzer will be closed.

Action: Ensure that the analyzer is connected to the computer on the 
communications port configured by the Setup program. Stop and restart the 
analysis program. If the restarted application cannot establish 
communications with the analyzer, turn the analyzer off, then back on. 
Contact your Micromeritics service representative if this message continues.
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2461- No instruments are in operation. This application will unconditionally terminate.

2471- Unit n - SN: nnnn has an invalid communications port specified. It cannot be 
initialized.

2474- Unit n - SN: nnnn communications port specified in the program control files is 
already in use. Unit cannot initialize.

2475- Unit n - SN: nnnn communications port specified in the program control files 
cannot be accessed. Unit cannot initialize.

2476- Unit n - SN: nnnn startup failed. Cannot initialize the communications port.

2477- Unit n - SN: nnnn did not properly initialize.

Cause: At least one instrument must be active for the analysis program to operate. 
The initialization of all of the instruments configured with the Setup program 
has failed.

Action A: Usually this message is preceded by another message giving the reason for 
the instrument’s failure to initialize. Refer to the explanation for that message.

Cause: The communications port associated with this unit was not valid.

Action: Run the setup program and set up the unit on a valid port.

Cause: The communications port associated with this instrument is in use by some 
other program in the system.

Action: Close the other program to release the port. Restart the analysis program.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program and configure the unit on a valid port.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program and configure the unit on a valid port.

Cause A: There were communication problems between the computer and the analyzer.

Action A: Check the communication cables and make sure they are connected securely.

Cause B: Cancel was selected during initialization.

Action B: None required.
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2478-   Error copying sequential data segment.

2479- Unit n - SN: nnnn The instrument is busy performing an operation of which this 
application is unaware. Do you want to cancel?

2480- File (file name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (file name) (Code n).

Cause: An internal processing and / or hardware error occurred while accessing a 
portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for example, 
to use a utility such as ScanDisk. Contact your Micromeritics service 
representative if this message continues.

Cause: During initialization, the instrument was found to be analyzing, but the 
analysis program has no record of it. 

Action: Click Yes to cancel the analysis and synchronize the analysis program with 
the instruments status. Click No to abort the initialization and allow the 
analyzer to continue the analysis.

Cause: An analysis was tempted using a sample file that is being edited.

Action: Save the changes and close the window.

Cause A: An attempt was made to open a file that is already open or minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: Diskette may be damaged.

Action B: Clean the diskette drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause C: Hard disk may be damaged.

Action C: Contact your Information Technology department or perform hard disk 
diagnostics.

Cause D: A software error occurred when the file was accessed.

Action D: Contact your Micromeritics service representative.
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2482- File cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and 
contains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis?

2485- The service test file has an invalid status and cannot be used for this analysis.

2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

Cause: An attempt was made to open a file that is currently being used (either by this 
application or another).   

Action: Locate the application using the file (in the Micromeritics application, use the 
Windows menu item to get a list of all windows, one of which may contain 
this file).

Cause: An attempt was made to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: An analysis was attempted using a sample file that contains unsaved changes.

Action: Select Yes to save the changes and continue with the analysis. Select No to 
abort the analysis and return to the sample file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace All to 
copy parameters from the file originally selected.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative if this message continues.

Cause: The specified file is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.
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2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing 
window.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.

Cause: The specified file in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system options 
information used during program startup does not exist.

Action A: Restore the 5125.INI file from a system backup.

Action B: Reinstall the analysis program.  

Cause: The highlighted field(s) contain an invalid entry. Correct the error before 
closing the window.

Action: Check the entry and correct the error, then close the window.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: An invalid entry was used.

Action: Enter or select an appropriate value.

Cause: The value entered in the highlighted field is outside the valid range of values.

Action: Check the entry and enter or select an appropriate value.
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2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: The value entered in the highlighted field is outside the valid range of values.

Action: Check the entry and enter or select a value within the indicated range.

Cause: An invalid number was entered in the highlighted field.

Action: Check the entry and enter or select a valid number.

Cause: An invalid number was entered in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your Micromeritics service representative if this message continues. 
Record the name of the sample file in which the problem occurred.

Cause: The sequence number did not contain at least three digits.

Action: Enter a sequence number that contains at least three digits.
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2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (sample name).

Cause: No more sample information files can be created using the currently entered 
file name sequence number.

Action: Go to Options > Sample Defaults and enter a new sequence number.

Cause: A large number of windows are open and consuming the system resources 
available to all applications.

Action: Close one or more windows on the screen. Contact your Micromeritics 
service representative if this message continues.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed in the 
directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP directory 
is located.

Cause B: An internal processing and / or hardware error has occurred.

Action B: Contact your Micromeritics service representative if this message continues.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your Micromeritics service 
representative if this message continues.
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2505- Error Logger cannot be initialized!! Error code (number).

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration window. Install 
the device using the Control Panel - Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay is a valid file.

Cause: An error occurred while the program was opening a file necessary to the 
report operation.

Action: Use the name given in the error message to investigate. Contact your 
Micromeritics service representative if this message continues.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and remove the 
invalid character.

Cause B: The system was unable to create the usual temporary files during the report, 
possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your Micromeritics service representative.
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2511- Print job (name) has been canceled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) canceled. (number)

2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of the 
instrument. Only qualified service personnel should do this. Do you wish to proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

Cause: The disk drive does not have enough space for the temporary file required by 
the Windows Print Manager. Therefore, printing of the requested report has 
been canceled.

Action: Delete unnecessary files from the disk. At least 5 megabytes of free space is 
required for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: An invalid calibration file was selected (or one that cannot be read).

Action: Be sure the media containing the alleged calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media containing the alleged calibration file has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: The process of performing a calibration operation was started.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: A calibration operation was performed. A backup copy is recommended.

Action: Perform a calibration Save operation.
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2517- Canceling this window will reset the calibration state to what it was when this 
window was first opened. Are you sure you want to cancel?

2519- Entered or merged data must have at least two points with unique mass percent 
values.

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

Cause: Accepted the calibration performed.

Action: If the calibration operation was successful, press Accept.

Cause: The entered and / or merged data included in the report being attempted does 
not have sufficient unique mass percent values.

Action: Review the entered or merged data. There must be at least two points and the 
mass percent value of the last point must be different than the mass percent 
value of the first point.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative if this message continues.
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2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

2549- Error accessing online manual (name).

4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # <n>)

4201- No reports selected.

Cause: The application has discovered a different version of software operating in the 
analyzer. 

Action: If there are no analyzers other than the SediGraph connected to the computer, 
select Yes and allow the updated software to load.

Cause: An internal processing and / or hardware error has occurred.

Action: Contact your Micromeritics service representative if this message continues.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: An attempt was made to view the online manual but it could not be found.

Action: Reinstall the software. Contact your Micromeritics service representative if 
this message continues.

Cause: An internal error occurred while read control information was being read 
from a disk file.

Action: The disk on which the application is installed may have failed. Contact your 
Micromeritics service representative and report the code number given in the 
message.

Cause: No reports were selected in the Reports to Generate list box. No output 
could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the 
sample for reporting.
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4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

Cause: The selected analysis in the sample file activated for reporting does not 
contain any valid data.

Action: If the sample is still analyzing, wait until enough data have been collected to 
allow reporting. If the sample is complete, an error or operator intervention 
stopped this analysis before sufficient data could be collected. The analysis 
may be deleted from the file.

Cause: A tabular report was requested with Difference from reference selected as one 
of the columns. This quantity cannot be computed because the reference file 
is invalid.

Action: If no reference file has been specified, select one from the Report Options 
window and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: A tabular report was requested with Out of Specification selected as one of 
the columns. This quantity cannot be computed because the coarse 
specification file is invalid.

Action: If no specification file has been specified, select one from the Report Options 
window and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: A tabular report was requested with the Out of Specification selected as one 
of the columns. This quantity cannot be computed because the finer 
specification file is invalid.

Action: If no specification file has been specified, select one from the Report Options 
window and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: A tabular report was requested with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one column of 
the table.
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4207- No valid data is available for this report. No report produced.

4208- An overlay file is not valid. It was not included in the report.

4209- The reference file is not valid. The report was not produced.

4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

Cause: The selected test in the sample file activated for reporting does not contain 
any valid data.

Action: If the sample is still analyzing, wait until enough data have been collected to 
allow reporting. If the sample is complete, an error or operator intervention 
stopped this analysis before sufficient data could be collected. The analysis 
may be deleted from the file.

Cause: The sample file selected for overlay does not exist or contains invalid data.

Action: From the Report Options window, click Overlays and remove the sample file.

Cause: The Difference from Reference graph was selected. It cannot be computed 
because the reference file is invalid.

Action: If a reference file has not been specified, select one from the Report Options 
window and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: The Out of Specification graph was selected. It cannot be computed because 
the coarse specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options window and re-run the reports. If a file has been specified, ensure 
that it contains valid information.

Cause: The Out of Specification graph was selected. It cannot be computed because 
the fine specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options window and re-run the reports. If a file has been specified, ensure 
that it contains valid information.
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4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

6001- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6002- Error accessing the sample information file (file name). (Code <n>).

6003- File (file name) already has all its tests filled.

6004- File `(file name)` cannot be analyzed. It is currently being edited.

Cause: No reports were selected in the Reports to Generate list box. No output 
could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the 
sample for reporting.

Cause: Delete was selected on the Collected Data editor.

Action: Click Yes to remove the indicated test from the sample file. Click No to have 
the test remain in the sample file.

Cause: One of the automatic analysis modes is active. Sample defaults may not be 
edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause A: Full rights to the application’s folders and files is required.

Action A: Contact your system administrator to have full rights granted.

Cause B: An error occurred when trying to access a sample file.

Action B: Report the error code number given in the message to your Micromeritics 
service representative.

Cause: An attempt was made to insert a new test into a sample which already 
contains eight tests.

Action: A single sample file can have a maximum of eight tests. If additional tests are 
required on this sample, create another sample file.

Cause: A file was selected which was still open in an editing window for analysis.

Action: Finish the changes to the sample file, then save and close the editing window.
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6005- The file (file name) can not be prepared for analysis. It is open for editing and 
contains errors.

6006- The edit session for `(file name)` must be saved before it is prepared for 
analysis. Save changes and proceed with the analysis?

6007- (Unit n - SN: nnnn) Bubble elimination failed. Operation cancelled.

Cause: A file was selected which is currently being edited. Editing cannot be finished 
because the sample contains entry fields with errors.

Action: Correct the errors and finish editing the sample file. Then save, close the 
editing window, and try opening the file again.

Cause: A file was selected for analysis which is currently being edited. The changes 
to this file must be saved before it can be prepared for analysis. 

Action: Click Yes to save the changes and proceed with the analysis. Click No to 
review the changes before saving them.

Cause A: A wetting agent may be required to aid in bubble elimination.

Action A: Add one drop of Photo-Flo 200 or other wetting agent to the mixing chamber.

Cause B: Cold suspension fluid was introduced to the heated mixing chamber and cell, 
causing the release of dissolved gases.

Action B: Warm the suspension fluid prior to introduction, or allow it to circulate in the 
mixing chamber for several minutes before starting the analysis.

Cause C: Dispersion indicated in cell is not uniform.

Action C: Wait to see if bubbles are eliminated. Then check tubing for clogs or 
damage. Replace tubing if necessary. 

Cause D: The sample material being analyzed requires more suspension energy.

Action D: Change the analysis options to increase the pump speed specified for the full-
scale scan operation. After changing the sample file, repeat the analysis.

Cause E: The sample material being analyzed has a high density.

Action E: Change analysis options to reduce the sensitivity of the bubble detection 
method. After changing the sample file, repeat the analysis.
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6008- (Unit n - SN: nnnn): Bubble elimination difficulties encountered.

6009- (Unit n - SN: nnnn) Failure reestablishing full scale concentration. Analysis will 
continue.

Cause A: A wetting agent may be required to aid in bubble elimination.

Action A: Add one drop of Photo-Flo 200 or other wetting agent to the mixing chamber.

Cause B: Cold suspension fluid was introduced to the heated mixing chamber and cell, 
causing release of dissolved gases.

Action B: Warm the suspension fluid prior to introduction, or allow it to circulate in the 
mixing chamber for several minutes before starting analysis.

Cause C: Dispersion indicated in cell is not uniform.

Action C: Wait to see if bubbles are eliminated. Then check tubing for clogs or damage. 
Replace tubing if necessary.

Cause: D Material under analysis requires more suspension energy.

Action D: Change the cell pump speed in your analysis options, then repeat the analysis.

Cause E: Material under analysis has high density.

Action E: Change the bubble detection method to medium or coarse in your analysis 
options, then repeat the analysis.

Cause A: The system could not reach the same level of sample suspension as during the 
previous full-scale scan.

Action A: Cancel the current analysis. Use manual control to change the cell pump 
speed to 5 and operate the pump for one or two minutes. Repeat the analysis.

Cause B: Sample residue is trapped in the system.

Action B: Check the tubing and fittings for clogs and residue. Squeeze the tubing at all 
locations where residue is trapped. Repeat the analysis.
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6010- (Unit n - SN: nnnn) Sample concentration is low. Analysis will continue.

6011- (Unit n - SN: nnnn) Sample concentration is high. Analysis will continue.

6012- (Unit n - SN: nnnn) No x-rays detected.

6013- (Unit n - SN: nnnn) No x-rays detected due to key at Standby. 
6014- (Unit n - SN: nnnn) No x-rays detected due to door open. 
6015- (Unit n - SN: nnnn) No x-rays detected due to panel off. 
6016- (Unit n - SN: nnnn) No x-rays detected due to X-Ray filament over-current. 
6017- (Unit n - SN: nnnn) No x-rays detected due to X-Ray lamp off. 

Cause A: Too little sample was used, causing a 13% change in X-ray adsorption.

Action A: Cancel the current analysis. Using manual control, turn on both pumps and 
add more dispersed sample to the mixing chamber. Restart the analysis.

Cause B: The sample requires more suspension energy.

Action B: Cancel the current analysis. Using manual control, operate the cell pump in 
the UP direction at pump speed 5 for one or two minutes. Restart the analysis.

Cause: Too much sample was used, causing more than a 75% change in X-ray 
absorption.

Action: Cancel the current analysis. Using manual control, turn on both pumps and 
add more dispersing liquid to the mixing chamber to dilute the sample 
mixture. Restart the analysis.

Cause A: The solid portion of the cell is blocking the X-rays from the detector.

Action A: Using manual control, move the cell to a different position.

Cause B: The slit in the X-ray source or detector is blocked.

Action B: Clean the slits in the X-ray source to remove any residue. Refer to Cleaning 
the Collimating Slits, page 7-18.

Cause: No x-rays are detected due to the problem described in the error message.

Action: Correct the problem, then restart the operation.
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6018- (Unit n - SN: nnnn) No x-rays detected. Automatic operation will cancel.

6019- (Unit n - SN: nnnn) No x-rays detected due to key at Standby. Automatic 
operation will cancel.

6020- (Unit n - SN: nnnn) No x-rays detected due to door open. Automatic operation 
will cancel.

6021- (Unit n - SN: nnnn) No x-rays detected due to panel off. Automatic operation will 
cancel.

6022- (Unit n - SN: nnnn) No x-rays detected due to X-Ray filament over-current. 
Automatic operation will cancel.

6023- (Unit n - SN: nnnn) No x-rays detected due to X-Ray lamp off. Automatic 
operation will cancel.

6024- (Unit n - SN: nnnn) Error rinsing system. Cannot reestablish baseline 
concentration.

Cause A: The solid portion of the cell is blocking the X-rays from the detector.

Action A: Using manual control, move the cell to a different position.

Cause B: The slit in the X-ray source or detector is blocked.

Action B: Clean the slits in the X-ray source to remove any residue. Refer to Cleaning 
the Collimating Slits, page 7-18.

Cause: No x-rays are detected due to the problem described in the error message. The 
automatic operation that is in progress will be canceled.

Action: Correct the problem, then restart the operation.

Cause A: The dispersing liquid being used is different from the one used for measuring 
the baseline.

Action A: Perform a baseline measurement using the current dispersing liquid.

Cause B: Sample residue has remained in the cell.

Action B: Cancel the current operation. Using manual control, select the Flow Up in 
Cell direction for the cell pump at pump speed 5 for one or two minutes. Also 
check for clogs in the tubing and crimped tubing as necessary. Visually 
inspect the cell windows, clean or replace as necessary. Refer to Preventive 
Maintenance, page 7-5.
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6025- (Unit n - SN: nnnn) Cannot find beamsplit.

6026- (Unit n - SN: nnnn) Cannot find beamsplit. Automatic operation will cancel.

6027- (Unit n - SN: nnnn) Not enough cell travel to perform an analysis.

6028- (Unit n - SN: nnnn) Not enough cell travel. Automatic operation will cancel.

Cause A: The cell has been removed from the analyzer.

Action A: Replace the cell and resume operation.

Cause B: The cell elevator is not operating properly.

Action B: Contact your Micromeritics service representative.

Cause A: The cell has been removed from the analyzer.

Action A: Replace the cell and resume the operation.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.

Cause A: Cell assembly is assembled improperly.

Action A: Disassemble the cell assembly and reassemble. Be sure the sloped portions of 
the cell body and the retaining plates are aligned. Refer to Cleaning the 
Analysis Cell, page 7-8.

Cause B: The upper limit switch of the cell elevator must be reset.

Action B: Contact your Micromeritics service representative.

Cause A: Cell assembly is assembled improperly.

Action A: Disassemble the cell assembly and reassemble. Be sure the sloped portions of 
the cell body and the retaining plates are aligned. Refer to Cleaning the 
Analysis Cell, page 7-8.

Cause B: The upper limit switch of the cell elevator must be reset.

Action B: Contact your Micromeritics service representative.
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6029- (Unit n - SN: nnnn) Upper limit switch not found.

6030- (Unit n - SN: nnnn) Error moving cell.

6031- (Unit n - SN: nnnn) Error moving cell. Automatic operation will cancel.

6032- (Unit n - SN: nnnn) Temperature is not within the range of the liquid properties 
set.

Cause A: The cell position counter is too far out of position to find the upper limit 
switch. The lower limit switch may have been triggered.

Action A: Using manual control, move the cell to the upper limit switch; this resets the 
cell position counter.

Cause B: The cell elevator is not operating properly.

Action B: Contact your Micromeritics service representative.

Cause C: The upper limit switch is operating improperly.

Action C: Contact your Micromeritics service representative.

Cause A: Some object or the cell tubing is preventing the cell elevator from moving.

Action A: Check for and remove object, or reposition the cell tubing.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.

Cause A: Some object or the cell tubing is preventing the cell elevator from moving.

Action A: Check for and remove any foreign object, or reposition the cell tubing.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.

Cause: The temperature of the analysis compartment at the time of the analysis is not 
within the range defined by the liquid properties specified in the sample file.

Action: Go to Unit [n] Unit Configuration and either change the analysis 
compartment temperature, then clicking the Set Temperature button or 
change the liquid properties in the associated sample file.
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6033- (Unit n - SN: nnnn) Liquid density must be less than sample density.

6034- (Unit n - SN: nnnn) Fan problem (code n,n)

6035- (Unit n - SN: nnnn) Electronics problem.

6036- (Unit n - SN: nnnn) Using mixing chamber speed of (n) which differs from 
requested speed of (n). Analysis will continue.

6037- (Unit n - SN: nnnn) Fan problem (code n,n). Automatic operation will cancel.

Cause: The density of the dispersing liquid is too high for the sample being analyzed.

Action: Switch the dispersing liquid to one with density lower than that of the sample.

Cause: One or both of the cooling fans are operating at less than 70% of the normal 
speed. The code values are: 1,0 means the PMT fan has the problem; 0,1 
means the X-ray fan has the problem; 1,1 means both fans have the problem.
The third fan (located under the tube’s anode) will need to be checked 
visually. The third fan (located under the tube’s anode) will need to be 
checked visually. To access to the fan, remove the analyzer cover then remove 
the shield.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: An electronic component is not operating to specification.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: The mixing chamber speed specified in the sample file being analyzed 
(requested speed) is not the same as the speed at which the mixing chamber is 
currently operating.

Action: No action required unless the mixing chamber speed needs to be adjusted. In 
this case, enable manual control and adjust the speed.

Cause: One or both of the cooling fans are operating at less than 70% of the normal 
speed. The code values are: 1,0 means the PMT fan has the problem; 0,1 
means the X-ray fan has the problem; 1,1 means both fans have the problem. 
The third fan (located under the tube’s anode) will need to be checked 
visually. To access to the fan, remove the analyzer cover then remove the 
shield.

Action: Turn off the analyzer. Contact your Micromeritics service representative.
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6038- (Unit n - SN: nnnn) Electronics problem. Automatic operation will cancel.

6039- (Unit n - SN: nnnn) Error moving turntable.

6040- (Unit n - SN: nnnn) Error moving turntable. MasterTech automatic operation will 
cancel.

6041- (Unit n - SN: nnnn) Error moving arm assembly.

6042- (Unit n - SN: nnnn) Error moving arm assembly. MasterTech automatic 
operation will cancel.

Cause: An electronic component is not operating to specification.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: The arm is in the Load position or something is preventing the beaker tray 
from moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
beaker tray from moving.

Cause: The arm is in the Load position or something is preventing the beaker tray 
from moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
beaker tray from moving.

Cause: The arm is in the Load position or something is preventing the arm from 
moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
arm from moving.

Cause: The arm is in the Load position or something is preventing the arm from 
moving.

Action: Make sure that the arm is not in the load position or that nothing is preventing 
the arm from moving.
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6043- (Unit n - SN: nnnn) Not present.

6044- (Unit n - SN: nnnn) Turntable not present.

6045- (Unit n - SN: nnnn) Turntable not present. MasterTech automatic operation will 
cancel.

6046- (Unit n - SN: nnnn) Arm assembly at the load position.

6047- (Unit n - SN: nnnn) Arm assembly at the load position. MasterTech automatic 
operation will cancel.

6048- (Unit n - SN: nnnn) Cannot find position 1 on the turntable.

Cause A: The MasterTech has been turned off.

Action A: Check the power connection and make sure the POWER ON/OFF switch on 
the MasterTech is in the ON (1) position.

Cause B: The MasterTech is not properly connected to the analyzer.

Action B: Check the control cable from the MasterTech to ensure that it is properly 
connected.

Cause: The turntable is not properly installed on the MasterTech.

Action: Install the turntable as described in the Installation Manual.

Cause: The turntable is not properly installed on the MasterTech.

Action: Install the turntable as described in Installation Manual.

Cause: An attempt was made to perform an operation that is inoperable when the arm 
is in the Load position.

Action: Press the front panel switch to take the arm out of the Load position.

Cause: An attempt was made to perform an operation that is inoperable when the arm 
is in the Load position.

Action: Press the front panel switch to take the arm out of the Load position.

Cause: The turntable may not be seated properly. If the turntable is moving properly, 
a service problem may be indicated.

Action: Contact your Micromeritics service representative.
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6049- (Unit n - SN: nnnn) No beaker is present in position (n).

6050- (Unit n - SN: nnnn) No beaker is present in position (n). MasterTech automatic 
operation will cancel.

6051- Conversion has not finished, close anyway?

6052- Cannot read source file (file name).

6053- Destination file (file name) already exists.

6054- Unable to create destination file (file name).

Cause: An action was requested, such as a MasterTech rinse, but there is no beaker 
present in the specified position.

Action: Insert a beaker at the specified position and restart the operation.

Cause: An action was requested, such as a MasterTech rinse, but there is no beaker 
present in the specified position.

Action: Insert a beaker at the specified position and restart the operation.

Cause: An attempt was made to close the conversion status window before the 
conversion of all files was complete.

Action: Click Yes to cancel the conversion. Click No to allow conversion of all files 
to finish.

Cause: An attempt was made to convert a non-Windows sample file, but the file 
could not be read from the disk drive.

Action: The conversion of other files will continue; however, the specified file may be 
invalid. If this error occurs on multiple files, the disk drive containing the 
files may have failed.

Cause: An attempt was made to convert a sample file with the same name as an 
existing file.

Action: Delete the original destination file and repeat the conversion operation.

Cause: An attempt was made to convert a non-Windows file, but the output file 
cannot be created.

Action: The disk on which the converted file is to be stored may be full or may have 
failed.
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6055- Unable to load the Liquid Properties for file (file name). Defaults will be used.

6056- Unable to load the Particle Size table for file (file name). Defaults will be used.

6057- Conversion aborted. Unrecoverable error converting (file name) into (file name).

6058- At least one item must be selected for recording.

6059- An incompatible table with that name already exists.

6060- Unable to read the calibration file (file name).

Cause: An attempt was made to convert a non-Windows file, but the liquid properties 
could not be located.

Action: The conversion will continue using the default liquid properties. The 
converted data will be valid and usable. To conduct the conversion without 
warnings, ensure that the specified file is located in the `System Directory’ 
specified on the File Conversion window and repeat the conversion.

Cause: An attempt was made to convert a non-Windows file, but the user-defined 
report table could not be located.

Action: The conversion will continue using the defaults report table. The converted 
data will be valid and usable. To conduct the conversion without warnings, 
ensure that the specified file is located in the `System Directory’ specified on 
the File Conversion window and repeat the conversion.

Cause: An error occurred when converting a non-Windows file to the Windows 
format.

Action: The file cannot be converted. Contact your Micromeritics service 
representative.

Cause: The Start Recording Service Test step requires that at least one signal be 
selected for recording.

Action: Select a signal or click Cancel.

Cause: In a Service Test script, data collected have names, each of which must be 
unique.

Action: Specify a different name for the data.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no problems.
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6061- Unable to write the calibration file (file name).

6062- The instrument (unit number) is not calibrated.

6063- File cannot be opened for writing. It is already in use.

6064- The sample file [name] is not in a valid state to resume the analysis.

6065- You need to choose a sample file.

6066- There is no more room for another test in this sample.

Cause: An attempt to Save calibration data has failed due to possible media problems

Action A: Confirm the media containing the alleged calibration file has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: Calibration information for various analyzer components are missing.

Action: Run the application setup program and reinstall calibration information for 
the specified unit.

Cause: A File Save As operation failed because the specified file is already in use.

Action: Specify a different file.

Cause: The status of the sample file has changed since last used. It can no longer be 
used as part of an analysis.

Action: Select a new sample file, and restart the analysis.

Cause: OK was selected on a schedule entry window, but a sample file was not 
selected.

Action: Click Browse and select a sample file.

Cause: A sample file was selected for analysis that already contains eight tests.

Action: Select a different sample file, or delete one of the previous tests from the file.
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6067- The current baseline does not match the one already in the sample.

6068- The previous tests of this sample were run on a different SediGraph.

6069- The sample has an invalid status and cannot be used for this analysis.

6070- Unit n - SN: nnnn There is no baseline available for this unit.

6071- Configured serial number does not match instrument.

6072- Could not update the Liquid Properties file (file name). It is currently in use.

Cause: A sample file was selected that contains some analyses that were performed 
using a different baseline.

Action: Select a sample file that either has no tests, or has tests that were performed 
using the current baseline.

Cause: A sample file was selected that contains some analyses that were performed 
using a different analyzer.

Action: Either perform the new analysis on the same analyzer, or select a different 
sample file.

Cause: A sample file was selected that cannot be analyzed. 

Action: Select a file that has a status of No Analysis or Complete.

Cause: No baseline has been measured for this unit. 

Action: Measure a baseline before performing sample analyses.

Cause: The serial number stored in the analyzer does not match the serial number 
stored with the software.

Action: Contact your Micromeritics service representative.

Cause: Change was selected on the Material Properties window to change a liquid 
properties set. The selected properties cannot be updated because it is being 
edited.

Action: Close the editing session for the named Liquid Properties and try again.
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6073- Could not create the new Liquid Properties file (file name). Properties were not 
saved.

 
6074- Could not delete the Liquid Properties file (file name). It is currently in use.

6075- New data reduction options are currently being applied to the test data. Do you 
wish to cancel the reprocessing?

6076- Application of new data reduction options to (file name) is complete.

6077- All of the test data will be converted to the new data reduction options. Do you 
wish to continue?

Cause: Add was selected for a liquid properties set on the Material Properties 
window. The new properties set cannot be created.

Action: The disk drive on which the liquid properties are stored may be full or may 
have malfunctioned. 

Cause: Delete was selected for a liquid properties set on the Material Properties 
window. The selected properties set cannot be deleted because it is being 
edited.

Action: Close the editing window and try again.

Cause: An attempt was made to change the material properties for a completed 
sample. These changes are currently being applied to all of the data collected 
for that sample.

Action: Click Yes to cancel the changes. Click No and the computation will continue.

Cause: A request was made for a change to the material properties on a completed 
sample file. These changes have been applied to all of the data collected for 
the sample.

Action: Click OK to acknowledge the message. Click Save if the results are as 
expected.

Cause: A change was requested to the material properties for a completed sample 
file. These changes are about to be applied to all of the data collected for that 
sample.

Action: Click No to cancel the changes. Click Yes and the computation will continue.
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6078- The current hardware does not match the calibration.

6079- The Schedule contains duplicate beaker entries. Are you sure you want to 
continue?

6080- Cell nominal temperature value not in the expected range of (nnn.nn).

6081- Error computing particle sizes! The baseline or the fullscale was zero.

6082- Mixing chamber nominal temperature value not in the expected range of (n) to 
(n).

6083 (Data Reduction) Zero denominator in mass computation.

Cause: One or more calibrated components have been replaced in the analyzer.

Action: Contact your Micromeritics service representative.

Cause: Start was selected on the MasterTech Schedule window and there is more 
than one entry in the schedule that has the same beaker number.

Action: Click No to stop the operation and fix the schedule. Click Yes to continue 
with the schedule.

Cause: During temperature calibration, the value read is outside of the expected 
range.

Action: Confirm that the correct temperature calibration resistor is being used.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action A: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: During temperature calibration, the value read is outside of the expected 
range.

Action: Confirm that the correct temperature calibration resistor is being used.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.
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6084- (Data Reduction) Less than 11 data points collected.

6085- (Data Reduction) Computed a particle size of zero.

6086- (Data Reduction) Insufficient data for mass filter.

6087- The Coarse / Fine specification file is invalid. No results available.

6088- The cell temperature reading of (nnn.nn) is invalid. If an analysis is in progress 
you may choose to cancel it.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: The material properties specified for this sample result in a particle size 
computation which is less than or equal to zero.

Action: The data from this analysis will not be converted into a particle size 
distribution. Edit the material properties for the sample and modify them so 
they are valid. Click Update Properties on the Material Properties window 
to reprocess the analysis results.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: A request was made for an invalid file either the coarse or fine specification.

Action: If no specification files have been specified, select them from the Report 
Options window and re-run the report. If files have been specified, ensure that 
they contain valid data.

Cause: A temperature reading outside of the valid range has occurred.

Action: If the problem persists, contact your Micromeritics service representative.
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6089- The mixing chamber temperature reading of (nnn.nn) is invalid. If an analysis is 
in progress you may choose to cancel it.

6090- The sample is already scheduled to be used for another analysis. 

Cause: A temperature reading outside of the valid range has occurred.

Action: Contact your Micromeritics service representative if this message continues.

Cause: A sample file was requested for an analysis that is already scheduled in the 
MasterTech schedule or the Repeat schedule.

Action A: Select a different sample that is not scheduled in the MasterTech schedule or 
the Repeat schedule.

Action B: Remove the sample from where it is already scheduled and then try 
again.
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B.  SAMPLE DISPERSION

Use of the SediGraph requires that each powder be well dispersed in a liquid of known density and vis-
cosity and that the difference between the powder and liquid densities be accurately known. Viscosity 
and density data for some common liquids are given in Appendix G. Handbook values for other liquids 
are usually sufficiently accurate, so the latter requirement means that only the powder density must be 
determined if it is unknown and if composition information does not permit calculation from handbook 
values. For this, one of Micromeritics’ pycnometers is recommended. For materials likely to have 
dead-end pores into which liquid may not completely penetrate, the effective density* may need to be 
determined using the sedimentation liquid to be employed and a gas pycnometer.

The liquid should be one in which the powder can be completely dispersed (separated into unattached 
particles) for accurate size results to be obtained. Obviously, the liquid should be nontoxic, readily 
available, and one in which the sample is insoluble. Complete insolubility may be difficult to achieve 
in some instances. Solubility problems may be minimized by allowing the liquid to stand in contact 
with the particle material prior to using the liquid for the test sample. This cannot completely eliminate 
problems, however, because particle solubility is a function of particle size. Small particles are more 
soluble than large ones; in a dispersion of different sizes, the smallest particles tend to go into solution 
while precipitation occurs on the larger particles. In making a particle size distribution analysis, parti-
cle solubility is indicated if the recorded distribution consistently fails to attain zero percent even long 
after the analysis is complete.

There are no established rules or laws by which complete particle dispersion can be assured. Only 
guidelines can be offered. Some powders disperse easily in any of several liquids and remain so while 
others require careful attention to conditions in order to achieve dispersion and are prone to reagglom-
erate if conditions shift a small amount. A few can be dispersed only after extended treatments.

Agitation, resulting in the application of strong shear forces, aids dispersion. The more violent the agi-
tation, perhaps carried out in a high-speed blender, homogenizer, or an ultrasonic device, the better 
generally is the dispersion. Stirring a suspension while subjecting it to ultrasonic dispersion generally 
achieves the best dispersion because this ensures that all portions of the mix are brought into the zones 
of greatest energy.

For a few friable materials such agitation can result in comminution of the particles for which mea-
surements are preferred. This is not likely to be the case with solid particles, particularly when the 
particles are under 50 to 100 μm in diameter.

Air bubbles cause misleading results if trapped in the liquid during agitation. Care should be taken to 
avoid bubble entrapment, especially when the liquid is highly viscous. The SediGraph performs bub-
ble elimination routines and checks to verify their effectiveness, but the best agitation procedure is one 
that does not introduce them in the first place.

*The procedure for determining the effective density is discussed in Application Note #94. Contact your local 
sales representative or the Micromeritics sales office to request a copy.
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The magnetic stirrer built into the instrument is a convenient means for maintaining a homogeneous 
particle dispersion but will cause flocculation in certain magnetically susceptible materials. With such 
particles, stirring can be accomplished by using the ultrasonic dispersion accessory or the MasterTech. 
Refer to ORDERING INFORMATION, page 8-1, for part numbers.

Chemical wetting or dispersing agents also generally aid dispersion. A great variety of such products 
are marketed. Appendices C and H list some of the more useful dispersing aids, as well as sources for 
some of these materials. These agents have been found useful for particle dispersion in Micromeritics’ 
Materials Analysis Laboratory but are not the only agents available. It is to be noted that liquid density 
and viscosity values may need slight adjustment if more than about 0.1% by weight (based on the dry 
weight of the sample) of dispersing agent is added and precise measurements are needed.

Some commercial surfactants are intended for use in specific pH ranges and in particular nonaqueous 
solutions. Slight solution composition differences may alter the effectiveness of any agent. The chemi-
cal supplier should be contacted about this type of problem. Sometimes merely shifting the pH of an 
aqueous dispersion will yield great improvements in the degree of dispersion. Metal oxides and metals 
that are likely to have oxide layers on their surface ordinarily are most easily dispersed in mildly alka-
line media. Metal powders with any likelihood of grease on them should always be degreased prior to 
a dispersion attempt. Noble metal powders usually need a wetting agent for good dispersion. Disper-
sions involving hydrocarbon liquids that are immiscible with water are often difficult to make unless 
the powder is quite dry. Sometimes moisture picked up from the air is more than enough to cause 
difficulties.

Micromeritics offers Sedisperse® liquids in three series for dispersing particles at low solids concen-
trations. A- and P-series are stable, balanced formulations containing highly purified, saturated 
aliphatic hydrocarbons and added surfactants. A-series Sedisperse liquids are colorless while the P-
series are pale yellow. These liquids produce nearly universal dispersion of powder-liquid systems 
with solids concentrations below three weight percent generally, and as much as five weight percent in 
some cases. Sedisperse liquids solubilize adsorbed moisture.

W-series Sedisperse liquids are slightly anionic, non-foaming, aqueous formulations. They also pro-
duce nearly universal dispersion of systems with concentrations generally below three weight percent. 
Sedisperse liquids contain built-in surfactants and dispersants so that nothing else needs to be added 
for the dispersion of particles except mechanical and / or ultrasonic energy. These liquids are available 
over a range of densities and viscosities, thus making them applicable to particles of widely varying 
properties. Sedisperse liquids are designed to be used without dilution or the addition of surfactants, 
and exhibit good shelf life and stability. A data sheet is supplied with each liquid giving handling 
details, density, and viscosity data over a temperature range of 24 to 45 °C. 

The A-series Sedisperse liquids are the most widely useful and will disperse most powders, including 
metals, oxides, silicates, pigments, Portland cements, propellants, and many other powders. Those few 
materials not dispersing well in the A-series liquids can usually be dispersed in the P-series Sedisperse 
liquids. These are special formulations, slightly cationic, developed to disperse difficult metal and pig-
mented resin powders. The W-series Sedisperse liquids should be used to disperse those materials 
which are soluble in the organic Sedisperse liquids. See Appendix I for detailed information on Sedis-
perse liquids.

Some powders flocculate upon standing a few moments after having been dispersed. Such flocculation 
is quite readily detected with the SediGraph. The indicated size distribution as plotted by the instru-
ment during a test will proceed normally until flocculation starts. The first evidence of flocculation 
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will likely be an increase in the indicated particle concentration and this will then be followed by a pre-
cipitous drop in the plotted percentage. Flocculation, of course, prevents accurate particle size 
analysis, and better dispersion and stabilization techniques must be sought.

As a general guide, the best dispersing technique (includes agent and procedure) is the one producing 
consistently the finest distribution of sizes by SediGraph analysis. We make this assertion because of 
the high reproducibility of the SediGraph when presented identical samples. If the sample preparation 
technique is deficient in freeing particles one from another or if, though unlikely, is producing particle 
fracture, this will be evidenced by an inconsistency of results.

The rheological behavior of high concentrations of fine powder in a liquid gives a good preliminary 
indication of the suitability of both the liquid medium and the dispersing agent. Some powders con-
taining as much as 50 percent liquid act as if they were almost a solid mass, but a few tenths of a 
percent of wetting agent can cause the mass to take on the consistency of soup. This reaction is indica-
tive of a very good agent. The effect will not often be so dramatic, but working the mass with a spatula 
will give a good indication of the efficacy of an agent.

A test for the optimum quantity of a dispersing agent is conducted by measuring the sediment volume 
from a slurry of about 5 weight percent concentration. The slurry and agent must be mixed and allowed 
to stand in a sedimentation tube undisturbed by either mechanical vibrations or thermal currents. The 
minimum sediment volume indicates the best agent concentration level. If several dispersing agents 
are compared at the same time, the minimum sediment volume is also a measure of the best dispersing 
agent.

No particular sample concentration is required in using the SediGraph as long as the dispersed sample 
reduces the radiation beam intensity by 13 to 70 percent. The recommended procedure for initial test-
ing is to prepare a dispersion of approximately 5 volume percent concentration. Portions of this 
preparation are added to pure suspending liquid until an adequate concentration for analysis is 
achieved. The advantage of this procedure is that less concentrated dispersions can generally be pro-
duced without fear of flocculation once the initial preparation is made.
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C.  CHEMICAL AIDS FOR PARTICLE DISPERSION

Name Type Active Ingredient  

Aerosol 22 Anionic Tetrasodium N-(1,2-dicarboxyet hyl)-N-
octadecysulfosuccinanate, 35%

Aerosol OT Anionic Dioctyl ester of sodium sulfosuccinic acid, 70%

Atlas G-3300 Anionic Amine salt of alkylaryl sulfonate

Calcium Chloride Cationic CaCl2

Calgon Anionic Sodium hexametaphosphate, unadjusted

Calgon T Anionic Part of sodium replaced by other cations, predominantly zinc

Cobaltous Chloride Cationic CoCl2

Cobalt Citrate Anionic Co3(C6H5O7)2

Daxad 23 Anionic Sodium salt of polymerized carboxylic acid, 25%

Daxad 30 Anionic Sodium salt of polymerized carboxylic acid, 25%

FC-134 Cationic Fluorochemical surfactant

FC-161 Anionic Fluorochemical surfactant

FC-170 Nonionic Fluorochemical surfactant

Igepal CO-530 Nonionic Nonylphenoxypoly (ethyleneoxy) ethanol, 100%

Oleic Acid Anionic CH3(CH2)7CH=CH(CH2)7COOH

Renex 648 Nonionic Ethoxylated nonylphenol, 100%

Sodium Silicate Anionic Na2SiO3

Triton X-100 Nonionic Octyl phenoxy polyethoxy ethanol, 100%
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Data extracted from McCutcheon’s Detergents and Emulsifiers, McCutcheon Division, MC Publishing 
Co., Glen Rock, NJ, 1980.

Tamol SN Anionic Sodium salt of condensed naphthalene sulfonic acid, 100%

TSPOP Anionic Tetrasodiumpyrophosphate, Na4P2O7

Twitchell Base 
8240

Anionic Sodium salt of low molecular weight, sulfonated oil, parafin 
oil, water, and diethylene glycol

Tween 20 Nonionic Polyoxyethylene Sorbitan monolaureate (polysorbate 20), 
100%

Zonyl S-13 Anionic Fluoroalkyl phosphate

Zonyl A Nonionic Ethylene oxide-ester condensate

Name Type Active Ingredient (continued) (continued)
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D.  STOKES’ LAW

A particle falling due to gravity in a viscous liquid is acted upon by three forces: a gravitational force 
acting downward, a buoyant force acting upward, and a drag force acting upward. The descriptive 
equation of this motion is

(1)

where m is the mass of the particle, mo the mass of a volume of liquid equal to the volume of the parti-
cle, g the acceleration of gravity, FD the drag force, v the particle velocity, and t the time.

Small particles reach a stable, or terminal, velocity very rapidly; hence, dv/dt quickly becomes zero. 
The equation of motion for a sphere of diameter D and density ρ falling in a liquid of density ρo then 
becomes

(2)

Dimensional analysis reveals that stable particle motion through a liquid is governed by two dimen-
sionless groups: the particle Reynolds number Re

(3)

where η is the liquid viscosity, and a drag coefficient CD expressed by

(4)

The relationship between Re and CD for laminar (not turbulent) flow conditions is well established 
experimentally for low values of the Reynolds number to be

(5)
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Combining equations (2) through (5) yields

(6)

which has come to be identified as the Stokes law equation*.

* Stokes, G.G., Mathematical and Physical Paper III, Cambridge University Press, 1891.
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E.  SEDIMENTATION THEORY

Calculations
Sedimentation size analysis is based upon the fact that the measured equilibrium velocity of a particle 
through a viscous medium, resulting from the action of the gravitational force, can be related to the 
size of the particle by Stokes’ law. For spherical particles, Stokes’ law is expressed by

(1)

where

(2)

and D is the diameter of the spherical particle, v its equilibrium sedimentation velocity, and ρ its den-
sity. The fluid medium is characterized by viscosity  η and density  ρo ; g is the acceleration of gravity. 
These equations apply rigorously as long as the particle Reynolds number, Dvρo/η, is less than 0.3 and 
they apply up to a Reynolds number of 0.5, with about 3% error.*

In practice, truly spherical particles are seldom encountered, and Stokes’ law is not exact for any other 
shape. Since irregular shapes cannot in any case be described by a single linear dimension, it is 
accepted practice to specify the size of non-spherical particles in terms of the diameter of a sphere of 
the same material that would have the same sedimentation velocity. Thus, for non-spherical particles, 
the terms “Stokes’ diameter” or “equivalent spherical diameter” are universally understood. The term 
“equivalent spherical diameter” (E.S.D.) is sometimes used in a different context to mean the diameter 
of a sphere of the same material that would have the same mass as the particle in question; that is, the 
results of measurements of particle dimensions from electron micrographs are frequently reduced to 
size distribution curves in terms of mass E.S.D. In general, the relationship between these two mea-
sures of size is given by the inequality

(3)

The ratio expressed in equation (3) is usually close to unity.

*Lapple, C.E., et al, Fluid and Particle Mechanics, University of Delaware, Newark, 1956.

D Kv1 2⁄=

K 18 η
ρ( ρo )g–

-------------------------
1 2⁄

=

Sedimentation E.S.D.
Mass E.S.D.

---------------------------------------------------- 1≤

 

512-42805-01 (Rev C) - Apr 2022 E-1 



Appendix E SediGraph III Plus
Data on the sedimentation velocity of suspended particles may be obtained in two ways: (a) by mea-
suring the concentration of particles remaining in suspension as a function of time, or (b) by measuring 
the quantity of sediment produced as a function of time. The latter approach is less desirable mathe-
matically because of the graphical differentiation required to reduce the data to a size distribution 
curve.

Tests based on the first approach are traditionally performed in the following way. A dilute, dispersion 
of the fine particle material is stirred to render it homogeneous and then allowed to stand undisturbed 
while undergoing sedimentation. Time is measured from the beginning of the settling period. By 
Stokes’ law, a particle of diameter D will settle a distance h in time t according to the expression

(4)

where K is given by equation (2). Consequently, after a given time ti all particles larger than the corre-
sponding diameter Di will have fallen below a given distance h from the surface of the suspension. If 
the initial (uniform) concentration of material is Co g/cm3 and the concentration after time ti at distance 
h is Ci g/cm3, then Pi, the weight percent of material finer than Di, is given by

(5)

By obtaining values of Ci after various times, the corresponding values of Pi and Di may be calculated, 
which when plotted yield an integral, or cumulative distribution of particle size in terms of Stokes’ 
E.S.D.

The SediGraph uses a finely collimated X-ray beam to measure particle concentration in terms of the 
transmitted intensity of the X-ray beam through the suspension relative to the clear or particle-free sus-
pending fluid. This transmittance is a function of the weight concentration of the suspended solid at the 
depth of measurement. Since the X-ray beam can be made extremely small and because it does not dis-
turb the suspension, it constitutes an ideal measuring technique.

If a sample container or cell of rectangular cross section is irradiated from a direction perpendicular to 
one of its sides by a collimated X-ray beam, the fraction of the incident radiation transmitted by the 
cell when filled with the suspension under study is given by

(6)

where: I and Io are the transmitted and incident intensities; a1, as, and ac the X-ray absorption coeffi-
cients of the liquid, the particulate solids, and the cell walls, respectively; φ1 and φsthe weight fractions 
of liquid and solid present in the suspension; L1 the internal cell thickness in the direction of irradia-
tion; L2 the total thickness of the cell walls. By using the relation φ1=1-φs and by defining a 
transmittance T as the ratio of the transmission of the cell when filled with a sample dispersion to its 
transmission when filled with pure suspending liquid, there is obtained
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(7)

or
(8)

where A is a constant for the particular apparatus and suspension components.

By collimating the X-ray beam through horizontal slits with a vertical dimension small compared to 
the sedimentation depth, h, the measured values of T can be used in calculating the particle size distri-
bution; that is,

(9)

where To refers to the transmittance of the initial suspension.
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Method of Analysis
Generally, the sedimentation method derives its results from the rates that different size particles fall in 
a liquid due to the force of gravity. Rate, as used here, is the distance that a particle falls in a certain 
period of time. The scientific law which describes the rate that particles fall in a liquid is called Stokes’ 
Law. Large particles fall at a faster rate than smaller particles, as shown in the following illustration.

Figure E-1. Particle Size Analysis Using Sedimentation

In order to determine particle diameters accurately using the falling rates of particles, the density and 
viscosity of the liquid used must be known as well as the density of the particles. Density is the mass of 
a material that it takes to fill a unit of space. Viscosity may be thought of as the resistance of the liquid 
applied to falling particles. For example, a particle falls much slower in syrup than in water because 
syrup has a higher viscosity. It should also be noted that temperature affects both the density and vis-
cosity of liquids; therefore, the temperature of the liquid must be known for particle size 
determinations to be accurate.

The falling rates for various particle sizes are computed before analysis using Stokes’ Law. A vertical 
distance and an elapsed time are selected for each falling rate such that a particle falling at a certain 
rate will fall a certain distance in a selected time. Relative particle concentration is then measured at 
the selected distance and time.

Initially, a completely mixed (homogeneous) suspension of particles is established in a container by 
rapidly circulating the mixture. The circulation is stopped, and the relative concentrations of particles 
are measured at the selected vertical distances from the top of the container and at the selected elapsed 
times after circulation is stopped.

The particle size associated with each concentration measurement is the size of the largest particle 
present at the height and time of the measurement. All particles larger than that size have higher falling 
rates, and have fallen to a lower point in the container. Smaller particles are still present at equal con-
centrations just above and below the specified point. Thus, the concentration measured at the specified 
point is the concentration of particles smaller than or equal to that size.

Lowest Falling Rate

Highest Falling Rate
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This series of relative concentrations of particles smaller than various sizes is the particle size 
distribution.

Figure E-2. Particle Size Distribution

Since different particles usually have different shapes, the standard measure used to report particle size 
is Equivalent Spherical Diameter. This is the diameter of a sphere (or perfectly rounded mass) of the 
same material with the same falling rate. 

System Operation
The sedimentation method is used for particle size analysis in the SediGraph. The rates of particle fall 
due to gravity are calculated and X-ray absorption (concentration) of particles at different heights and 
points in time are determined, and the results of those determinations are provided as graphs and tabu-
lar reports. Sedimentation analysis takes place in the analyzer. Data are sent to the computer which 
provides the graphs and tabular reports.

The material to be analyzed is dispersed in a liquid, according to the type of analysis to be performed. 
(For more information concerning the relationship of dispersion to the type of analysis, see appendices 
B and C.) At the appropriate time, the dispersed mixture is poured into the mixing chamber on the 
front of the analyzer.

A magnetic stirrer located under the mixing chamber keeps the particles suspended (that is, keeps the 
particles from sedimenting) until it is time for the analysis. The stirring speed can be adjusted as 
required to properly suspend the particles. If the particles to be analyzed are attracted to the magnetic 
stirrer, the magnetic stirrer can be replaced with a mechanical stirrer. If the dispersion energy required 
to keep the particles in a dispersed state in the mixing chamber is more than can be provided by the 
stirrer used, an ultrasonic probe can be inserted into the mixing chamber.

Sedimentation takes place inside an analysis cell as shown in the following illustration. At the appro-
priate time, the particle mixture is transferred by the analyzer from the mixing chamber to the analysis 

% of Maximum Concentration
at Typical Specified Points
512-42805-01 (Rev C) - Apr 2022 E-5 



Appendix E SediGraph III Plus
cell. Particle circulation is stopped, and the particles are allowed to sediment (or fall) inside the analy-
sis cell under the influence of gravity. The SediGraph then determines the particle size distribution.

Figure E-3. Analysis Cell

An X-ray beam (made up of a number of fine parallel rays) is provided from a source inside the ana-
lyzer. A unit which detects X-rays is placed directly across from the X-ray source. The analysis cell is 
placed in the path of the X-ray beam, between the X-ray source and the detector. The cell contains a 
window on each side so that the X-rays can pass through the cell to the detector. Sedimenting particles 
(particles falling under the influence of gravity) inside the cell cross the path of the X-ray beam. The 
particles in the path of the beam absorb X-rays (that is, the particles keep some X-rays from reaching 
the detector). The amount of X-ray absorption at the point in the cell where the beam is located is 
determined as a percentage of the X-ray absorption with the highest particle concentration for that 
sample. Based upon particle falling rates, this percentage is related to the maximum particle size above 
that point in the cell.

Figure E-4. SediGraph Particle Size Analysis

The SediGraph system uses both particle falling rates and the amount of X-ray absorption for particle 
size analysis. Particle falling rates (according to Stokes’ Law) are used to determine the points in the 
cell beyond which certain size particles have fallen. X-ray absorption is used to determine the percent-
age of total particle mass at different points in the cell. The resulting particle size distribution data are 
processed by the system computer and used to provide graphs and tabular reports which provide 
details of the analysis.

Lowest Falling Rate

Highest Falling Rate

X-Rays

Sample Cell

Particle

X-Ray Detector

X-Ray Source
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Particle Falling Rates
Particle falling rates are very significant in the determination of particle size distribution. However, 
there are several important considerations in the accurate determination of particle falling rates. There 
must be a reference point for measuring particle falling distances. The SediGraph uses an automatic 
beam-split feature for establishing a reference point. Small particles have a low falling rate, which 
could require considerable amounts of time for analysis. The SediGraph uses cell movement during 
analysis to shorten analysis times by measuring small particle concentration at very short sedimenta-
tion distances. Cell movement does not affect particle falling rates within the cell. Particle dispersion 
also affects falling rates; therefore, proper particle dispersion is required when using the SediGraph.

Beam-Split

Figure E-5. Beam-Split

Since the top of the cell is used as the reference point for measuring particle falling rates, the exact 
position of the cell (relative to the X-ray beam) must be known in order for particle falling rates to be 
correct. The SediGraph determines the position of the cell by moving the cell to the point where the 
top edge of the cell splits the X-ray beam (exactly in half), and by storing this beam-split data in the 
system computer so that this position can be located for the next analysis. Beam-split is done automat-
ically by the system at the start of any automatic scanning operation; no message is displayed on the 
monitor unless beam-split cannot be performed for some reason.

Inside Top of
Cell

50% Beam Detector

100% Beam

X-Ray Source
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Cell Movement

Figure E-6. Cell Movement

The cell is attached to an elevator assembly which moves the cell down during analysis to speed the 
data collection process. The system computer performs the calculations associated with particle falling 
rates as the distances and times are changed according to the movement of the cell. For example, as 
shown in the cell movement illustration, it might take 30 minutes for the particle shown to fall the dis-
tance from the top of the cell to the X-ray beam; however, by moving the cell down, the particle 
reaches the beam in, perhaps, three minutes. The system computer uses this time and distance in deter-
mining the particle falling rate.

Particle Dispersion
The particle falling rates also depend upon how well the particles in the cell are dispersed (or sepa-
rated). Joined particles behave as a single particle with a greater falling rate than if the joined particles 
were separate (as shown in the following illustration).

Figure E-7. Affect of Dispersion on Particle Falling Rate

Cell is Moved Down

Joined Particles Have
Higher Falling Rate 
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X-Ray Absorption
In addition to particle falling rates, the SediGraph uses the relative amount of X-ray absorption as part 
of the analysis process. As falling particles in the cell cross the path of the X-ray beam, they absorb X-
rays. In order for X-ray absorption to be used for measuring the distribution of particle masses in the 
cell: (1) the minimum and maximum X-ray absorption must be determined for each X-ray absorption 
measurement point in the cell; (2) any bubbles in the cell must be detected and eliminated; and (3) the 
particles must be properly dispersed, as explained in Appendices B and C.

Baseline (Minimum) Absorption
In order for the X-Ray absorption values to be accurate, a reference (or baseline) must be used with 
each value. This baseline is the amount of X-ray absorption with no particle mass present. However, 
since the sedimentation liquid also absorbs X-rays, the amount of X-ray absorption for the liquid must 
be included in the baseline. The shape of the cell, or cell profile, affects the accuracy of baseline X-ray 
absorption values. The SediGraph automatically determines the baseline and makes baseline correc-
tions for any changes in the shape of the cell. This feature is called baseline correction. Let’s look at 
how it works.

When instructed, the SediGraph performs an X-ray scan of the cell filled only with the selected sedi-
mentation liquid. The reason for this scan is to determine the amount of X-ray absorption of the cell 
and liquid alone before any particles are introduced. The scan progresses from the bottom of the cell 
toward the top in exactly the same manner as will be done when sample particles are present.

As the cell is scanned, X-ray absorption reference values (referred to as baseline values) are deter-
mined at many points along the cell. The baseline value is the amount of X-ray absorption at that point 
in the cell. The baseline value is for 0% concentration since the cell contains only the sedimentation 
liquid and no particles.

Figure E-8. Baseline (0% Concentration) Absorption

Slight differences in the cell thickness at the measurement points (up to 250) along the cell change the 
amount of X-ray absorption for those points. The amount of X-ray absorption at each point is stored in 
the system computer and recalled during the analysis to adjust the baseline at those same points in the 
cell.

The baseline values do not change unless the sedimentation liquid changes, the shape of the cell 
changes, or the X-ray intensity changes. It is, however, recommended that you obtain a baseline mea-

X-Ray Source

X-Rays

Sample Cell

X-Ray Detector

Clear Liquid in
Cell
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surement at the beginning of each shift or whenever a different dispersant (or a new batch) is to be 
used. This assures accurate analysis results. The baseline operation is selected from the Unit [n] menu.

Full-Scale (Maximum) Absorption
Before each analysis, the SediGraph examines the cell filled with particles suspended in liquid (parti-
cles not allowed to sediment). As the cell is being examined, a full-scale X-ray absorption value (or 
maximum absorption) is determined for each point along the cell as shown in the following illustra-
tion. This full-scale absorption value is for 100% concentration, since the cell contains suspended 
particles, which represents the highest particle concentration for that analysis. The full-scale absorp-
tion values change with each analysis since a different number and composition of particles is used.

Figure E-9. Full-Scale (Maximum) Absorption

The X-ray absorption is measured at up to 250 positions in the cell. This may be reported on the Base-
line / Full scale report. The full scale scan used in the analysis is computed as the average of 10 
readings measured at a fixed position.

The full-scale absorption profile operation is performed automatically by the system. Since baseline 
absorption and full-scale absorption are known for each analysis point in the cell before the analysis, 
the absorption during the analysis is a percentage somewhere between baseline and full-scale. Using 
particle falling rate determinations, the system determines the size of the particles which have fallen 
beyond the specific analysis point in the cell. Therefore, the absorption percentage at each specific 
analysis point in the cell indicates the percentage of particles that are below a certain particle size. 
When this is done for a number of points in the cell, the particle size distribution can be determined.

X-Rays

Sample Cell

Particle

X-Ray Detector

X-Ray Source
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Bubble Detection / Elimination
If air bubbles are formed in the cell during analysis, the amount of X-ray absorption at those points 
will be detected as a sharp, discrete change. This would make the analysis results invalid. In order to 
prevent this, the SediGraph has a built-in bubble detection and elimination feature. This feature auto-
matically detects and removes bubbles from the cell. A message is displayed on the screen indicating 
this operation is in process.

Figure E-10. Bubble Detection / Elimination

Bubbles

Cell Tilted for
Bubble Discharge
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F.  SEDIGRAPH RESULTS RELATIVE TO OTHER METHODS

The SediGraph 5100 Analyzer, sieve analysis, and hydrometer measurements yield particle size distri-
butions on a mass (weight) basis. Microscopic measurements result in size data as a function of the 
number of particles. Measurements that involve light scattering, transmission, or diffraction relate size 
most appropriately to particle cross sectional area. Particle counting systems, electric zone sensing, 
gives size in terms of particle volume.

Mass-based measurements can be expected to be in agreement with respect to their reliability and the 
applicability to the size range involved, provided the particles are spherical and solid. When the parti-
cles are irregular, close agreement should not necessarily be anticipated. Sieve analysis, for example, 
must be very carefully performed with fine particles to ensure complete separation according to size 
without damaging the sieves. Even so, the size determined is not necessarily the same as that measured 
by the SediGraph. The SediGraph determines the size of all particles in terms of the E.S.D. (equivalent 
spherical diameter). Since sieve openings are usually square, elongated particles sometimes pass a 
given sieve in one orientation and at other times are retained. These differences obviously lead to dif-
ferences in results.

Light-based instruments incorporate various means for tuning, calibrating, and data reduction, which 
can make them agree satisfactorily for some materials with most any one of the other techniques. Any 
setting is dependent to a degree on the refractive index of the measured particles, however, so agree-
ment cannot be general or over all particle size ranges. The shape of the particles also influences all 
results.

Mass and volume measurements are equivalent numerically. Therefore, analyses with the SediGraph 
and the electric sensing zone can be expected to agree if the particles are spherical, solid, and if their 
size range is sufficiently narrow for all of them to be accurately detected by the electric sensing zone. 
Again, precise agreement is not to be expected with irregular particles, for the electric sensing zone 
measures something closely akin to the diameter an irregular particle would assume were it melted into 
a sphere. This is not necessarily the equivalent spherical diameter.

Microscopic measurements yield particle diameters that, for spheres, are essentially E.S.D. As before, 
measured sizes will deviate from E.S.D. when the particles are irregular— the greater the irregularity, 
the greater the deviation. The numbers will not correspond even approximately because, as noted 
above, the measurements are on a different basis. However number-based measurements are readily 
converted into mass-based (or volume-based) results by applying the relationship to incremental sizes,

where Y is the mass percent of particles having the diameter D and n the number of particles of that 
diameter. The denominator, therefore, represents the entire spectrum of sizes. The following tabulation 
presents number-based data and calculations leading to the number-based and mass-based diameter 
distributions.

Y nD3

Σ nD3( )
-------------------=
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            Comparison of Number and Mass (volume) Size Distributions

Particle 
Diameter 

Range 
(μm)

D
Largest 

Diameter 
Within 
Range 
(μm)

n
Number 

of 
Particles 
Within 
Range

Percent By 
Number 

Less Than 
Diameter

Percent by 
Mass Less 

Than 
Diameter

5.4 - 5.0 5.4 10 100.0 1575 0.0481 100.0

4.9 - 4.5 4.9 51 99.2 6000 0.1833 95.2

4.4 - 4.0 4.4 65 95.3 5537 0.1692 76.9

3.9 - 3.5 3.9 70 90.3 4152 0.1269 59.9

3.4 - 3.0 3.4 133 84.9 5227 0.1597 47.3

2.9 - 2.5 2.9 160 74.6 3902 0.1192 31.3

2.4 - 2.0 2.4 288 62.3 3981 0.1216 19.4

1.9 - 1.5 1.0 271 40.1 1859 0.0568 7.2

1.4 - 1.0 1.4 162 19.2 445 0.0136 1.5

0.9 - 0.5 0.9 72 6.7 52 0.0016 0.2

0.4 - 0 0.4 14 1.1 1 0.0000 0.0

nD3
nD3

Σ nD3( )
-------------------

1296 Σn= 32731 ΣnD3=
F-2                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Appendix G
G.  LIQUID DENSITY AND VISCOSITY DATA

Density and viscosity of pure liquids and solutions (aqueous, by weight) as functions of temperature at 
atmospheric pressure.

Liquid or Solution Temperature
(°C)

Density
(g/cm3)

Viscosity
(mPa•s)

Ethanol (absolute) 25
30
35

0.7851
0.7808
0.7764

1.096
1.003
0.914

Ethylene Glycol 25
32
40

1.1100
1.1051
1.0995

16.10
12.18
  9.13

Glycerol (10%) 25
30
35

1.0206
1.0192
1.0178

1.1530
1.0240
0.9150

Glycerol (20%) 25
30
36

1.0452
1.0436
1.0400

1.5430
1.3590
1.1743

Glycerol (40%) 25
30
35

1.0970
1.0948
1.0926

3.1860
2.7280
2.3400

Glycerol (50%) 25
30
35

1.1238
1.1211
1.1182

5.041
4.247
3.540

Hexane (n) 25
30
35

0.6550
0.6504
0.6459

0.3046
0.2900
0.2828

Isopropanol 30
32
35

0.7769
0.7752
0.7728

1.7800
1.6800
1.5400

Sucrose (20%) 20
30
40

1.0810
1.0777
1.0737

1.945
1.493
1.184
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Data extracted from (with interpolation in some cases):

Honig, P., Principles of Sugar Technology, p. 31, Elsevier Publishing Co., New York, 1953.

Swindells, J.F., Snyder, C.F., Hardy, R.C. and Golden, P.E., Viscosities of Sucrose Solutions at Various 
Temperatures: Tables of Recalculated Values, Supplement to N.B.S. Circular 440, U.S. Government 
Printing Office, Washington, 1958.

CRC Handbook of Chemistry and Physics, 59th Edition, The Chemical Rubber Co., Cleveland, OH, 
1978-79.

The Merck Index, 9th Edition, Merck & Co., Rahway, NJ, 1976.

Sucrose (30%) 20
30
40

1.1270
1.1232
1.1189

3.187
2.373
1.833

Sucrose (40%) 20
30
40

1.1765
1.1721
1.1676

6.167
4.375
3.241

Sucrose (50%) 20
30
40

1.2296
1.2250
1.2200

15.43
10.11
  6.991

Water 26
32
38

0.9968
0.9951
0.9930

0.8737
0.7679
0.6814

n-Butanol 25
32
40

0.8058
0.8003
0.7940

2.59
2.18
1.78

Liquid or Solution Temperature
(°C)

Density
(g/cm3)

Viscosity
(mPa•s)
G-2                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Appendix H
H.  SOURCES OF DISPERSING AIDS

Dispersant Source

Aerosol OT  
Aerosol 22

American Cyanamid Company, Process Chemicals Department, 
One-T Cyanamid Plaza, Wayne, NJ 07470

Calcium Chloride Can be purchased at most laboratory supply houses.

Calgon
Calgon T

Calgon Corporation, Water Management Division, Calgon 
Center, P. O. Box 1346, Pittsburgh, PA 15230

Cobalt Citrate Shepherd Chemical Company, Cincinnati, OH 45212

Cobaltous Chloride Can be purchased at most laboratory supply houses.

Daxad 23, 30 Hampshire Chemical Corporation, 55 Hayden Avenue, 
Lexington, MA 02173

Dispex 40 Allied Colloids, 2301 Wilroy Road, Suffolk, VA 23434

FC-134, -161 and -170 3M Company, Chemical Division, St. Paul, MN 55141

Igepal CO-530 GAF Corporation, 1361-T Alps Road, Wayne, NJ 07470

Lomar D Henkel, 300 Brookside Avenue, Ambler, PA 19002

Oleic Acid Can be purchased at most laboratory supply houses.

Renex 648 
Tween 20
Atlas  G-3300 

ICI Americas, Inc., Chemical Division, New Concordville Pike, 
Wilmington, DE 19897

Triton X-100 
Tamol SN

Rohm and Haas Company, Independence Mall West, 
Philadelphia, PA 19105

Sodium Silicate 
“N” Brand

Philadelphia Quartz Company, 1301-T E. Fort Avenue, 
Baltimore, MD 21230

Pyrophosphate (TSPP) Can be purchased at most laboratory supply houses.
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Zonyl A, S-13  E. I. DuPont de Nemours and Company, Dyes and Chemical 
Division, 1000-T Market Street, Wilmington,  DE 19898

Dispersant (continued) Source
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I.  SEDISPERSE® PARTICLE DISPERSION LIQUIDS

Description 
Sedisperse A-series and P-series liquids are stable, balanced formulations for dispersing insoluble par-
ticles. These liquids are primarily saturated aliphatic hydrocarbons. Sedisperse A- series liquids are 
colorless while P-series liquids are pale yellow. These liquids produce nearly universal dispersions of 
powder-liquid systems with solids concentrations below three weight percent and to as much as five 
weight percent in some cases. Sedisperse liquids solubilize adsorbed moisture.

Sedisperse W-series liquids are slightly anionic, non-foaming, aqueous formulations for dispersing 
insoluble particles. They also produce nearly universal dispersions of systems with solids concentra-
tions generally below three weight percent.

Sedisperse liquids are non-irritating, non-toxic, non-carcinogenic and non-explosive. The organic 
Sedisperse liquids will burn, but will not support combustion at room temperature.

Storage Requirements  
Keep containers closed. Keep containers from freezing. If a container develops a leak during storage, 
transfer it to another clean container. Spillage may be cleaned using detergent and water. Sometimes 
particles may crystallize and settle out of Sedisperse liquids during storage. This is usually a result of 
exposure to cold temperatures. It is corrected by warming the Sedisperse to 40-50 °C and then vigor-
ously shaking the liquid in a closed container to re-dissolve the particulates. Micro-organisms may also 
begin to grow in Sedisperse W-series liquids. These can usually be removed by filtering and the liquid 
is again usable for particle dispersion.

Technical Data  
Recommended techniques for using these liquids:  

1. Disperse particles using energy from an ultrasonic bath or probe accompanied by continuous, 
moderate mechanical agitation to force particles through the nodes of the standing ultrasound 
waves.

2. For sedimentation particle size analysis, first disperse the powder in Sedisperse and estimate the 
size of the largest particles using a microscope. Next, calculate the liquid viscosity needed by 
using the relationship

where

η = minimum viscosity permitted in mPa•s (or cp), 

Dmax = equivalent spherical diameter of the largest particles in μm, and 

η 0.0023Dmax Dmax ρ 1–( )=
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ρ    = density of the particles in g/cm3.

This calculation assumes a particle Reynolds number of 0.1. To convert mPa•s to poise, divide by 102. 

Material Properties
A Material Safety Data Sheet (MSDS) is supplied with each purchase. It should be consulted for the 
following information:

1. Oral Toxicity.

2. Local effect on eyes.

3. Local effect on skin.

4. Shock Sensitivity.

5. Decomposition characteristics.

6. Heat generation characteristics.

7. Recommended extinguishing agents.

8. Hazard by inhalation.

First Aid Treatment
The Material Safety Data Sheet (MSDS) supplied with each liquid should be consulted for the follow-
ing first aid information:

1. Skin contact.

2. Eye contact.

3. Inhalation.

4. Antidote in case of swallowing.
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J.  DATA REDUCTION

Data Acquisition
The basic data acquired are in the form of cumulative mass percent finer vs. diameter. An explanation 
of the method for acquiring the data is provided below.

Diameter
Diameter for a given set of sedimentation conditions is given by Stokes equation as follows

:

where
D = diameter (cm, multiply by 10000 for micrometers)
η = liquid viscosity (poise, multiply by 0.01 for cp)
h = sedimentation height (cm)
ρ = sample density (g/cm3)

ρo = liquid density (g/cm3)

g = acceleration due to gravity (981 cm/s/s)
t = sedimentation time (sec)

All data are acquired at one of 220 predetermined sedimentation heights, ranging from 2.54 cm to 
0.0079375 cm. 

Sample density is user-entered. Liquid viscosity and density are user-entered, or they are calculated 
using the sedimentation cell temperature and interpolating from the user-selected Liquid Properties Set 
(see Liquid Properties Interpolation).

Target diameters for data collection are determined as follows:

Up to 250 target diameters are selected, evenly spaced on a log diameter basis, between the user-
selected starting diameter and ending diameter. Note that this gives the operator some choice in the res-
olution of the data relative to the log diameter axis: selecting a narrower range of analysis provides 
more data points in a given range of diameters. Maximum resolution is obtained by selecting starting 
and ending diameters spanning only one decade (factor of 10), providing 250 data points per decade 
resolution.

Target sedimentation heights and times are selected based on run type (high speed, standard, or high 
resolution) and Stokes’ equation.

During analysis, mass % data will be taken at these target heights, and as close to these target times as 
possible, allowing for cell movement, data acquisition delay time, and sequential collection of data 

D 18η
ρ( ρo )g–

-------------------------
1 2⁄ h

t
---

1 2⁄
×=
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Appendix J SediGraph III Plus
points. The actual time of data collection will be recorded for each point, so that actual diameter may 
be calculated later.

Height, time, density, and viscosity data are stored separately, so that corrections to density and viscos-
ity can be made after the analysis and diameters are recalculated.

Liquid Properties Interpolation
The density and viscosity of the sedimentation liquid at the time of analysis are interpolated as follows, 
using a liquid properties table of three points of density and viscosity versus temperature, and the cell 
temperature reading at the start of analysis.

Density

where
t1, t2, t3 = temperatures from liquid properties table (degrees C)
d1, d2, d3 = densities at t1, t2, t3 respectively (g/cc)
A = first order coefficient
B = second order coefficient
tc = cell temperature reading at start of analysis (degrees C)
ρo = liquid density at analysis temperature (g/cc)

B ((d2 d1)– (d3– d1) ((t2 t1) / (t3-t1)))–×–
d1 2 t3 )–( )×(

--------------------------------------------------------------------------------------------------------=

A 1 (d2/d1) + B (t2 t1)2 ) t2 t1–( )⁄–×–(=

ρo d1 1 A tc t1–(×–( )× B tc t1–( )× 2 )+=
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Viscosity

where

t1, t2, t3    = 1/(t + 273.15) for t = each of the 3 temperatures in the liquid properties 
table (t in degrees C)

v1, v2, v3 =  ln(v) for v = each of the 3 viscosities (cp)
A, B, C     = 0th, 1st, and 2nd order coefficients, respectively
tk     = cell temperature at start of analysis (degrees K, i.e. 273.15 +  

degrees C)
η     = viscosity at analysis temperature (cp)

Mass Percent
The mass percent of sample present at a given sedimentation height after a given time is determined by 
relating the x-ray transmission intensity at that point to the intensity with no sample present (baseline), 
and the intensity with all of the sample present (full scale):

  mass % =  ( log(Im) - log(Ib) ) / ( log(If) - log(Ib) ) x 100 

where

Im=   intensity at data point (mass % being determined)

Ib=   intensity at baseline (mass % = 0)

If=   intensity at full scale (mass % = 100)

The Ib and If values are average values to minimize random variations in the X-ray intensity. The aver-
age of these values is used to compute the mass percent.

One set of baseline data may be used for scaling multiple analyses until another set of baseline data are 
collected.

After the sample is loaded while the cell pump is still on and the sample fully suspended and evenly 
distributed throughout the cell, bubble elimination data are collected at between 110 and 220 predeter-
mined analysis heights, based on the type of bubble elimination selected. In addition, a single average 
full-scale value is computed at the starting analysis height.

C (v1 (1 ( t1 t2–( )– t1 t3–( )⁄× ) ) v2– v3 (t1 t2) t1 t3 )–( )⁄–× (t1 t2–( )⁄ (t2 t3))–×+=

B v1 v2– C (t12 t22–×(– ))( ) (t1-t2⁄ )=

A v1 B t1×( )– C t12×( )–=

η e A( B tk )  +  (C tk2 ) )⁄⁄+=
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Mass percent data appearing on the ‘Analysis Results’ screen has been smoothed with an 11-point 
evenly weighted running average.

When data are saved permanently after all analyses on a sample are completed, the mass percent val-
ues are smoothed before storage in the sample file as follows:

The mass percent values are smoothed with an 11-point running average, just as for the ‘Analysis 
Results’ screen. From these data, a set of mass percent values are interpolated at 250 evenly spaced 
intervals on a log diameter basis, using linear interpolation between the two adjacent collected points 
to get each evenly spaced point. This is done because the next smoothing step requires evenly spaced 
data points, and the collected data can vary from even log diameter spacing due to limitations on time 
of collection, as noted above.

The evenly spaced mass percent values are smoothed using a digital filter which removes high-fre-
quency variations from the data. The final, stored mass percent values are obtained by interpolating to 
a standard size table with 40 logarithmicly, evenly-spaced sizes per decade.

Reduction of Collected Data

Mass Data
In order to obtain cumulative mass percent data, the smoothed mass percent data scaled to the specified 
full scale value:

For each of the total number of points collected,

Cumulative mass percent coarser data are simply the difference of scaled mass percent finer data from 
100:

For each of the total number of points collected

These cumulative mass data (finer and coarser) are represented directly in tabular form and as y-axis 
data in the CUMULATIVE MASS FINER VS. DIAMETER and CUMULATIVE MASS COARSER 
VS. DIAMETER plots (cumulative mass distribution curve). Also, cumulative mass data are used to 
derive mass frequency and log probability data.

Mass Frequency Data
The mass frequency of a particle size interval is the difference between the cumulative mass percent 
interpolated at the end points of the interval. The interpolation is performed using a spline fit to the 
cumulative mass data.

CumMassFiner (%) MassFiner FullScale
100.0

-------------------------×=

CumMassCoarser (%) 100.0 (%) CumMassFiner (%)–=
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Cumulative Data
Any cumulative quantity can be expressed as Coarser or Finer (Retained or Passed on the Tabular 
Report by Sieve Size). 

For data defined by the standard class sizes (Summary, Tabular Defined by Size Class, and Graphs):

   CumFracCoarseri =  Σ FreqFrack for all classes k such that AvgDiamk > AvgDiami

   CumFracFineri =  Σ FreqFrack for all classes k such that AvgDiamk < AvgDiami

   CumFracRetaini =  Σ FreqFrack for all classes k such that AvgDiamk > = AvgDiami

   CumFracPassi =  Σ FreqFrack for all classes k such that AvgDiamk < AveDiami 

or equivalently,

   CumFracFineri = 1.0 - CumFracCoarseri-1

   CumFracRetaini = CumFracCoarseri-1

   CumFracPassi = 1.0 - CumFracCoarseri-1

For Tabular Defined by SizeTable or by Sieve Sizes:

CumFrac (Coarser or Finer, Retained or Passed) is calculated for the standard size classes as 
defined above. CumFrac is then interpolated from CumFrac vs. Particle Size at each particle 
size in the Size table or aperture size in the Sieve table.

Peak Report Data
Peak report data are calculated as:

Starting at the small particle size end of the frequency distribution:

1. Scan DiffFreqFraci for a local maximum, i.e.,

DiffFreqFrack > DiffFreqFrack+1, and

DiffFreqFrack > DiffFreqFrack-1

DiffFreqFraci
FreqFraci
HighDiami
LowDiami
-----------------------------



log

--------------------------------------------=
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AvgDiamk is the mode of the candidate peak.

2. Scan DiffFreqFraci from class k toward smaller particle sizes to find a local minimum, i.e.,

DiffFreqFracm = 0, or

DiffFreqFracm < DiffFreqFracm+1 and DiffFreqFracm < DiffFreqFracm-1

LowDiamm is the low diameter of the candidate peak.

3. Scan DiffFreqFraci from class k toward larger particle sizes to find a local minimum, i.e.,

DiffFreqFracn = 0, or

DiffFreqFracn < DiffFreqFracn+1 and DiffFreqFracn < DiffFreqFracn-1

HighDiamn is the high diameter of the candidate peak.

4. Sum values of FreqFraci from i=m to i=n.

If the sum is greater than or equal to the Minimum Fraction to Report, the candidate peak is 
qualified and the sum is the Fraction of Distribution. Other peak quantities are calculated using 
the same formulas as for the entire distribution, except the only range from class m to class n 
isused.

Otherwise, the candidate peak is disqualified.

In either case, peak identification repeats from step 1, starting with class n. When the end of the distri-
bution is reached by scanning in either step 1 or step 3, peak identification is complete.

In step 1 if the end of the distribution is reached on an increasing frequency slope, i.e., DiffFreqFrack > 
DiffFreqFrack-1, then class k is treated as the mode of a candidate peak and as the high size end of the 
candidate peak.

If the beginning or end of the distribution is reached while scanning for a local minimum in step 2 or 3, 
the beginning or ending class is treated as the local minimum.

For calculating Standard Deviation for N tests, peaks from the various tests are simply matched by 
their order, i.e., peak 1 from test 1 is matched with peak 1 from test 2, etc. If all tests do not have the 
same number of peaks, Standard Deviation for N tests is reported as N/A (not available). If the peak 
numbers are not the same and the user chose average of n tests, a single row is filled in with all N/A 
(including the peak number).
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Number Frequency Data
The number frequency is computed from the mass frequency distribution as defined by the standard 
size classes.

For each class:

where

NumFreqN =   NumberfFrequency for class N

MassFreqN =  Mass frequency for class N

AvgDiam    =  Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative frequen-
cies for all smaller classes.

Surface Area Frequency Data
The surface area frequency is computed from the mass frequency distribution as defined by the stan-
dard size classes.

For each class:

where

AreaFreqN =   NumberfFrequency for class N

MassFreqN =  Mass frequency for class N

AvgDiam    =  Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative frequen-
cies for all smaller classes.

NumFreqi
MassFreqi AvgDiami

3⁄

ΣMassFreq AvgDiamk
3⁄

-------------------------------------------------------------

k

=

AreaFreqi
MassFreqi AvgDiami⁄
ΣMassFreq AvgDiamk⁄
-----------------------------------------------------------

k

=

512-42805-01 (Rev C) - Apr 2022 J-7 



Appendix J SediGraph III Plus
Size Statistics

Standard Deviation of Quantity for N Tests
For quantity, substitute the variable name for which the standard deviation is being determined. The 
subscript k refers to the test number.

If NumTests < = 1, StdDevTestQuantity = 0.

Otherwise,

Mode
In order to do a mode calculation, the definition of the standard classes is extended over the range of 
input for all the data; frequencies are calculated for these classes. It is this frequency data that is used in 
determining the peak quantities so that all the classes are of the same width.

  ModeDiam = AvgDiami such that DiffFreqFraci is the maximum DiffFreqFrac

Median
MedianDiam = Diameter interpolated from HighDiam vs. CumFracCoarser at CumFracCoarser = 0.5. 

If the calculation is being performed on a peak, the interpolation point is at CumFracCoarser = (Cum-
FracCoarserm + CumFracCoarsern)/2.

Arithmetic Calculations

Mean

MeanTestQuantity
ΣQuantityk
NumTests

---------------------------=

StdDevTestQuantity
Σ(Quantityk MeanTest Quantity)2–

NumTests 1–
--------------------------------------------------------------------------------------=

MeanDiam
ΣFreqFrac AvgDiami⋅

ΣFreqFraci
-------------------------------------------------------=
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Standard Deviation (of the distribution)

Coefficient of Variation

Skewness

Kurtosis

+xσ

where x is a user-selected number.

-xσ

where x is a user-selected number.

StdDevDiam
ΣFreqFraci (AvgDiam MeanDiam)2–

ΣFreqFraci
------------------------------------------------------------------------------------------------=

CoefVar StdDevDiam
MeanDiam

---------------------------------=

Skew
ΣFreqFraci (AvgDiami MeanDiam)3/ΣFreqFraci–

(ΣFreqFraci (AvgDiami MeanDiam)2/ΣFreqFraci)
3 2⁄–

----------------------------------------------------------------------------------------------------------------------------------------------=

Kurt
ΣFreqFraci (AvgDiami MeanDiam)4/ΣFreqFraci–

(ΣFreqFraci (AvgDiami MeanDiam)2/ΣFreqFraci)
2–

------------------------------------------------------------------------------------------------------------------------------------------ 3–=

PlusNSig MeanDiam x STdDevDiam⋅+=

MinusNSig MeanDiam x StdDevDiam⋅–=
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Geometric Calculations

Mean

Standard Deviation (of the distribution)

Standard Deviation of Log

Skewness of Log

Kurtosis of Log

+xσ

-xσ

Σ FreqFracilog(AvgDiami( )
ΣFreqFraci

--------------------------------------------------------------------

GeoMeanDiam 10=

10StdDevLogDiam

StdDevLogDiam
ΣFreqFraci (log(AvgDiam) (GeoMeanDiam))log 2–

ΣFreqFraci
------------------------------------------------------------------------------------------------------------------------------------=

SkewLog
ΣFreqFraci (log (AvgDiami) log (GeoMeanDiam))3/ΣFreqFraci–

(ΣFreqFraci (log (AvgDiami) log (GeoMeanDiam))2/ΣFreqFraci)3 2⁄–
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

KurtLog
ΣFreqFraci (log (AvgDiami) log (GeoMeanDiam))4/ΣFreqFraci–

(ΣFreqFraci (log (AvgDiami) log (GeoMeanDiam))2/ΣFreqFraci)
2–

------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 3–=

PlusNSigLog 10log(GeoMeanDiam) x log (GeoStdDevDiam)+=

MinusNSigLog 10log(GeoMeanDiam) x log (GeoStdDevDiam)–=
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Specification / Reference Quantities

Out of Spec
SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample distribution

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from Coarse Spec-
ification distribution interpolated if the bins are of different size. This is always the average of all tests 
in the named sample file.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from FineSpecifica-
tion distribution interpolated if the bins are of different size. This is always the average of all the tests 
in the named sample file.

If {SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

   OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFrac

   Coarseri-1

If {SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1}

   OutspecFracCoarseri = SampCumFracCoarser - FineSpecCumFrac

   Coarseri-1

or,

OutSpecFracFineri = -OutSpecFracCoarseri-1

OutSpecFracRetaini = OutSpecFracCoarseri-1

OutSpecFracPassi = OutSpecFracCoarseri-1
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Difference from Reference
SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from Reference Spec-
ification distribution interpolated if the bins are of different size. This is always the average of all the 
tests in the named sample file.

DiffRefCoarseri = SampCumFraci - RefCumFraci

or,

DiffRefFineri = DiffRefCoarseri-1

DiffRefRetaini = DiffRefCoarseri-1

DiffRefPassi = DiffRefCoarseri-1

Maximum Out of Spec
MaxOutSpecFrac = maximum (abs value (OutSpecFraci))

Pass / Fail by Specification
If MaxOutSpecFrac = 0, PassFail = Passed by Specification

Otherwise, PassFail = FAILED by Specification
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SPC Report Variables

Regression Chart
The line of best for the Regression Chart is calculated by the usual least squares method. If there is 
only a single point, or all N points have the same x-value, there can be no line of best fit in the standard 
form.

The coefficient of correlation for this line also is calculated in the usual 

way.*

* Mathematical Handbook for Scientists and Engineers, G.A., Korn and T.M. Korn, McGraw Hill, Sec. 
18.4 (1968).

XAve
Σxi
N

--------=

YAve
Σyi
N

--------=

Slope
Σ xi XAve ) yi YAve )–(–(

Σ xi XAve )2–(
---------------------------------------------------------------=

YIntercept YAve Slope XAve⋅–=

σx
Σ xi XAve )2–(

N
------------------------------------=

σy
Σ yi YAve )2–(

N
------------------------------------=

Cov (x,y) 
Σ xi XAve ) yiAVe )(–(

N
-------------------------------------------------------=

CorrelationCoef Cov x y ),(
σxσy

------------------------=
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Control Chart

Reynolds Number
The Reynolds Number is calculated as follows:

where  
D = specified starting diameter,
ρo = liquid density,
ρ = sample density,
η = liquid viscosity,
g = acceleration due to gravity, and
K = Stokes’ constant = 18.

The Reynolds Number is displayed on the tabular report.

Mean
Σyi
N

--------=

StdDev
Σ yi Mean )2–(

N 1–
-------------------------------------=

CoefVar StdDev
Mean

-------------------=

PlusNSig Mean n STdDev⋅+=

MinusNSig Mean n StdDev⋅–=

Reynolds Number D μm )(
10000 μm cn⁄( )
--------------------------------------

3
ρo g/cc) ρ ρo–( ) g cc⁄( ) g cm s s⁄⁄( )××(
K η cp )(( 0.01 (poise/centipoise)) 22×××
-------------------------------------------------------------------------------------------------------×=
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Log Probability Data
Log probability data are a transformation of cumulative mass finer data as a means of determining how 
well cumulative and differential mass data represent statistical normal distributions. Since cumulative 
mass finer data are essentially data indicating the probabilities of finding particles of mass finer at 
given diameters, log normal probability data are a fit of the cumulative mass data to the defined, sym-
metrical probabilities tabulated for a normal distribution. 

The log probability table used is a subset of 99 points, ranging from (-2.88, 0.2%) to (0.0, 50.0%) to 
(+2.88, 99.8%), from a standard normal distribution table (see log probability interpolation table). The 
x-axis and y-axis data which are plotted on a log probability graph are calculated as follows:

1. X-axis boundaries are determined by the spline interpolation at 0.2% and 99.8% from cumulative 
mass finer vs. log diameter. This gives Xprob_beg and Xprob_end, respectively.

2. For each of the number of points collected,

If Diameter value is between Xprob_beg and Xprob_end and

if CumMassFiner value is between 0.2% and 99.8%, then

Xprob value = Diameter value

Yprob value = Spline interpolation at CumMassFiner values of the x  vs. y log probability table 
values

Log Probability Interpolation Table

X(%) Y X(%) Y X(%) Y

0.20 -2.88 33.00 -0.44 68.08 0.47

0.99 -2.33 34.83 -0.39 69.15 0.50

2.02 -2.05 35.94 -0.36 69.85 0.52

3.01 -1.88 37.07 -0.33 70.88 0.55

4.01 -1.75 37.83 -0.31 71.90 0.58

4.95 -1.65 38.97 -0.28 72.91 0.61

5.94 -1.56 40.13 -0.25 73.89 0.64

6.94 -1.48 40.90 -0.23 74.86 0.67

7.93 -1.41 42.07 -0.20 76.11 0.71
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9.01 -1.34 42.86 -0.18 77.04 0.74

10.03 -1.28 44.04 -0.15 77.94 0.77

10.93 -1.23 44.83 -0.13 79.10 0.81

11.90 -1.18 46.02 -0.10 79.95 0.84

12.92 -1.13 46.81 -0.08 81.06 0.88

14.01 -1.08 48.01 -0.05 82.12 0.92

14.92 -1.04 48.80 -0.03 82.89 0.95

16.11 -0.99 50.00 0.00 83.89 0.99

17.11 -0.95 51.20 0.03 85.08 1.04

17.88 -0.92 51.99 0.05 85.99 1.08

18.94 -0.88 53.19 0.08 87.08 1.13

20.05 -0.84 53.98 0.10 88.10 1.18

20.90 -0.81 55.17 0.13 89.07 1.23

22.06 -0.77 55.96 0.15 89.97 1.28

22.96 -0.74 57.14 0.18 90.99 1.34

23.89 -0.71 57.93 0.20 92.07 1.41

25.14 -0.67 59.10 0.23 93.06 1.48

26.11 -0.64 59.87 0.25 94.06 1.56

27.09 -0.61 61.03 0.28 95.05 1.65

28.10 -0.58 62.17 0.31 95.99 1.75

29.12 -0.55 62.93 0.33 96.99 1.88

30.15 -0.52 64.06 0.36 97.98 2.05

X(%) Y X(%) Y X(%) Y
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Standard Report Tables

30.85 -0.50 65.17 0.39 99.01 2.33

31.92 -0.47 67.00 0.44 99.80 2.88

X(%) Y X(%) Y X(%) Y

Standard Diameter Standard Mass %

300 95

250 90

200 85

150 80

100 75

80 70

60 65

50 60

40 55

30 50

25 45

20 40

15 35

10 30

8 25

6 20

5 15

4 10

3 5
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1.5

1

0.8

0.6

0.5

0.4

0.3

0.2

0.1

Standard Diameter Standard Mass %
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K.  SEDIGRAPH X-RAY SAFETY INFORMATION

In a continuing effort to provide maximum safety to operators of Micromeritics equipment, and to 
ensure full compliance with all known government safety regulations regarding X-rays, Micromeritics 
provides a high level of X-ray safety on its SediGraph line.

General
The SediGraph Particle Size Analysis System employs soft X-rays to detect relative particle concen-
tration because X-ray absorption is directly proportional to particle mass. This X-ray beam is 
inaccessible to the operator at all times due to cabinet construction, a door enclosing the cell compart-
ment, a mechanical shutter that blocks the beam’s entry into the cell compartment when that door is 
opened more than 12 mm (0.5 in.), and electrical interlocks that interrupt power to the X-ray tube when 
the cell compartment door or top panel is opened.

X-ray Source

X-rays are generated by a small, air-cooled tube having a tungsten target inclined at 55o
 to a thin beryl-

lium window. It is operated at a potential of 13,600 VDC with a power input of less than 41 Watts. The 
greatest value the anode voltage can attain in a malfunction is 15,000 VDC. Only the tungsten L-lines 
are excited, of which the L is primary. This primary radiation has an energy of approximately 10,000 
eV and a corresponding wavelength of 0.125 nm (1.25 angstroms). The integrated radiation density of 
the direct, unattentuated beam over a 25-mm circular aperture is between 300 and 400 milliroentgens 
per hour. The X-ray beam is, for example, 60% blocked by a 51 μm (0.002 in.) thick film of the plastic 
polyvinyl chloride and essentially completely blocked by 130 μm (0.005 in.) thick steel. Nevertheless, 
the shutter mechanism should never be defeated.

Radiation levels outside the instrument or in the cell compartment when the compartment door is open 
are well below 0.5 milliroentgen per hour. Most jurisdictions require the registration of radiation 
producing devices regardless of kind or intensity level. Check with the appropriate authority in your 
area*.

Since a potential of 13,600 VDC and a current of up to 3 mA generate the X-rays, the instrument 
should be unplugged before any panel is removed for any purpose. This ensures that X-ray generation 
ceases and high voltages are eliminated.

*Based on the above information, SediGraph users in the State of Georgia have regularly been granted 
waivers to the State of Georgia “Rules and Regulations for X-Ray” by the Radiological Health Section 
of the Georgia Department of Human Resources.
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Warning / Indicator Lights
The SediGraph control switches and indicators are located on the front panel of the analytical unit and 
include a keyswitch to turn the X-ray tube on. The key is held captive when the keyswitch is on. There 
are two warning lights: An amber X-RAY STANDBY light and a red X-RAY ON light. With the ana-
lytical unit connected to the electric mains and the power switch on, the amber X-RAY STANDBY 
light is lit. Turning the keyswitch to the ON position causes the red X-RAY ON light to illuminate sig-
naling that power is applied to the X-ray tube. When the X-RAY ON light is illuminated, power is 
applied to both the filament and anode of the X-ray tube. If the X-RAY ON lamp filament burns out, 
then power is interrupted to both the filament and anode of the X-ray tube. In order for power to be 
supplied to the X-ray tube filament and anode when a failure (open circuit) occurs in the X-RAY ON 
light, concurrent failures must occur in two independent circuits such that these circuits continue to 
supply power to the X-ray tube.

The SediGraph has magnetically actuated reed switches. These switches are in series with the X-RAY 
ON lamp filament. Whenever the top or back panel of the SediGraph is removed, the cell-compartment 
door is opened, the fluid module is removed, or the X-RAY ON lamp filament burns out (opens), both 
filament and anode power to the X-ray tube are interrupted. 

These switches are in addition to the mechanical shutter which operates when the cell compartment 
door is opened, blocking X-rays and and removes filament power when the top cover is removed. Dur-
ing the last 12 mm (0.5 in.) of travel of the cell compartment door to the fully closed position, the 
sliding pin actuates the gravity-operated, spring-assisted shutter so that the shutter is opened to allow 
X-rays to enter the cell compartment. When the cell compartment door is opened from the fully closed 
position, the shutter is actuated during the first 12 mm (0.5 in.) of travel to close and block x-rays from 
entering the cell compartment. As long as the cell compartment door remains open, the shutter blocks 
X-rays from entering the cell compartment and the X-Ray Detection Indicator remains off.

Now, when the cell compartment door is opened, not only does the shutter block the X-ray beam but 
the power to the X-ray tube also is interrupted.
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L.  MASTERTECH INSTALLATION

The MasterTech should be correctly installed and checked to make sure that it is operating properly 
before actual analyses are attempted. 

Removing Packing Material From the Unit
After removing the MasterTech from the shipping carton, remove all foam packing material from the 
unit before proceeding with installation.

Selecting the Voltage
The MasterTech 052 leaves the factory set for 120 VAC and with the line fuse removed. The correct 
setting of the universal power entrance must be checked and the appropriate fuse installed before the 
MasterTech can be operated. The MasterTech is designed to operate with either 100, 120, 220 or 240 
VAC at 50 or 60 Hz. Voltage selection and fusing are made at the power connector which is located on 
the rear panel of the unit.

1. Ensure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power connector at 
the rear of the MasterTech.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.
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3. Pull the voltage selector card straight out of the power connector housing.

4. Orient the voltage selector card so that the proper voltage is indicated at the bottom. Orient the 
indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing the 
proper voltage first and with the printed side facing the power ON/OFF switch.
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6. Fuse the input power line according to local safety practices. The input power connector can be 
used with either a single-fuse arrangement or a double-fuse arrangement, as shown in the 
following illustration.

a.) Observe the position of the fuse block, using the previous figure for reference. If the single-
fuse arrangement is preferred, position the fuse block so that the side with the single-fuse slot 
and the jumper bar is away from the cover. 

If the double-fuse arrangement is preferred, position the fuse block so that the side with the 
double-fuse slots is away from the cover.

b.) If the fuse block is positioned properly for the fusing, proceed to Step c. 

If the fuse block is not positioned properly for the fusing:

1) Remove the fuse block retaining screw. 
2) Lift the fuse block from the cover. 
3) Rotate the fuse block. 
4) Mount the fuse block to the cover. 
5) Replace the retaining screw.

The power cord should be disconnected from the MasterTech when installing or 
replacing fuses. Failure to do so could result in electrical shock.

The fuses used in the MasterTech must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the MasterTech.
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c.) Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

Power Source                    Fuse                    
100-120 VAC 3AG, 2.00 Amp Slow-Blow
200-240 VAC 5 × 20 mm, 1.00 Amp Slow-Blow (Type T)

7. Insert fuse block and cover assembly into input power connector (as shown in the following 
illustration) and snap it into place. Once the fuse block and cover assembly are in place, the 
position of the indicator pin shows the input power selected.
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Turning on the MasterTech
1. Ensure the proper operating voltage and fuse are selected and in place.

Place the POWER ON/OFF switch, located on the MasterTech rear panel, in the ON ( | ) position. 
The +5 and +24 LEDs on the rear panel and some of the LEDs in the front panel switches should 
illuminate.

2. Press the ARM AUTO/LOAD switch on the front panel of the MasterTech. The arm should rise to 
the Load position, which is used for removal and replacement of the tray.

The ultrasonic probe should not be turned on at this point. Check the indicator on the 
ULTRASONIC PROBE AUTO/ON switch on the front panel of the MasterTech. If the ON 
indicator is illuminated, press the switch to turn off the probe. The indicator below 
AUTO should illuminate.

RS232 connectorPower switch

+5 and +24 VDC indicators

Power 
display

Intensity 
control

Pump Auto/Off 
switch

Ultrasonic Probe 
Auto/ON switch

Arm Auto/Load 
switch
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Installing the Beaker Tray
1. Ensure the arm of the MasterTech is in the Load (uppermost) position. When the arm is in the 

Load position, the Load LED is illuminated. If the Load LED is not illuminated, press the ARM 
AUTO/LOAD switch.

2. Hold the tray firmly by the outside edge. The bottom of the tray has small slots positioned radially 
outward from the inside edge. Place the tray on the MasterTech so that the arm passes through the 
center opening of the tray.

3. Ensure the drive pin is lined up into a radial slot on the bottom of the tray. The position of the tray 
does not matter at this point.

The front panel on your MasterTech may differ slightly from your MasterTech.
B-6                                                    512-42805-01 (Rev C) - Apr 2022



SediGraph III Plus Appendix L
Connecting Cables
1. Position the MasterTech next to the SediGraph. Ensure the units are level and their bases are at 

the same height. Alternately, the MasterTech may be placed on top of the SediGraph.

2. Ensure that the power switches on the SediGraph and MasterTech are in the OFF position.

3. Insert one end of the serial cable into the MasterTech connector on the side panel of the 
SediGraph. 

4. Insert the other end of the cable into the connector labeled MasterTech RS232 on the back of the 
MasterTech. 

MasterTech to 
SediGraph 
connection
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Installing the Ultrasonic Probe

1. The ON/OFF power switch on the rear panel of the MasterTech should be in the OFF (O) 
position.

2. Attach the probe cable to the connector labeled Ultrasonic Probe.

3. Ensure that the probe tip is attached to the probe; if not, attach it. A 1/4 in. probe tip is supplied 
with the MasterTech 052. A 1/8 in. tip is also available.

4. Insert the cylinder into the arm. Position the cylinder so that the longer slots slide over the 
protrusions inside the arm. 

5. Insert the probe into the cylinder.

Ensure that no power is supplied to the unit before starting this procedure.

Position the shorter slots of the cylinder over the protrusions if using the 1/8 in. probe.

Cable Ultrasonic Probe

Cylinder

Arm
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Installing Sample Transfer Tubing
Separate instructions are provided for installing sample transfer tubing into:

• a MasterTech with a serial number 500 or below, and 

• a MasterTech with a serial number 501 or above. 

MasterTech with Serial Number 500 or Below
1. Ensure that the MasterTech POWER switch is in the ON position and that the the arm is in the 

LOAD (uppermost) position; the LOAD LED is illuminated. If the LED is not illuminated, press 
the ARM AUTO/LOAD switch.

2. Several segments of flexible tubing are supplied with the MasterTech. Press the end of one 
segment of flexible tubing over the sample transfer tube until there is at least 1/2 in. (1.27 cm) 
overlap.

3. Unlatch the pump housing and unscrew the plastic knob on the rear of the pump. 

4. Thread the tubing through the pump as shown above and attach it to the rigid tubing labeled L 
(left) or R (right). Choose the rigid tubing labeled with the side of the MasterTech from which 
you want the fluid to be discharged.

5. Close and latch the housing. Tighten the plastic knob on the rear of the pump sufficiently to 
prevent tubing slippage but not enough to restrict flow through the tubing.

6. Open the pump chassis cover on the SediGraph by pulling it forward.

Sample Transfer tube

Flexible Tubing

Arm

Rigid Tubing

Pump

Pump Housing Latch

Plastic knob

Pump Housing
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7. Drain the system. 

8. Cut the flexible tubing labeled F midway between the mixing pump and the rigid tubing 
connector on the SediGraph. Remove and discard the segment remaining on the rigid tubing 
connector.

9. Remove a segment of flexible tubing from the accessories kit and cut a length of tubing 
approximately 1 1/2 in. (3.81 cm).

10. Attach the end of another segment of tubing to the Discharge Tube connector on the front of the 
MasterTech.

11. Thread the other end of the tubing through the hole in the analyzer lower front panel.

12. Attach tubing to the Y-connector as shown below.

13. Attach the tubing from the Y-connector to the rigid tubing connector on the analyzer.

14. Close the pump chassis cover.

If the MasterTech is located on top of the SediGraph, use the longer segment of tubing 
(P/N 052-32802-00).

Y-Connector

MasterTech Mixing Pump Tubing (F)

Tubing Segment
cut in step 8 - 
connects to rigid
tubing connector

Tubing

Y-Connector Mixing Pump
Tubing (F)

Mixing Pump

MasterTech
Tubing

Rigid Tubing
Connector
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MasterTech with Serial Number 501 or Above
1. Ensure that the arm is in the Load (uppermost) position. When the arm is in the Load position, the 

Load LED is illuminated. If the LED is not illuminated, press the ARM AUTO/LOAD switch.

2. Unscrew the two thumbscrews from the cover of the pump housing, then remove the cover.

3. Remove the cover from one of the steel tubes labeled L (Left) or R (Right). Choose the steel tube 
labeled with the side of the MasterTech from which you want the fluid to be discharged. Attach 
one end of the flexible tubing to the steel tube. A 21 in. segment of flexible tubing is shipped with 
the MasterTech.  

Load position

A                                                        B

A                                                                B
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4.  Loop the tubing around the pump rollers in a clockwise direction. Use one hand to hold the two 
ends of the tubing loop in the two grooves at the base of the pump.

5. Insert the key between the pump rollers near the left side of the pump base. The key blade must be 
between the tubing and the plate on the top of the rollers. 

6. Turn the key clockwise so the tubing presses into the groove until the key is stopped by the peg in 
the right side of the pump body.
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7. Slide the key out, then place the cover over the pump, wiggling it slightly to align it with the 
pump body and press it into place. Insert and tighten the two thumbscrews only tight enough to 
secure the cover.

8. Attach the other end of the flexible tubing to the Sample Transfer tube on the front of the 
MasterTech.

9. With the instrument schematic displayed, enable Manual Mode. Right-click the MasterTech 
Pump icon and select Turn On.

10. The pump should begin operating. If the pump does not start or is sluggish, pull on the long end of 
the tubing to create tension and pull excess tubing out of the pump, no more than 1/4 in. should be 

                                                                            A                                                                   B 
512-42805-01 (Rev C) - Apr 2022 B-13 



Appendix L SediGraph III Plus
required. (Loosen the thumbscrews if necessary.) When the pump is operating freely, hand-tighten 
the two thumbscrews, then turn the pump off.

11. Press the ARM AUTO/LOAD switch to place the arm in the AUTO position.

12. Open the pump chassis cover on the SediGraph by pulling it forward.

13. Drain the system. 

14. Cut the flexible tubing labeled F midway between the mixing pump and the rigid tubing 
connector on the SediGraph. Remove and discard the segment remaining on the rigid tubing 
connector.

15. Remove a segment of flexible tubing from the accessories kit and cut a length approximately  
1 1/2 inches (3.81 cm). 

16. Attach the end of another segment of tubing to the Discharge Tube connector on the front of the 
MasterTech.

17. Thread the other end of the tubing through the hole in the analyzer lower front panel.

If the MasterTech is located on top of the SediGraph, use the longer segment of tubing 
(P/N 052-32802-00).
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18. Attach tubing to the Y-connector as shown below.

19. Attach the tubing from the Y-connector to the rigid tubing connector on the analyzer.

20. Close the pump chassis cover.

Y-Connector

MasterTech Mixing Pump Tubing (F)

Tubing Segment
cut in step 7 - 
connects to rigid
tubing connector

Tubing

Y-Connector Mixing Pump
Tubing (F)

Mixing Pump

MasterTech
Tubing

Rigid Tubing
Connector
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Verifying Operation
To verify operation, manually move each subsystem using the manual control option of the SediGraph 
analysis program.

1. Ensure that the SediGraph and MasterTech are turned on. Start the SediGraph analysis program if 
it has not been started.

2. Fill at least one of the supplied beakers with approximately 80 mL of water.

3. Place the beaker in the position numbered 1 on the tray.

4. To test the ultrasonic probe, remove it from the holder and insert the tip of the probe well into the 
water.

5. While holding the probe tip  under water, press the ULTRASONIC PROBE AUTO/ON switch. A 
high-pitched sound indicates that the probe is working properly.

6. Press the ultrasonic probe AUTO/ON switch again to turn off the probe.

7. Place the probe back into the holder.

NEVER operate the ultrasonic probe without having the tip immersed into a liquid. 
Doing so may harm the probe and/or the driving electronics. DO NOT let the tip of the 
probe come in contact with a glass beaker. Doing so may shatter the beaker.

DO NOT press the ultrasonic probe AUTO/ON switch unless the probe and its cable are 
properly connected to the MasterTech. Doing so may harm the driving electronics.
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8. Go to Unit [n] > Enable manual control. If necessary, go to Unit > Show Instrument Schematic 
to display the instrument schematic.

9. If the arm is in the Load position, press the ARM AUTO/LOAD switch on the front panel of the 
MasterTech to release it.

10. Go to Unit [n] > Initialize MasterTech to initialize the MasterTech. Click Continue on the popup 
message.

A message is displayed indicating initialization is in process. The tray on the MasterTech rotates 
in a counterclockwise direction for one position, and the arm lowers to the Rinse position then 
returns.

The tray continues to rotate until position 1 is reached. The beaker inserted in the tray in Step 3 
should now be directly under the head of the MasterTech. Ensure that the beaker contains 
approximately 80 mL of water.

11. On the instrument schematic, select the symbol representing the MasterTech arm.

When manual mode is enabled, components on the instrument schematic have pop-up 
menus displaying the options available for that component. Right click a component to 
display pop-up menus.

MasterTech portion
of the Instrument
Schematic

MasterTech Arm

                Beaker

MasterTech
Pump
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Appendix L SediGraph III Plus
In each of the following steps, first access the pop-up menu:

a.) Select Move Arm Down; then repeat the step.

b.) Select Ultrasonic On. A high-pitched sound indicates the probe is operational. Select 
Ultrasonic Off.

c.) Select Stirrer On. The stirrer begins to operate.

d.) Select Stirrer Speed Fast.

e.) Select Ultrasonic Off.

f.) Select Stirrer Off.

g.) Select Move Arm Up.

h.) Select Move Arm Up.

i.) Select Move To Next Beaker. The display updates to reflect the position of the beaker tray. 
The picture on the screen should reflect whether or not a beaker is present.

12. Select the MasterTech pump. In each instruction in this step, first access the pop-up menu:

a.) Select Turn On; the MasterTech pump should begin operating. A whirring sound can be 
heard then the pump will begin to operate.

b.) Check the direction of the flow of the MasterTech pump:

• Flow Direction Load - allows suspension to flow from the MasterTech to the SediGraph. 
This direction is used to load the sample into the mixing chamber of the SediGraph.

• Flow Direction Rinse - allows suspension to move from the SediGraph to the 
MasterTech. This direction is used to rinse the sample from the stirrer and transfer tube on 
the MasterTech.
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INDEX

A
Absorption

baseline, E-9
full scale, E-10
X-ray, E-9

Accessories, ordering, 8-1
Add button

in liquid properties, 3-13
in Regression reports, 5-1

Advanced command, 2-4
Advanced format

defined, 2-3
Air valve

changing position in manual control mode, 4-25
Analyses

high resolution, 4-9
high speed, 4-9
preparing for, 2-17
reference material, 7-6
results relative to other methods, F-1
selecting number to perform, 3-8, 3-20, 3-24, 4-4
selecting report options, 4-2
selecting type, 3-14, 4-9
standard, 4-9
time, 3-15

Analyses counter, 4-33
resetting, 4-33

Analyses, performing, 2-21
MasterTech Automatic method, 4-10
MasterTech Schedule method, 2-31, 4-12
Quick Start method, 4-6
Sample Analysis method, 2-21

Analysis cell
cleaning, 7-8
draining, 2-17
movement, E-8
moving in manual control mode, 4-26
replacing assembly, 7-22
replacing tubing, 7-14
replacing windows, 7-21
rinsing, 4-19
zeroing position in manual control mode, 4-27

Analysis Conditions
Material Properties, 2-9

Analysis conditions
command, 3-11

Analysis conditions command, 2-9, 2-11
Analysis liquids

See Liquids
Analysis Options, 2-8
Analysis options, 2-9
Analysis program

using, 1-11
version number, 1-15

Analyzer
cleaning, 7-6
description, 1-4
leveling, 7-18
maintaining, 7-5
rinsing, 2-33, 4-19
routine maintenance, 7-20
RS232 connector, 1-7
side panel, 1-7
specifications, 1-16
turning on and off, 1-10

Analyzing file status, 1-13
Apply Changes button

in material properties, 3-17
ARM AUTO/LOAD switch, 1-8
Autorinse, 2-34, 3-20, 4-19

specifying options, 6-4
Autoscale

in Control Chart reports, 5-12
selecting options, 3-26, 5-8
when merging data, 3-29

Aux RS232 port, 1-7
Axis coordinates, viewing, 5-28
Axis range

specifying beginning and ending values, 3-26

B
Baseline

displaying date and average intensity of latest, 4-32
latest, 2-20
measuring, 2-19, 4-15
measuring alternately with samples, 4-12
performing a series of measurements, 4-12
previous, 2-20

Baseline command, 2-19
Baseline Measurement dialog, 2-19
Baseline report, 5-4
Basic command, 2-1
Basic format

defined, 2-3
sample information file, 2-6
sample information files, 2-6
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Beaker
redispersing sample in, 4-10
starting beaker in automatic analysis, 4-10

Beaker tray, 1-5
aligning, 4-23
installing, L-6

Beamsplit, E-7
finding in manual control mode, 4-27

Bezel, cleaning mixing chamber, 7-6
Board ID button, 4-33
Board ID dialog, 4-33
Boards

See Circuit boards
Bubble detection, 7-23
Bubbles

detection, E-11
determining cause, 7-23
elimination, E-11

C
Calculations

arithmetic, J-8
data, J-1
geometric, J-10

Calibration
displaying data, 4-33

Calibration command, 4-34
Cautions, 1-8
Cautions, defined, 1-3
Cell pump

changing flow direction in manual control mode, 
4-26

checking operation, 7-17
replacing tubing, 7-13
resetting, 7-23
selecting speed, 3-19, 3-20, 4-20, 4-22

Circuit boards
displaying identification, 4-33

Cleaning
air filter, 7-15
analysis cell, 7-8
analyzer, 7-6
collimating slits, 7-18
mixing chamber, 7-6
mixing chamber bezel, 7-6

Clear button, 3-9
in particle size or sieve table, 3-28

Collected data, 3-27
Collected Data dialog, 3-27
Collimating slits

cleaning, 7-18
Common fields and buttons

for file menu, 3-1

for reports menu, 5-1
for unit menu, 4-2

Complete file status, 1-13
Control Chart

calculations, J-14
Control Chart report

recalculating archived results, 5-12
selecting statistics, 5-11

Control chart report, 5-10
Conventions

Caution, 1-3
Notes, 1-3
Warning, 1-3

Cumulative Data
calculation, J-5

D
Data

selecting display options, 6-2
Data points table, 3-25
Data presentation command, 6-2
Default sample information file, 2-38, 6-3
Delete button, 3-9

in liquid properties, 3-13
in particle size or sieve table, 3-28

Density, 3-8, 3-21, 4-4
values, G-1

Diameter
particle range, 1-16
starting and ending, 3-14

Dimensions
MasterTech, 1-17
SediGraph, 1-17

Dispersant
Sedisperse, I-1
sources, H-1

Dispersants, changing during analysis, 4-13
Dispersion

chemical aids, C-1
methods, B-1

Drain and load command, 2-17
Drain and load operation, 2-17

methods of performing, 4-17
Draining the system, 7-11

E
Edit button

in MasterTech Schedule analysis, 4-14
in Repeat Schedule analysis, 4-9

Entered data, 3-30
Entered file status, 1-13
Ethernet port, 1-7
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Export
sample files, 3-3

Export command, 2-40
External data

entering, 3-30
merging, 2-7, 3-28, 4-4

External Data button, 3-9, 3-28

F
File

list, 2-42
File menu

Analysis conditions command, 3-11
Common fields and buttons, 3-1
Exit, 2-45
Report command, 3-23

File name, default extensions, 3-5
File names

conventions, 1-13
Filter

See Air filter
Flexible tubing

See Tubing
Format

Advanced, 2-3
Basic, 2-3
Restricted, 2-3

Frequency
MasterTech, 1-17
SediGraph, 1-16

Full scale mass percent, 3-10, 3-29, 4-4
Fuse

MasterTech, 1-17

G
Graph

copying as metafile, 5-27
editing onscreen, 5-24

Graphs
selecting grid line type, 6-2
showing and hiding gridlines, 6-2

H
Help

online manual, 1-15
Help menu, 1-15
Humidity, 1-17

I
Insert button, 2-28, 2-31

in particle size or sieve table, 3-28
in Repeat Schedule analysis, 4-9

Installing
beaker tray, L-6
MasterTech, L-1
ultrasonic probe, L-8

Instrument log, 4-30
printing a report, 4-31

Instrument schematic, 4-24
description, 4-28
displaying, 4-28

INTENSITY control, 1-8

L
Level indicator, 7-18
Leveling analyzer, 7-18
Liquid properties, 2-8

changing, 3-12, 3-13, 3-21
entering, 3-21
Interpolation calculations, J-2
values, 3-22

Liquid properties command, 2-12
Liquid Properties dialog, 3-21
Liquids, 1-17

See also Sedisperse dispersing liquids
adding in analysis program, 3-12, 3-13
adding properties in analysis program, 3-13
analysis, 3-13
suspending, 1-16, 1-17

List command, 2-42
List file statistics, 3-3
Log

See Analysis Log
Log Probability Data, J-15
Log Probability Interpolation Table, J-15

M
Main Menu bar, 1-14
Main menu bar, 1-14
Maintenance

system, 7-1
Maintenance schedule, 7-5
Manual control mode

enabling, 4-24
pop-up menus, 4-24

Mass Data
calculation, J-4

Mass Frequency Data, J-4
Mass Percent
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Index SediGraph III Plus
calculation, J-3
Mass percent

specifying ending percent finer, 3-20
stop at specified, 3-20

MasterTech
+5 and +24 VDC indicators, 1-9
ARM AUTO/LOAD switch, 1-8
connecting cables, L-7
connecting to SediGraph, L-7
controls and indicators, 1-8
description, 1-5
dimensions, 1-17
front panel, 1-8
fuse type, L-4
initializing, 4-23
installing beaker tray, L-6
installing sample transfer tubing, L-9
installing ultrasonic probe, L-8
INTENSITY control, 1-8
moving arm to next beaker in manual control mode, 

4-27
moving arm up or down in manual control mode, 

4-27
Power Display, 1-8
POWER ON/OFF switch, 1-9
PUMP AUTO/OFF switch, 1-9
rear panel, 1-9
replacing input power fuse, 7-24
rinsing, 4-21
RS232 connector, 1-9
selecting stirrer time and stirrer speed, 3-18
selecting voltage, L-1
specifications, 1-17
troubleshooting, 7-4
turning on, L-5

Material Properties, 2-9
Material properties, 2-8, 3-11

updating, 3-16
Mean

calculation, J-8
Mixing chamber, 1-7

cleaning, 7-6
cleaning bezel, 7-6
increasing or decreasing stirrer speed, 4-18
rinsing, 4-19
selecting speed in manual control mode, 4-25
stirrer speed, 3-20

Mixing pump
checking operation, 7-16
replacing tubing, 7-12
resetting, 7-23
turning on and off in manual control mode, 4-25

Mode
calculation, J-8

Multiple graph overlays, 2-46

N
No analysis file status, 1-13
Notes, defined, 1-3
Number Frequency Data

calculation, J-7

O
ON/OFF switch, analyzer, 1-7
ON/OFF switch, MasterTech, 1-9
Open command, 3-5
Opening

files, 3-5
Operator’s manual, conventions, 1-3
Option Presentation

Advanced Format, 6-1
Options menu

Service Test mode, 6-5
Ordering information, 8-1
Out of Spec calculations, J-11
Overflow tube, 2-33, 2-35
Overlays

creating the same graph for all tests from one sample 
file, 2-52

creating the same graph for multiple samples, 2-49
Generating, 2-46
generating, 2-46
multiple graphs, 2-46
selecting type, 3-26

Overlays button, 2-16

P
Parameter files, defining, 2-8
Particle size distributions, F-2
Particle size table, 3-9, 3-28
Parts, ordering, 8-1
Peak Report Data

calculation, J-5
Plot type, 3-26
Power

MasterTech, 1-17
SediGraph, 1-16

Print command, 2-39
Printer

specifying, 6-4
Printing

instrument log report, 4-31
Probe

See Ultrasonic probe
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Properties button, 3-13
PSD History report, 5-14
PUMP AUTO/OFF switch, MasterTech, 1-9
Pump Control Off/Auto switch, analyzer, 1-6
Pumps

symbols in instrument schematic, 4-24

R
Reference button

in report options, 2-15
Reference material analysis, 7-6
Reference Quantities, J-11
Regression Chart

calculations, J-13
Regression report

command, 5-8
recalculating SPC values, 5-9
selecting axis range, 5-8
selecting X- and Y-Axes variables, 5-8
window, 5-8

Replacing
analysis cell assembly, 7-22
analysis cell windows, 7-21
MasterTech input power fuse, 7-24
ultrasonic probe tip, 7-24
X-ray indicator lamps, 7-20

Report
control chart, 5-10
generating, 5-3, 6-1
graphs, editing onscreen, 5-24
header, 5-16
shortcut menus for, 5-22
tabular, editing, 5-23
tool bar, 5-19
zoom feature, 5-28

Report button, 4-4
Report Options

command, 3-23
list file statistics, 3-3

Report options
ID, 3-23

Report options files, 4-4
defining, 2-14

Reports
Baseline, 5-4
calculations, J-1
closing, 5-3
displaying during an analysis, 4-4
examples, 5-29
ordering by ascending or descending data, 3-25
overlays, 2-46
PSD History, 5-14
selecting, 3-25

showing graph, 3-23
showing title, 3-23

Reports List Box, 4-4
Reports menu

control chart command, 5-10
regression report command, 5-8
start report command, 5-3

Resolution, 1-16
Restricted format

creating sample information files, 2-6
defined, 2-3
sample information file, 2-6

Resuspension parameters, 4-10
Reynolds number, 2-10, 3-15

calculation, J-14
specifying default, 6-3

Reynolds number command, 6-3
Rinse

after analysis, 2-25, 3-9, 4-4
cycles, 3-20, 4-19

Rinse Both command, 2-36
Rinse container

adding surfactant, 2-33
Rinse MasterTech command, 2-35
Rinse operation, performing, 2-33, 4-19

both SediGraph and MasterTech, 2-33, 2-36
MasterTech, 2-33
SediGraph, 2-33

Rinse SediGraph command, 2-34
Rinse tube, 2-33, 2-35
Rinse valve

changing position in manual control mode, 4-25
RS232 connector, 1-9

S
Safety information

X-ray, K-1
Sample

See also Samples, analyzing
beaker tray capacity, 1-17
dispersion, B-1
loading, 2-17
size, 1-16, 1-17
transfer tubing, installing, L-9

Sample Analysis command, 2-21
Sample analysis command, 4-3
Sample defaults, 6-3
Sample defaults command, 2-1
Sample Information command, 2-4, 2-6
Sample information file

creating in Basic format, 2-6
export, 3-3
list file statistics, 3-3
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Sample information files
converting, 2-43
creating, 2-3
creating automatically in QuickStart, 4-6
defining, 2-1

Sample materials
adding properties in analysis program, 3-12

Samples, analyzing
a series, 4-6
a series with different conditions, 4-12
a series with the same conditions, 4-10
alternately with baseline collection, 4-12
individual samples, 4-3
the same sample multiple times, 4-8

Sedimentation
method of analysis, E-4
theory, E-1

Sedimentation liquids
See  Liquids

Sedisperse dispersing liquids, I-1
material properties, I-2
storage requirements, I-1
technical data, I-1

Service Test mode, 4-34
Service test mode, 6-5
Set Baseline button, 3-16
Set point, temperature, 4-25
Shortcut

for graphs, 5-24
for tabular reports, 5-23

Show Status command, 4-29
Sieve table, 3-9, 3-28

specifying defaults, 6-3
Size Statistics

calculation, J-8
SmartPrep port, 1-7
Software version

displaying, 4-32
Software, using, 1-11
SPC Analysis Options dialog, 5-6
SPC report

control chart, 5-10
regression, 5-8

SPC reports
selecting analysis conditions, 5-6
selecting parameters, 5-6
selecting peaks, 5-7
selecting percentiles, 5-6

SPC Sample Options dialog, 5-6
Specification button, 2-15
Specifications

MasterTech, 1-17
Standard Report Tables, J-17
Standard Report Tables, J-17

Start report, command, 5-3
Status display

lower display, 2-38
upper display, 2-38

Stirrer, MasterTech
changing the speed in manual control mode, 4-27
selecting speed, 4-14
selecting time, 4-10, 4-14
turning on and off in manual control mode, 4-27

Stokes' Law, D-1
Surface Area Frequency Data

calculation, J-7
Suspending liquids

See Liquids

T
Tables

data points, 3-25
particle size, 3-28
sieve, 3-28

Tabular reports, 5-8, 5-12
Temperature

displayed, 3-15
MasterTech, 1-17
SediGraph, 1-16
set point, 4-25
setting target, 4-25

Temperature stabilization, 3-20
Title properties window, 5-27
Tool bar, reports window, 5-19
Tubing

analyses remaining on current set, 4-33
entering number of analyses per set, 4-33
replacing, 7-10, 7-14
replacing cell pump, 7-13
replacing mixing pump, 7-12
rinsing MasterTech, 4-21
rinsing SediGraph, 4-19

U
Ultrasonic probe, 1-5

AUTO/ON switch, 1-8
installing, L-8
replacing tip, 7-24
selecting time, 4-14

Unit menu
service test command, 4-35

Units, selecting, 6-2
Update Properties button, 3-16
Using the Analyzer, 1-1
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V
Verifying operation

MasterTech, L-16
Viscosity, 3-21

calculations, J-3
values, G-1

Voltage
MasterTech, 1-17
SediGraph, 1-16

Voltage, selecting
MasterTech, L-1

W
Warnings, defined, 1-3
Waste tube, 2-33, 2-35
Waste valve

changing position in manual control mode, 4-25
Wetted materials, 1-16, 1-17
Window menu

arrange icons, 1-15
tile and cascade, 1-15

Windows menu, 1-15

X
X-Axis

selecting how values are displayed, 3-26
X-axis order by, 5-10, 5-14
X-ray

absorption, E-9
assembly, 1-4
safety information, K-1
source, K-1
warning and indicator lights, K-1

X-ray indicator lamps, replacing, 7-20
X-ray intensity

low, 3-22
normal, 3-22
reduction, 2-18, 2-25
selecting, 2-13, 3-22
selecting in manual control mode, 4-26

X-RAY ON indicator, 1-6
X-Ray STANDBY indicator, 1-6

Z
Zoom feature, 5-28
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